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FME Desktop Advanced

FME Desktop Advanced Training Manual
This is the manual for the advanced-level training course for Safe Software’s FME Desktop application.

The training builds upon basic training to cover functionality that is important to all FME users wishing to take their skills to the
next level.

Course Structure
The full course is made up of five main sections. These sections are:
Advanced Attribute Handling
Advanced Workspace Design
Advanced Reading/Writing
Advanced Parameter Use
Custom Transformers

Current Status
The current status of this manual is: COMPLETE: this manual can be used for training, subject to minor, last-minute fixes and
creation of slides
It is valid for FME2018.1
The status of each chapter is:
Chapter 0: Content and exercise complete
Chapter 1: Content and exercises complete
Chapter 2: Content and exercises complete
Chapter 3: Content and exercises complete
Chapter 4: Content and exercises complete
Chapter 5: Content and exercises complete
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Chapter 6: Complete content. No exercises
Slides: Complete
FMEData: Complete
Course Outline: Complete
NB: Even for completed content, Safe Software Inc. assumes no responsibility for any errors in this document or their
consequences, and reserves the right to make improvements and changes to this document without notice. See the full licensing
agreement for further details.
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About This Document

About This Document
This advanced course is for users with prior experience of FME Desktop.

Look out for residents of the City of Interopolis, who will appear from time-to-time to give you advice and dispense FME-related
wisdom.

Mr. E.Dict (Attorney of FME Law) says...
On behalf of the City of Interopolis, welcome to this training course. Here is the standard legal
information about this training document and the datasets used during the course.
Be sure to read it, particularly if you're thinking about re-using or modifying this content.

Licensing and Warranty
Permission is hereby granted to use, modify and distribute the FME Tutorials and related data and documentation (collectively, the
“Tutorials”), subject to the following restrictions:
1. The origin of the Tutorials and any associated FME® software must not be misrepresented.
2. Redistributions in original or modified form must include Safe Software’s copyright notice and any applicable Data
Source(s) notices.
3. You may not suggest that any modified version of the Tutorials is endorsed or approved by Safe Software Inc.
4. Redistributions in original or modified form must include a disclaimer similar to that below which: (a) states that the
Tutorials are provided “as-is”; (b) disclaims any warranties; and (c) waives any liability claims.
Safe Software Inc. makes no warranty either expressed or implied, including, but not limited to, any implied warranties of
merchantability, non-infringement, or fitness for a particular purpose regarding these Tutorials, and makes such Tutorials available
solely on an “as-is” basis. In no event shall Safe Software Inc. be liable to anyone for direct, indirect, special, collateral,
incidental, or consequential damages in connection with or arising out of the use, modification or distribution of these Tutorials.
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About This Document

This manual describes the functionality and use of the software at the time of publication. The software described herein, and the
descriptions themselves, are subject to change without notice.

Data Sources
City of Vancouver
Unless otherwise stated, the data used here originates from open data made available by the City of Vancouver, British Columbia.
It contains information licensed under the Open Government License - Vancouver.

Others
Forward Sortation Areas: Statistics Canada, 2011 Census Digital Boundary Files, 2013. Reproduced and distributed on an "as is"
basis with the permission of Statistics Canada. © This data includes information copied with permission from Canada Post
Corporation.
Digital Elevation Model: GeoBase®
Fire Hall Data: Some attribute data adapted from content © 2013 by Wikipedia, used under a Creative Commons AttributionShareAlike license
Stanley Park GPS Trail: Used with kind permission of VancouverTrails.com.
OpenStreetMap Datasets: © OpenStreetMap contributors. See www.openstreetmap.org/copyright.

Copyright
© 2005–2018 Safe Software Inc. All rights are reserved.

Revisions
Every effort has been made to ensure the accuracy of this document. Safe Software Inc. regrets any errors and omissions that may
occur and would appreciate being informed of any errors found. Safe Software Inc. will correct any such errors and omissions in a
subsequent version, as feasible. Please contact us at:
Safe Software Inc.
Phone: 604-501-9985
Fax: 604-501-9965
Email: train@safe.com
Web: www.safe.com
Safe Software Inc. assumes no responsibility for any errors in this document or their consequences and reserves the right to make
improvements and changes to this document without notice.

Trademarks
FME® is a registered trademark of Safe Software Inc. All brand or product names are trademarks or registered trademarks of their
respective companies or organizations.

Document Information
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About This Document

Document Name: FME Desktop Advanced Training Manual 2018.1

What's New?
A list of changes to this manual and its accompanying datasets can be found on GitHub at
https://github.com/safesoftware/FMETraining/blob/Desktop-Advanced-2018/WhatsNew.md. The file includes a list of general
revisions compared to the previous year's materials. It is designed to help trainers become up-to-speed with new content, and for
students to identify which FME functionality is new for the current release.
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Course Overview
This training course builds upon the basic framework of workspace creation in FME Desktop. The course covers topics that are
commonly used by all workspace authors who wish to take their FME skills to the next level.

Course Structure
The full course is made up of five sections. These sections are:
Advanced Attribute Handling
Advanced Workspace Design
Advanced Reading/Writing
Advanced Parameter Use
Custom Transformers

Course Length
The instructor may choose to cover as many of these sections as they feel are required, or possible in the time permitted. They
may also cover the course content in a different order and will skip or add new content to better customize the course to your
needs.
Therefore the length and content of the course may vary, particularly when delivered online.
Safe Software offers training in various lengths, but usually either two days or five days. Both courses cover the same content.
The two-day course runs over fewer, but longer, days and is more intense. The five-day course runs over more, but shorter, days
and allows a little more time to cover the content from a beginner's perspective.

Prerequisites
This training material is intended for persons with some prior experience of using FME. The content assumes a basic familiarity
with the concepts and practices of FME Desktop; at least to the extent covered by the FME Desktop Basic Training.
In particular, it would be helpful to be familiar with:
FME transformers and basic transformation techniques
See the "Data Transformation" chapter of the Basic Training
Basic workspace design including multiple Readers and Writers and use of FeatureReader/FeatureWriter
See the "Workspace Design" chapter of the Basic Training
Data filtering and attribute management techniques in FME Workbench
See the "Practical Transformer Use" chapter of the Basic Training

About the Manual
The FME Desktop Advanced Training manual not only forms the basis for advanced FME Desktop training – in-person or online
– but is also useful reference material for future work you may undertake with FME. It is updated for each major release of FME.
All screenshots in these materials were taken using FME on Windows Server 2016. The fonts used (especially in screenshots of
the log window) may be resized or otherwise changed for improved legibility.
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Course Resources
This course uses a number of sample datasets and workspaces.

On Your Training Computer
The data used in this training course is based on open data from the City of Vancouver, Canada.
Most exercises ask you to assume the role of a city planner at the fictional city of Interopolis and to solve a particular problem
using this data.
Whether it's a local computer or a virtual computer hosted in the cloud, you'll find resources for the examples and exercises in the
manual at the following locations:
Location

Resource

C:\FMEData2018\Data

Datasets used by the City of Interopolis

C:\FMEData2018\Resources

Other resources used in the training

C:\FMEData2018\Workspaces

Workspaces used in the student exercises

C:\FMEData2018\Output

The location in which to write exercise output

<documents>\FME\Workspaces

The default location to save FME workspaces

You should also find FME pre-installed, plus a digital copy of this manual.
Please alert your instructor if any item is missing from your setup.
You can find the latest version of FME Desktop and FME Server for Windows, Mac, and Linux - together with the latest Beta
versions - on the Safe Software web site.

Course Etiquette
For online courses, please consider other students and test your virtual machine connection before training starts. The instructor
cannot help debug connection problems during the course!
For live courses, please respect other students’ needs by keeping noise to a minimum when using a mobile phone or checking email.
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Exercise 1

Basic FME Skills Review

Data

Public Art (Microsoft Excel)
Transit Stations (File Geodatabase)

Overall Goal

Review basic FME skills

Demonstrates

Reading and writing data with basic transformer use

Start Workspace

None

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\FMEReview-Ex1-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\FMEReview-Ex1-CompleteAdvanced.fmw

You've just been hired by the city's GIS department. For your first project, you've been asked to create a map that shows the public
art within a 5-minute walking radius (2-3 street blocks) of each train station. This project is also being used to assess your skills
and see what other projects you'll be able to work on right away.
Project Requirements:
Use FME Workbench to carry out the following:
Read all the sheets from an Excel spreadsheet (PublicArt.xlsx) turning the data into spatial features
Read the Transit Stations table from a File Geodatabase (CommunityMapping.gdb)
Reproject the data to UTM83-10 as required
Create a buffer around the transit stations set to approximately 3 blocks (250 metres)
Find artwork features within the station buffer
Style the data for output to KML format
Write the data to Google KML format

TIP
If you wish, use the FME skills that you have previously learned to create a workspace that satisfies the
requirements above without looking at the steps!
That's ok if you don't get it finished. The complete instructions are below. Just try your best!
If you struggled with this exercise, it might be a good idea to go back and review the FME Desktop Basic
Manual before taking this advanced course.

1) Create a New Workspace
Open FME Workbench and start with a blank workspace. Add a new reader using the following parameters:
Reader Format:

Microsoft Excel

Reader Dataset:

C:\FMEData2018\Data\Culture\PublicArt.xlsx

Coord. System:

LL84

Workflow Options:

Single Merged Feature Type
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Once the Microsoft Excel reader is added, add an Inspector transformer (or turn on Feature Caching) and run the workspace.
Inspect the results.
NB: Don't use the Inspect pop-up button on the reader feature type. You will not see any geometry.

2) Add Geodatabase Data
Next, add another reader, this time the Transit Stations table from a Geodatabase:
Reader Format:

Esri Geodatabase (File Geodb Open API)

Reader Dataset:

C:\FMEData2018\Data\CommunityMapping\CommunityMap.gdb

Parameters > Table List:

TransitStations

Workflow Options:

Individual Feature Types

Inspect this new dataset paying attention to the coordinate system:

The coordinate system for this dataset is UTM83-10, the other dataset LL84; so one of these datasets must be reprojected to match
the other if we wish to test their spatial relationships.

3) Reproject PublicArt
Since UTM83-10 is a more localized coordinate system, let's reproject the PublicArt to it. Add a Reprojector transformer to the
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canvas and connect it to the Public Art feature type (<All>). In the parameters set the Destination Coordinate System to UTM8310:

4) Buffer the Transit Stations
To create a 5-minute walking radius for each transit station, which is about 2-3 city blocks, we will need to create a buffer. To do
this, we will use the Bufferer transformer. Add a Bufferer transformer to the canvas and connect it to the TransitStations feature
type. In the parameters set the Buffer Amount to 100:

5) Inspect Features
Next, we will run the translation to check if the buffer amount was enough. If it's not already set, firstly select Run > Run with
Feature Caching from the menubar:

Now run the translation.
Once the translation is complete, select both the Reprojector and Bufferer transformers on the canvas. Then use right click >
Inspect Cached Features:

This will open both the features in the Data Inspector.
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To check how many blocks the buffer covers we will need to enable background maps. In the Data Inspector select Tools > FME
Options > Background Map. Set Stamen Maps as the Background Format, click the Parameters button, and choose any of the
available map types.
The result will look like this:

Map tiles by Stamen Design, under CC-BY-3.0. Data by OpenStreetMap, under CC-BY-SA.

TIP
If there is no internet connection, or you can't get the background maps working with a web service, you
can use any FME-supported format of data. For example, set the Background to Other FME Formats and
use an Autodesk AutoCAD DWG/DXF reader to display the CompleteRoads.dwg dataset:
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It looks like these buffers only cover approximately one block, so we should increase their size. Back in FME Workbench, change
the Buffer Amount parameter in the Bufferer to 250. Optionally, reduce the Interpolation Angle parameter to give a smoother
result.
To re-run the workspace use a Partial Run (i.e. click on the Bufferer and choose the Run From This pop-up button). Then inspect
both the Reprojector and the Bufferer caches again:

Map tiles by Stamen Design, under CC-BY-3.0. Data by OpenStreetMap, under CC-BY-SA.

This looks good; now we can move on.

6) Filter Public Art
Now that the buffer is a good size we can find out which of the public art pieces fall within the buffered area.
Add a SpatialFilter transformer to the canvas. Connect the Reprojector:Reprojected output port to the SpatialFilter:Candidate
input port, and the Bufferer:Buffered output port to the SpatialFilter:Filter input port:
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Adjust the workspace as necessary to ensure there are no crossed connections.
Set the SpatialFilter Spatial Predicates to Test parameter to apply both Filter Contains Candidate and Filter Touches Candidate.

Rerun the translation if you wish, and inspect the SpatialFilter:Passed output port (alongside the Bufferer output) to make sure the
results are correct. There should be 52 Passed features.

7) Add Google KML Writer
Finally, we can write out to Google KML. Add a Google KML Writer using the following parameters:
Writer Format:

Google KML

Writer Dataset:

C:\FMEData2018\Output\Walkability.kml

Feature Type Definition

Automatic

Change the name of the newly created Feature Type to ArtNearTransit. Connect it to the SpatialFilter:Passed output port. Also
connect the Bufferer:Buffered output port to the ArtNearTransit:Input port:
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Open the ArtNearTransit feature type parameters and select the User Attributes tab. Change the Attribute Definition to Manual
and remove the attributes OBJECTID and _predicate:

8) Save and Run Translation
You can now save your workspace then run the translation. Open up the Google KML file in Google Earth or the FME Data
Inspector:

NB: Even though we reprojected the data to UTM83-10, Google KML format supports only a Latitude and Longitude coordinate
system. Notice that the writer automatically reprojected our data for us. So why do you think we reprojected our data to UTM8310 in the Reprojector? Hint: it has something to do with the Bufferer transformer.
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Advanced Exercise
The output of the Google KML isn't the prettiest; it just uses default icons. These output styles can be
changed with KMLStyler transformers.

9) Connect TransitStations
We also want to add an icon for our TransitStations so the user knows where the station is. Connect the TransitStations Feature
Type to the ArtNearTransit Writer:

10) Style Output KML
Add a KMLStyler transformer between the SpatialFilter:Passed output port and the ArtNearTransit Writer. In the parameters
under Icon > Name, click the ellipsis then select an icon such as J1. Then for Label Style set the Scale to 0 and the Opacity to 0.
This will allow the icon to show, but hide their labels.
Between the Bufferer and the ArtNearTransit Writer add another KMLStyler. In the parameters set the Color to Black and the Fill
Color to Yellow. Set both Opacity and Fill Opacity to 0.5. Then for Label Style set the Scale to 0 and the Opacity to 0.
Finally, add a third KMLStyler to the canvas. This time connect it between the TransitStations:Output port and the
ArtNearTransit:Input port. In the parameters Icon > Name, click on the ellipsis then double click on the first folder icon to browse
for more icons. Then select the gx_rail icon and click OK. Also, set the Scale and Opacity for Label Style to 0.

11) Save and Run Translation
Finally, save and rerun the translation to see the updated icons in Google Earth:
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CONGRATULATIONS
By completing this exercise you have reviewed the following skills:
Add a reader and writer
Modify reader parameters
Apply various transformer parameters (Bufferer and SpatialFilter)
Use the Data Inspector to inspect data
Add a background map to the Data Inspector
Modify writer output schema
Style a KML dataset
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Advanced Attribute Handling
Handling attributes are one of the most common operations carried out in FME. Users need to set attributes, edit them, and use
them within most workspaces.

Professor Lynn Guistic says…
Good afternoon. I'm here to guide you through the technical aspects of attribute handling in FME. By the
time we're complete, you'll have the FME equivalent of a Master's degree in constructing attribute values!
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Constructing Attributes
Besides constant attribute values, FME also allows you to build values using string manipulation and arithmetic calculations. This
is achieved using the menu opened by clicking on the arrow in the Attribute Value field:

This capability is very useful because an attribute is no longer a fixed value: it can be constructed from a mix of existing attributes
and parameters. The two methods are the Text Editor and Arithmetic Editor.
The string functions are mostly based around Tcl, the arithmetic functions around C.

Professor Lynn Guistic says…
Remember that besides existing to construct attributes, the text and arithmetic editors can be applied on
most FME parameters. You wouldn't, for example, have to use the AttributeManager arithmetic editor to
create an attribute to then use in the 3DForcer transformer; you could instead use the arithmetic editor
directly in the 3DForcer itself.

Miss Vector says...
Do you know which transformers can be used to create attributes? Select all that apply:
1. AttributeCopier
2. AttributeCreator
3. AttributeManager
4. AttributeRenamer
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Text Editor
The text editor - as you would expect - allows you to construct a text value. It includes all the usual string-handling functionality
you would need, such as concatenation, trimming, padding, and case changing.
The text editor looks like this:

Here the user is constructing a simple address string by concatenating various existing attributes. Notice the menu on the left-hand
side. Existing attributes are listed here and were added to the string by double-clicking them.
Also, notice the other menu options. The most important (for a text editor) is the String Functions:
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These are the functions that can be used to manipulate the strings being used. For example, here the user is making sure to trim the
attributes used to construct a new value:

Other functions allow you to calculate results for various date operations; for example, you can determine the interval between
two dates in a number of units, you can add or subtract time from a date, or you can change a date from one structure to another.
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Arithmetic Editor
The arithmetic editor is much the same as the text editor, except that whatever the user enters into the dialog will be evaluated as
an arithmetic expression and a numeric result returned:

Here the user is calculating a resident's tax using a simple equation containing property area and a tax code. As with the text
editor, existing attributes and arithmetic functions were obtained from the menu on the left-hand side.
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FME Feature Functions
One other item in the menu of both text and arithmetic editors is FME Feature Functions:

These are functions that reach into the very heart of FME's core functionality. They are the building blocks that transformers are
built upon; basic functionality that can return values to the editor.
For example, the @Area() function returns the area of the current feature (assuming it is a polygon). @NumCoords() returns the
number of vertices in the current feature.
Some functions return strings, and others return numeric values; therefore the available functions vary depending on whether the
text or arithmetic editor is being used. In the screenshot above, the text editor functions are on the left and the arithmetic editor
functions on the right.
FME Feature Functions are useful because they allow you to build processing directly into attribute creation, instead of using a
separate transformer.

Professor Lynn Guistic says…
You might also be wondering why there are math functions inside the text editor and how you can use
them.
Well, sometimes you need to calculate a numeric value as part of a string. If so, you can use the FME
function @Evaluate() inside a text editor to carry out a mathematical calculation. This function
understands all numerical operations, which is why they are included in the text editor dialog.

Replacing Other Transformers
Integrated text and arithmetic editors provide a great benefit for workspace creation. They allow attribute-creating functions to be
carried out directly in a single transformer.
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For example, the AttributeManager text editor can be used as a direct replacement for the StringConcatenator and
ExpressionEvaluator transformers.
The AttributeManager could also replace the StringPadder and AttributeTrimmer transformers, albeit with a little less userfriendliness. If FME Feature Functions are used inside the editor, this transformer could also technically replace transformers such
as the AreaCalculator, LengthCalculator, VertexCounter, DateTimeStamper, and many more.
Replacing transformers is usually a good thing. Workspaces are more compact and well-defined when as many peripheral
operations as possible are integrated directly into a single transformer. However, because it's possible for an AttributeManager to
be carrying out one of many, many activities, it is also critical to use Best Practice and ensure it has the proper annotation.
If an AttributeManager is not annotated correctly, it isn't possible to determine from looking at the Workbench canvas what action
it is carrying out!

Professor Lynn Guistic says…
Note that incorporating functions into a single transformer is not intended as a way to improve
performance.
For example, replacing twenty (20) transformers with twenty functions inside one AttributeManager
transformer - all carrying out the same task - is unlikely to make the workspace faster overall; plus the
AttributeManager will naturally become slower with each new function that is added to it.
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Exercise 1

Taxation Report Project

Data

Building Footprints (AutoCAD DWG)
Zoning Data (MapInfo TAB)
Tax Report (CSV (Comma Separated Value))

Overall Goal

Create a taxation report for each building

Demonstrates

Constructing attribute values

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex1-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex1-Complete.fmw

The annual property tax reports are due to be calculated, and it is decided to use FME to carry out the processing. You must set up
a workspace that calculates tax values for each building (based on size and zoning) and creates a text file containing the results.

1) Open Workspace
Open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex1-Begin.fmw. This is what you have created
so far in order to set up readers and writers and a couple of preparatory transformations:

Open the parameters for each transformer in turn. Notice that the AttributeValueMapper is mapping from zone category to a
TaxMultiplier value:
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The GOIDGenerator is merely creating a unique ID for each building footprint.

2) Run the Workspace
Make sure Run > Run with Caching is turned on and then run the workspace. Inspect the caches for the two source datasets. They
will look like this:

Also inspect the transformer caches to ensure they are carrying out the action you expect.

3) Add SpatialFilter
The first thing to do is transfer zoning information onto the building footprints. Add a SpatialFilter transformer to the workspace,
with the zones as the Filter features and the buildings as the Candidates:

Inspect the transformer parameters. Set (or ensure are set) the following:
Filter Type

Multiple Filters

Pass Criteria

Pass Against One Filter

Spatial Predicates to Test

"Filter Intersects Candidate" and "Filter Contains Candidate"

You may want to rerun the workspace and inspect the SpatialFilter caches to ensure that the building features do - as expected emerge from the SpatialFilter:Passed output port and possess three new attributes (ZoneName, ZoneCategory, and TaxMultiplier).

4) Add AttributeManager
Add an AttributeManager connected to the SpatialFilter:Passed output port and inspect its parameters.
The first task is to create a numeric value for the taxation rate.
Create a new attribute called TaxRate. Set it to a fixed value of 0.2
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Next, add a new attribute called TaxAmount, click the drop-down arrow to the right and choose the option for Open Arithmetic
Editor:

5) Calculate Tax Amount
The calculation for the tax amount is:
Building Footprint x Tax Multiplier x Tax Rate = Tax Amount

...where Building Footprint is the area in square meters, Tax Multiplier is the value relating to the Zone Type, and Tax Rate is a
value that changes each year and so should be provided by the user.
The result should also be rounded off to two decimal places.
So, start out by locating Area under FME Feature Functions and double-clicking it to add the area of the building footprint to the
equation:

Next, add a multiplication symbol, and locate the TaxMultiplier attribute and double-click it to add it to the equation:
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Add another multiplication symbol. Now locate the TaxRate attribute and double-click it to add it to the equation:

Now we need to round the result to two decimal places. Enclose the equation in the round function then add a comma after
@Value(TaxRate) and type 2, so that we can round to two decimal places.

@round(@Area()*@Value(TaxMultiplier)*@Value(TaxRate),2)

Click OK to close this dialog, but keep the AttributeManager parameters on display...

6) Create Tax Report String
The final task is to create a string of text that we can write to a report file. In this case, the end-users of the information wish to
receive a plain text file in the following structure:
Property: <PropertyID>
Tax Value: <TaxValue>
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<Current Date and Time>

So, inside the AttributeManager create a new attribute called text_line_data - this matches the output schema. Then click the dropdown arrow and open the text editor dialog.
Enter fixed values and add the attributes in the appropriate places to get the correct output:

Then use the DateTimeNow() function to create a date/time stamp:

To get carriage returns in the output, we need to specifically add those characters to the editor. To see such characters, select
Options > Show Spaces/Tabs
Then locate Carriage Return (\r) in the Special Characters menu and add one for each line:

Now click OK to close the dialog and then accept the changes to the AttributeManager.

7) Connect Schema, Run Workspace
Connect the AttributeManager:Output port to the Text File writer feature type:

Save and then run the workspace. The result should be a text file that looks like this:
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CONGRATULATIONS
By completing this exercise you have learned how to:
Construct numeric values with the arithmetic editor
Construct strings with the text editor
Write data to a plain text file
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Conditional Attribute Values
Conditional Attribute Values are a tool that can be used to replace many existing transformers of the same type.

Transformer-Based Attribute Mapping
Features can be divided within a workspace using transformers in a process called Conditional Filtering, and attributes can be set
or created based on these divisions. Here an author divides data into neighborhoods using a postcode attribute:

However, a large number of AttributeManager transformers like this is not a good idea. It causes the workspace to be bloated;
hard to navigate and harder to edit. Also, since each value needs a separate TestFilter port and AttributeManager combination, it's
easy to imagine the difficulties involved with - say - more than 50 values!
One solution is to use a simple AttributeValueMapper transformer. However, that transformer only permits a single, simple
condition, such as X=Y. If a more advanced set of conditions is required, then the preferred solution is Conditional Attribute
Values.

What are Conditional Attribute Values?
Conditional attribute values are when, instead of creating a set of conditions and values as separate objects in a workspace, the
author sets both condition and value inside a single transformer.
The option for conditional attributes is found in the drop-down dialog on most transformer parameters. In the AttributeManager, it
appears like so:
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In the above screenshot, a workspace author is creating a new attribute called NEIGHBORHOOD. The values for
NEIGHBORHOOD are conditional upon other attribute values and - in this example - are set up like this:

Professor Lynn Guistic says…
To save time and prevent data entry error, you can copy and paste between transformers of a similar style.
For example, the Tester transformer and a Test Condition in the TestFilter transformer.
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Like the AttributeValueMapper, a series of conditions (left) map to different values (right). However, in contrast to the
AttributeValueMapper, this dialog allows much more complex conditions than a simple 1:1 mapping. That’s because full test
capabilities are built into this dialog.
The conditions are defined by double-clicking in the Test Condition field to open up a Tester-style dialog. Both the condition and
the output value can be set within this dialog:

When the conditions are set than the original dialog – in this case, an AttributeManager – looks like this, with the number of
conditions defining the number of possible values:

Professor Lynn Guistic says…
Just like attribute construction, conditional values apply not only to attributes but to most FME
parameters; for example, I can create labels conditional upon certain tests using the Labeller transformer
itself:
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So I don't have to create the labels in an AttributeManager and then apply them in the Labeller as a
separate task.

When to use Conditional Attribute Values?
Conditional attribute values are great for when you need to map (or set) an attribute in relation to the value of an existing attribute,
and when the conditions are more complex than can be handled in a simple AttributeValueMapper (or AttributeRangeMapper)
transformer.
In essence, conditional values are like a combination of TestFilter and AttributeCreators in the range of functionality that they
include.

Professor Lynn Guistic says…
Additionally, if you’re using the ?: operator in an arithmetic editor, then you can stop being such a showoff and use conditional values instead!

Miss Vector says...
The output attribute "value" in a conditional setup can be which of these (select all that apply):
1. A simple value like a string or number
2. A value constructed from a text or arithmetic editor
3. No Action (i.e. the value will remain what it was)
4. A command to FME to cancel the translation
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Exercise 2

Flood Risk Project

Data

Parks (MapInfo TAB)

Overall Goal

Assess flood risk for addresses based on elevation and distance from shore

Demonstrates

Conditional attribute values

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2-Complete.fmw

A colleague is working on a workspace to calculate the tsunami flood risk for all addresses in the city. The risk is adjudged to be a
combination of closeness to the shoreline and elevation above sea level, and is calculated using this table:
Elevation (meters above sea level)

Distance from Shoreline (meters)

0-10m

10-25m

25-60m

100m

1

2

3

200m

2

3

4

300m

3

4

5

Your colleague has created the workspace up until the point at which each address has an elevation and distance from the
shoreline. Now the calculations need to start, and he has asked for your assistance in finishing the project.

1) Start Workbench
Open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2-Begin.fmw. This is the workspace as your
colleague has created it so far.
To find out what data we are dealing with, run the workspace and then inspect the results at various parts. You can do this either
using Inspector transformers or Feature Caching.
You’ll probably want to inspect the source feature types (or the Reprojector, since the CDED data is a different coordinate
system). You’ll also want to inspect the AttributeRenamer output.
Don’t forget you can set a Group-By in an Inspector's parameters, which may be of use in visualizing which addresses are in
which zone.
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You’ll see how the addresses are assigned a zone denoting their distance from the shoreline, and also possess an elevation.

Ms. Analyst says...
Before we get onto a full set of instructions for the exercise, try to consider how you might go about this
task. You’ll need to think about:
Can the data be mapped directly to flood risk, or does it need filtering first?
The zone is fairly easy to map because it is a fixed value (100, 200, and 300). However, elevation is
trickier because they are not fixed values; elevation could be any single value from 0 to 60.
Which transformers would you use?
To filter the data the Tester and TestFilter transformers are the most obvious candidates, with maybe the
AttributeRangeFilter; to map data, either the AttributeValueMapper or AttributeRangeMapper.
Alternatively, why not just use the AttributeManager with conditional attributes?
Should you combine methods?
Perhaps a combination method would work best, where you filter the data partially and then map it? If so,
which data do you filter by and using which transformers?
Which will produce the most aesthetic workspace?
Best Practice should always play a part in any workspace. If there are several solutions, then which
produces the most aesthetic (good-looking) workspace? Are fewer transformers always better, or will that
impact on the need to maintain the workspace?

Miss Vector says...
On consideration, I see three likely ways to carry out this project. I call them:
Simple Filtering (Simple, but bulky)
Complex Filtering (Moderate in both complexity and size)
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Conditional Values (Complex, but compact)
Simple Filtering filters the data and then maps it to the required values; as such it is a two-step process. It
requires more transformers but is simpler to understand and set up.
Complex Filtering filters the data in a single step, so no further mapping is required. It’s a single-step
process, but – because the data is filtered – needs more transformers than perhaps necessary. It is
moderately complex.
Conditional Values set the values directly depending on a set of inbuilt conditions. All the work can be
done in a single transformer, so it is compact, but the setup and maintenance are considerably more
complex.
On the following pages, we’ll detail how to set up each method. Pick which one you want to try and follow
the instructions. Alternatively, do each in turn – then you’ll be able to compare the different methods and
decide which you think is the best.
BEWARE! Be sure to check your use of AND and OR in filter transformers. It's easy to get one wrong but
difficult to track that down as the cause!
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Exercise 2a

Flood Risk Project: Simple Filtering Method

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2a-Complete.fmw

This simple filtering method is a two-step process involving an AttributeFilter and several AttributeRangeMapper transformers.
You should already have the start workspace open.

1) Place AttributeFilter
Place an AttributeFilter connected to the AttributeRenamer:

Inspect the parameters either in the parameters dialog or the Parameter Editor window. Select Zone as the attribute to filter by. In
the Attribute Values field enter the values 100, 200, and 300:

You could use the Import function, but for so few values it’s hardly worth it.
Apply the changes, and you’ll see a new output port added for each value you specified.

2) Add AttributeRangeMapper
Add an AttributeRangeMapper transformer and connect it to the 100 output port of the AttributeFilter:
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Inspect the parameters. As you’ll see this is a lookup table that involves ranges. We should be able to map the elevation range to a
final flood risk using the information in the original table.
So, select Elevation as the Source Attribute. Enter FloodRisk as the Output Attribute:

In the Range Lookup Table, enter the From-To values as follows:
From

To

Output Value

0

10

1

10

25

2

25

60

3

If an elevation falls precisely on one value (for example 25), it is counted in the lower band (i.e. 10-25). Enter 999 as the Default,
so that any features whose elevation does not match, for whatever reason, is flagged appropriately:

Apply the changes. You may wish to run the translation and inspect the AttributeRangeMapper results, to ensure that this part is
working correctly.

Miss Vector says...
Hopefully you see that the Output Value numbers come from the flood risk table in the introduction to this
exercise! Here we're combining the zone that we just filtered by (zone 100) with each possible risk value.
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3) Duplicate AttributeRangeMapper
Now we need to do the same thing for each of the other AttributeFilter output ports. Rather than set them up manually – as above
– the easiest method is to copy the AttributeRangeMapper transformer that we just set up.
So, click on the existing AttributeRangeMapper and press Ctrl+D to duplicate it. Repeat and connect each duplicate to a different
AttributeFilter output port.
The workspace will now look like this:

Now open the parameters dialog for each of the new AttributeRangeMapper transformers in turn and set up the correct Output
Values in accordance with the original table of calculations.
The Output Values will be:
100m Zone

1

2

3

200m Zone

2

3

4

300m Zone

3

4

5

4) Add Inspector
Inspecting cached data doesn't allow you to separate that data out for easier inspection. So place a single Inspector transformer and
connect each AttributeRangeMapper output to it.
Open the Inspector parameters dialog and under Group-By select the newly created attribute called FloodRisk.

TIP
To achieve the same effect with Feature Caching, add a second AttributeFilter and filter by FloodRisk. Set
the filters to 1,2,3,4,5. Then run the workspace, select the transformer, and press Ctrl+I to inspect it.

5) Save and Run Workspace
Save your workspace as a new file to preserve the starting workspace and then run it. You should see each address colored to
match its flood risk. You can also turn off each zone, in turn, to see which addresses are most/least at risk.

Professor Lynn Guistic says…
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If you’re sharp today, you’ll have noticed you could do this process in the reverse order. Instead of
filtering by zone then mapping elevation, you could filter by elevation and then map zone. This would
require a combination of AttributeRangeFilter and AttributeValueMapper transformers.

CONGRATULATIONS
By completing this exercise you have learned how to:
Filter data with a simple test in order to subdivide it for attribute mapping
Map attribute values
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Exercise 2b

Flood Risk Project: Complex Filtering Method

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2b-Complete.fmw

This slightly more complex method is also is a filtering process, but the filtering is all done in a single step - for both zones and
elevation - with a TestFilter.

1) Place TestFilter
Place a TestFilter connected to the AttributeRenamer:

What we want to get here is a separate output port for each flood risk value. So we’ll need to incorporate all of the tests into this
one transformer.

2) Set First TestFilter Condition
Inspect the parameters either in the parameters dialog or Parameter Editor window. See that there are fields for Test Condition and
Output Port. Double-click the first Test Condition field and a Tester-like dialog will open:
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This can be the test for FloodRisk=1 (the highest). According to the table of calculations, this can occur only when Zone=100 and
Elevation <= 10. So, set up the conditions to test for Zone = 100 AND Elevation <= 10. The important part here is to set up the
test as an AND (i.e. both clauses must be true).
Enter 1 into the Output Port parameter at the foot of the dialog:

Now click OK to close this part of the dialog.
The main TestFilter dialog now looks like this:

3) Set Second TestFilter Condition
Now double-click the next Test Condition (Else If) to set up the condition for FloodRisk=2
According to the table, there are two conditions for FloodRisk=2. They are when:
Zone = 200 AND Elevation <= 10
Zone = 100 AND Elevation <= 25
So, enter four clauses; one each for Zone=100, Zone=200, Elevation<=10, Elevation<=25. You can use the Copy and Paste
buttons or the keyboard shortcuts in this dialog to help speed up the process.
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Then change the test type to Composite. In the Composite Expression field, enter:
(1 AND 4) OR (2 AND 3)
Of course, the composite expression field depends on the order in which you entered the clauses. If you entered them in a different
order, then you will need to adjust this field.
Enter 2 into the Output Port parameter and click OK to close this dialog. The main TestFilter dialog now looks like this:

4) Set Remaining TestFilter Conditions
Now repeat the above steps for each of the other flood risk values. There will be five conditions in all (one for each flood risk).
It may seem complicated, but it should be easy to get into a routine. Additionally, make use of the Copy and Paste buttons in these
dialogs to speed up the process.
The final dialog will look like this:
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The final test will be similar to the very first, with only two conditions so that it will be an AND rather than a Composite test.
It is essential to keep these in the correct order; otherwise, a feature may pass the tests in the wrong order and receive a lesser risk
than expected. You can change the order by highlighting a line and then clicking on the arrow buttons to move the condition up or
down.
Apply the changes to the parameters.

5) Add AttributeCreator
So far we've filtered the data, but not set an attribute with the result.
To do so, add an AttributeCreator (or AttributeManager) connected to each TestFilter output port. Use the AttributeCreator to
create the correct FloodRisk attribute (and value) for each output port (i.e. Port 1: FloodRisk = 1):
It’s easiest to place one AttributeCreator and duplicate it for each port, editing the FloodRisk value each time.

6) Inspect Results
Run the workspace, using your preferred method of data inspection. For inspecting cached data, you can simply select all of the
AttributeCreator transformers and inspect them all.
For Inspector transformers, place a single Inspector transformer and connect each AttributeCreator/Manager output to it. Open the
Inspector parameters dialog and under Group-By select the newly created attribute called FloodRisk.
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TIP
The quickest way to place a new Inspector transformer in this scenario is to select all of the
AttributeCreator/Manager transformers and then add an Inspector using Quick Add. This will
automatically connect all three transformers. You'll still need to manually set the group-by setting on the
Inspector.

The workspace will now look like this:

7) Save and Run Workspace
Save your workspace as a new file to preserve the starting workspace and then run it. You should see each address colored to
match its flood risk. You can also turn off each zone, in turn, to see which addresses are most/least at risk.

CONGRATULATIONS
By completing this exercise you have learned how to:
Filter data with a complex test in order to subdivide it for attribute mapping

50

Exercise: Flood Risk Assessment: Conditional Values

Exercise 2c

Flood Risk Project: Conditional Values Method

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex2c-Complete.fmw

This is a one-step process involving an AttributeManager transformer.

1) Place AttributeManager
Place an AttributeManager transformer and connect it to the AttributeRenamer:

2) Set First AttributeManager Condition
Inspect the parameters either in the parameters dialog or the Parameter Editor window. Ignoring all of the existing attributes, scroll
to the bottom of the dialog and in the <Add New Attribute> field enter FloodRisk.
In the Attribute Value field click the drop-down arrow and choose Conditional Value:

This opens a new dialog very similar to a Tester/TestFilter transformer. There are fields for Test Condition and Output Value.
Double-click the first Test Condition field and a Tester-like dialog will open:
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This can be the test for FloodRisk=1 (the highest). According to the table of calculations, this can occur only when Zone=100 and
Elevation <= 10. So, set up the conditions to test for Zone = 100 AND Elevation <= 10. The important part here is to set up the
test as an AND (i.e. both clauses) must be true.
Enter 1 into the Attribute Value parameter at the foot of the dialog:

Now click OK to close this part of the dialog.
The main Conditional Definition dialog now looks like this:
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3) Set Second AttributeManager Condition
Now double-click the next Test Condition (Else If) to set up the condition for FloodRisk=2
According to the table, there are two conditions for FloodRisk=2. They are when:
Zone = 200 AND Elevation <= 10
Zone = 100 AND Elevation <= 25
So, enter four clauses; one each for Zone=100, Zone=200, Elevation<=10, Elevation<=25.

Also, change the test type to Composite. In the Composite Expression field, enter:
(1 AND 4) OR (2 AND 3)
Of course, the composite expression field depends on the order in which you entered the clauses. If you entered them in a different
order, then you will need to adjust this field.
Enter 2 into the Attribute Value parameter and click OK to close this dialog. The main Conditional Definition dialog now looks
like this:
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4) Set Remaining TestFilter Conditions
Now repeat the above steps for each of the other flood risk values. There will be five conditions in all (one for each flood risk).
It may seem complicated, but it should be easy to get into a routine. Additionally, make use of the Copy and Paste buttons or
keyboard shortcuts in these dialogs to speed up the process.
The final dialog will look like this:
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It is essential to keep these in the correct order; otherwise, a feature may pass the tests in the wrong order and receive a lesser risk
than expected.
Accept the changes and the main AttributeManager dialog now looks like this:

5) Add Inspector
Inspecting cached data doesn't allow you to separate that data out for easier inspection. So place a single Inspector transformer and
connect each AttributeRangeMapper output to it.
Open the Inspector parameters dialog and under Group-By select the newly created attribute called FloodRisk.

TIP
To achieve the same effect with Feature Caching, add a second AttributeFilter and filter by FloodRisk. Set
the filters to 1,2,3,4,5. Then run the workspace, select the transformer, and press Ctrl+I to inspect it.

6) Save and Run Workspace
Save and run the workspace. You should see each address colored to match its flood risk. You can also turn off each zone, in turn,
to see which addresses are most/least at risk.

CONGRATULATIONS
By completing this exercise you have learned how to:
Use Conditional Attributes to map data according to a set of complex conditions
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Adjacent Feature Attributes
Normally a feature in FME is self-contained. It might get processed as a group at some point, but other than that it doesn’t have
any relationship to other features in the workspace.
However, in some cases, the ability for a feature to access the attributes of other features is quite useful.
For example, take a tabular dataset of coordinates recorded as follows:
X

Y

+0.0

+3.0

+3.2

+0.0

-3.2

+0.0

+0.0

+3.4

+4.2

+0.0

In this case each row is not an absolute coordinate; instead, it is an offset from the previous one. Therefore, to calculate the true
coordinates, each feature needs to know the coordinates of the previous feature, so that it can apply the offset.
This sort of scenario is catered for by Adjacent Feature Attributes in FME.

Adjacent Feature Functionality
Adjacent Feature functionality is activated by checking the box labeled Enable Adjacent Feature Attributes in an AttributeCreator
or AttributeManager transformer:

This opens up a section of dialog in which the author can specify how many features preceding the current feature, or how many
features that succeed it, should be made available. In the above screenshot attributes from the previous and subsequent two
features will become available.

Using Multiple Feature Attributes
The simplest way to make use of the attributes retrieved from prior/subsequent features is through the text or arithmetic editors,
where the list of feature attributes has an expandable section for prior and subsequent features:
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Notice above how attributes are available not only for the current feature but also for the previous/subsequent two features. As
with the current attribute, double-clicking an adjacent attribute adds it to the expression window:

In the above screenshot, the workspace author is using data on parking offenses. They create a string composed of a date and an
offense and then add the prior two offenses (we're assuming that the data is already sorted in date order).
You can see that prior and subsequent attribute values can be accessed simply by using feature[x]. where x is a positive or
negative number that refers to a subsequent or prior feature.

Professor Lynn Guistic says…
This is a first-class piece of functionality, excellent to the highest degree.
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However... be aware that extra system resources are used for storage of adjacent features. Therefore
translation performance will take a (fairly minor) hit when using these capabilities, the degree of which
depends on the number of attributes being retained.

Missing Values
The AttributeCreator and AttributeManager also have an option to specify what should happen if the attributes being used in a
string are missing:

When the transformer tries to use a value that is missing (or null or empty) this option lets the user choose a replacement value, or
to carry out no substitution.
Notice that this setting applies to attributes of the current feature, just as much as attributes of adjacent features.

Miss Vector says...
My AttributeManager sets up NewAttribute = OldAttribute + feature[+1].OldAttribute
There are 100 features in my dataset. Given that feature[101].OldAttribute doesn't exist, what will the
value of NewAttribute be for the 100th feature?
1. No value at all (empty attribute)
2. The same as feature[100].OldAttribute
3. It depends on the Substitute Value parameter
4. Nothing. FME will crash and explode your computer
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Exercise 3

Precipitation Calculations

Data

Precipitation Data (Microsoft Excel)

Overall Goal

Calculate monthly precipitation

Demonstrates

Adjacent feature attributes

Start Workspace

None

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex3-Complete.fmw

You're working on a project mapping monthly precipitation (rainfall) in the city. You have been given a dataset like so:
Month

Precipitation

Jan

168

Feb

273

Mar

387

Apr

476

May

541

Jun

595

Jul

631

Aug

668

Sep

719

Oct

840

Nov

1029

Dec

1191

Unfortunately, the numbers are a cumulative amount, and you wanted to map individual figures for each month.
Rather than reaching into your desk drawer for a calculator, you decide to use FME to do the calculations!

1) Create Workspace
Create a workspace to translate the data as follows:
Reader Format

Microsoft Excel

Reader Dataset

C:\FMEData2018\Data\ElevationModel\Precipitation.xlsx

Writer Format

Microsoft Excel

Writer Dataset

C:\FMEData2018\Output\Training\MonthlyPrecipitation.xlsx

When creating the workspace, check the parameters for the reader to ensure FME recognizes the headers at the top of each
column.

2) Add AttributeManager
To calculate precipitation for any given month, you need to subtract the previous month's cumulative total from the current
month's cumulative total.
With FME you can use the Adjacent Feature Attribute functionality to fetch the previous month's number.
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So, place an AttributeManager transformer between the reader and writer feature types:

3) Set AttributeManager Parameters 1
Inspect the AttributeManager's parameters, either in the parameters dialog or the Parameter Editor window.
Expand the advanced set of attributes and check the box marked Enable Adjacent Feature Attributes. In the fields provided enter 1
for the Number of Prior Features to keep.
Next set the parameter Substitute Missing, Null and Empty by: to Default Value and enter 0 into the Default Value field:

Professor Lynn Guistic says…
The substitution parameter is more important than perhaps most people recognize.
Think about it: the first feature to be processed can’t have a prior feature, and the last feature to be
processed won’t ever have a subsequent one. Therefore you always have to be careful about what you have
set here.
In this exercise we’re calculating a numeric value; therefore it makes sense to use 0 (zero) as the default
replacement.

4) Set AttributeManager Parameters 2
Now let's calculate the new precipitation value.
In the Attribute Value field for the precipitation attribute, click the drop-down arrow and open the Arithmetic Editor:
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In the arithmetic editor dialog use the menu on the left to select:
The FME Feature Attribute Precipitation
The Math Operator – (minus)
The FME Feature Attribute Precipitation for feature[-1]
All of which should leave you with an expression looking like this:
@Value(Precipitation)-@Value(feature[-1].Precipitation)

Now you can see why it was so important to set the substitution field because it’s uncertain what result would occur from the
above when feature[-1].Precipitation is missing!
Click OK to close the Arithmetic Editor dialog, and then accept the parameter changes.

5) Save and Run Workspace
Save the workspace and then run it. Inspect the output.
The numbers start out looking correct but quickly become wrong. Not even in Vancouver (I mean, Interopolis) does it rain 623mm
in a single month!
The problem is this: unlike other occasions in FME, here we can’t simply overwrite the attribute we are working with. That’s
because it skews the next calculation. i.e. the calculation for March needs to operate on February's original number, but instead, it
receives the value we've just overwritten it with!
The only way to solve this is by creating a new attribute.

6) Adjust Workspace
Return to the workspace. Edit the writer schema by renaming the destination attribute Precipitation to MonthlyPrecipitation:
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Now return to the AttributeManager and change it to create an entirely new attribute called MonthlyPrecipitation. You can copy
and paste the line to save time; just change the Output Attribute name:

It's a pain to have to do, but blame me for leading you in the wrong direction at first! You can't even just rename Precipitation to
MonthlyPrecipitation since, whatever you call it, it still fetches an incorrect value. You'll have to reset its Action field to "Do
Nothing" and then create a new attribute.

7) Re-Run Workspace.
Save the workspace.
Before you re-run the workspace, check the writer parameter called "Overwrite Existing File" in the Navigator window.
Set it to Yes – if it isn’t already – so the output overwrites the destination dataset and doesn’t just append this data to the same
spreadsheet.
Also, make sure the file you are writing to is not already open in Excel (or any other editor).
Re-run the workspace.
Inspect the output. This time the numbers should be correct:
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Professor Lynn Guistic says…
If the values in the output are literally "273-168", "387-273", etc., then you've used the string editor and
not the arithmetic editor! If the values are all zero, then you need to make sure the AttributeManager
action is set to Do Nothing for the Precipitation field, rather than Set Value.

CONGRATULATIONS
By completing this exercise you have learned how to:
Expose adjacent feature attributes
Use adjacent feature attributes
Handle missing values in attribute manipulation

63

Null Attributes

Null Attributes
Null attributes are a very important part of FME’s attribute handling. Not every dataset has null values, and not every format
supports them; but when they do exist it is important for FME to handle them correctly.

What is a Null Value?
In general, a null attribute value is the equivalent of nothing. However, it’s important to be precise in our terminology because
there are many ways to represent nothing:
An attribute has a particular state that indicates nothingness (null)
An attribute has a particular value that indicates nothingness (for example, -999)
An attribute exists but has no value (empty)
An attribute doesn’t exist (missing)
A numeric attribute is NaN (Not a Number)
A numeric attribute has a value of zero
In fact, Safe Software’s developers identified fifteen (15) different ways for “nothing” to be represented in spatial and tabular data.

Professor Lynn Guistic says…
In case you are wondering, yes, our developers were the subject of many jokes for having spent six months
"working on nothing"!

So when we talk about null, it has a particular meaning. For us, null is a specific state that is deliberately set to signify that the
information does not exist. It tells us that the lack of information is not a mistake, as a missing or empty value might be.
Because there are so many different methods, this section will discuss ways to handle "nothing" attribute values, but with a
particular emphasis on Null values.

How does FME Represent Nothing?
FME’s internal engine has its own state to represent null. However, when presented to the user, a null value is usually represented
as <null>.
For example, this feature in the Logger has <null> for the ParkName attribute:

Similarly, the FME Data Inspector will depict nulls as <null>:
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Notice how we have a wide range of "nothing" values here. The ParkName is a true <null>, the RefParkId has a value of -9999,
and Washrooms is <missing> (meaning the attribute doesn't exist).

Professor Lynn Guistic says…
<missing> is an interesting concept. You might be asking, "how do we know when an attribute is
missing"? But a better question is "how do we know that the attribute should exist"?
We know it should exist because it appears in the schema defined in a reader. For example, in the above
screenshot, Washrooms appears in the schema, but for some reason certain features do not have that
attribute. That makes the attribute <missing>.
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Handling Nothing
Besides representing all forms of nothing in its interface, FME also allows nothing to be a condition in various tests, lets users set
nothing values, and allows bulk updates from one form of nothing to another.

Recognizing Null Values
Various formats have various ways to represent nothing. However, if they support the concept of null, then FME will read any null
attributes with a <null> value.
For a workspace to check for incoming nulls, the Tester transformer has specific operators to test for null, empty, and missing
values:

Because the Tester interface is incorporated into many facets of FME (such as the TestFilter transformer or Conditional
attributes/parameters), you can test for nulls wherever you find that interface.

TIP
The "Attribute Has a Value" test returns true when an attribute is not null, is not empty, and is not missing
- saving you the inconvenience of having to use those three tests separately.

Other Null-Handling Transformers
Many other transformers also allow testing for nulls. For example, the Matcher transformer has options as to whether null values
constitute a match:
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This parameter lets the workspace author decide whether null, empty, and missing values should be treated as different values.
If set to No, then two features can match even if one has an attribute that is <null> and the other has an attribute that is <missing>.
If set to Yes, then two features can only match when their attributes are the same type of nothing; i.e., when <null> one on feature
is matched by <null> on the other.
Another example is the AttributeFilter transformer, which has separate output ports for <Empty>, <Missing>, and <Null>:

Writing Null Values
It's often important to be able to test for and filter null values as part of a data validation process, or when a null value would cause
problems in a calculation.
However, it's also important to be able to filter out null values for writing data. That's because what happens when an attribute set
to null is sent to a writer depends very much upon the data format.
If the format supports <null> then the destination dataset will contain <null> attributes.
If the format doesn’t support <null>, then FME will automatically convert the data to the closest representation that is supported.
For example, MapInfo TAB does not have a concept of <null>; instead text attributes are not written (so FME will read them back
as <missing>) and numeric attributes are written as -9999 (which is a MapInfo equivalent to null).

TIP
Be aware that FME only converts "null" values when the format does not support the current
representation. For example, if a feature has an empty attribute value, and the format allows empty
values, then FME will not convert the data to a true <null>.

Joining with Null Attribute Keys and Values
There are various transformers in FME that join data together in some way; the FeatureMerger, FeatureJoiner, and DatabaseJoiner
are all examples of these.
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When joining data, one consideration must be handling null values, particularly null key values in an attribute join.
When FME compares keys, and one key is null, it must consider what action is correct. Should that feature be rejected, or should
that feature be joined to other features that also have a null key?
Similarly, when FME merges attributes and there is a clash, most transformers have a parameter to specify which takes
precedence. But should that action be the same when the attribute with priority has a null value? Should a null overwrite an actual
value?
These are all aspects of data joins to consider. Some transformers - for example, the FeatureMerger - have a specific parameter to
handle nulls. In general, you should always inspect the documentation for each transformer if you suspect that your data contains
null values that need handling.
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Setting Null Values
The usual way to set an attribute value is with the AttributeCreator or AttributeManager, and these have an option in their dropdown menu to set a value to null:

Conditional Attributes functionality also supports setting <null> values:

Bulk Null Updates
The way to handle bulk updates of attributes is with the NullAttributeMapper transformer.
The NullAttributeMapper transformer allows the author to check values for any or all attributes on a feature, and convert them in
bulk to or from null.
For example, here the author is checking for attributes that are either missing or empty and converting them to nulls:
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One reason for this might be that the workspace converts data from a format that does not support nulls, to one that does. It's
necessary to explicitly map the values here because empty/missing values may be permitted in the output and FME will not
automatically map data from empty to null, just because a format supports it.
In this second example, the author is checking attributes for existing null values. If the value is set to null then it gets replaced
with a zero:

Presumably, this must be a numeric field. If it was a text field perhaps the author would set it to an empty string instead. Unlike
before, the author wouldn't need to do this when converting from a format that supports null to a format that doesn't, because FME
will map the values automatically when the current state isn't supported.
A better reason for this mapping is that the author wants to carry out a numeric, calculation where zero is a valid number but
<null> isn't.

Miss Vector says...
My reader format supports nulls and includes known null values in the data. My writer format is a simple
text format that does not support nulls. What must I do to get my workspace to work correctly?
1. Delete the attributes with the AttributeRemover
2. Set the advanced reader parameter "Read Nulls as Empty" to Yes
3. Use the NullAttributeMapper to convert all <null> values to <empty>
4. Nothing, the writer will convert the values as necessary
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Exercise 4

Parks Dataset Sorting

Data

Parks (MapInfo TAB)

Overall Goal

Sort parks into alphabetical order

Demonstrates

Null attribute handling

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex4-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex4-Complete.fmw

In this workspace, a colleague is trying to write out a list of parks to a Geodatabase dataset. It’s important that the parks are in
alphabetical order – according to their name – and that features with no park names are written as null and appear last in the
dataset.
However, the workspace they have does not seem to be doing what they need. The parks are sorted alphabetically, but un-named
parks always appear first.

1) Start Workbench
Open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\Attributes-Ex4-Begin.fmw
Inspect the source dataset by clicking the source feature type and choosing the pop-up inspection button.
In the Data Inspector examine the data in the Table View window. You’ll see that the data is in order of ID, not name and that
there are <missing> values scattered throughout:

To sort the <missing> data we'll need to set their ParkName attribute to something that appears at the bottom of a sorted list, then
set them back to null afterward.

2) Add NullAttributeMapper
Add a NullAttributeMapper transformer prior to the Sorter transformer. Inspect the parameters.
Ensure “Map” is set to Selected Attributes, and choose the attribute ParkName:

Underneath that is a section of what to map to.
We know the values in here are currently listed as <missing> so set the “If Attribute Value Is” parameter to Missing (Selected
Attributes Only)
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We want to map these to a value that appears at the bottom of an alphabetically sorted list, so change “Map To” to New Value and
enter ZZZ as the new value.

Accept the parameter changes.

3) Add NullAttributeMapper
Now add a second NullAttributeMapper; this time it should be connected after the Sorter.
Open the parameters and, once again, ensure “Map” is set to Selected Attributes and select the ParkName attribute. This time turn
the ZZZ values back to nulls:

Technically we could just turn them back into <missing>; the Geodatabase writer will write them out as nulls. However, assuming
we didn’t know that, null is the safer option and bound to give us what we want.

4) Save and Run Workspace
Save the workspace and then run it. Inspect the output. This time the data should be sorted by ParkName, but with all null values
at the end of the dataset:
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5) Fix RefParkId
Your colleague now asks you to fix the RefParkId field. You'll have noticed that a lot of the values are -9999. That's the MapInfo
equivalent of "nothing", but for Geodatabase it would be better to set these to proper nulls.

Miss Vector says...
That's very simple to do. Take a moment to think about how before you look at the instructions!

To do this open the parameters dialog for the first NullAttributeMapper. Add RefParkId to the list of attributes for processing.
Then add -9999 to the Or If Attribute Value Is field:
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Now open the second NullAttributeMapper and add RefParkId to the list of attributes for processing.
Now, these values will get mapped to ZZZ with the missing ParkName values. Then they will be turned into true nulls by the
second NullAttributeMapper.

Advanced Exercise
If you still have time, you should filter out the null ParkNames and RefParkIDs and write them to a
separate Feature Type (table) in the Geodatabase.

CONGRATULATIONS
By completing this exercise you have learned how to:
Identify null and missing attribute values
Set null and missing attribute values
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Module Review
This chapter looked at advanced techniques for handling attributes in FME.
What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
Attributes can be constructed either with a series of transformers or inside a single transformer using Text and Arithmetic
editors.
Constructing an attribute as a series of transformers is more self-documenting, but a single transformer is more elegant and
reduces canvas clutter.
Conditional Values are when an author constructs an attribute according to a number of test conditions.
Multiple Feature Attributes is a technique where any feature can access the attributes of previous or subsequent features.
Null attributes are those whose state indicates lack of a value.
FME Skills
The ability to construct attributes with either the Text or Arithmetic editors.
The ability to apply conditional attribute values, and the knowledge to know when this is a good approach.
The ability to use Multiple Feature Attributes.
The ability to use test for null values, and change values to or from null.

Further Reading
For further reading take a look at articles tagged with Null on our blog, or this article on Adjacent Feature Attributes.
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Do you know which transformers can be used to create attributes? Select all that apply:
1. AttributeCopier
2. AttributeCreator
3. AttributeManager
4. AttributeRenamer
The AttributeCreator is obvious and - hopefully - so is the AttributeManager. Other transformers may
have allowed attribute creation at some point, but those capabilities should no longer be needed.

Miss Vector says...
The output attribute "value" in a conditional setup can be which of these (select all that apply):
1. A simple value like a string or number
2. A value constructed from a text or arithmetic editor
3. No Action (i.e. the value will remain what it was)
4. A command to FME to cancel the translation
Yes, all of these are valid. You can type in a simple value or construct one with an editor, or even set the
value to a user parameter. But the Output Value field also does not need to be a "value" at all! It can be
any action on the usual dropdown menu, including Null, No Action, or Stop Translation.

Miss Vector says...
My AttributeManager sets up NewAttribute = OldAttribute + feature[+1].OldAttribute
There are 100 features in my dataset. Given that feature[101].OldAttribute doesn't exist, what will the
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value of NewAttribute be for the 100th feature?
1. No value at all (empty attribute)
2. The same as feature[100].OldAttribute
3. It depends on the Substitute Value parameter
4. FME will crash and explode your computer
You as the author get the choice of what happens when a value is missing, using the Substitute Value
parameter, and that includes values that are missing because they are out of range. If you don't set a
substitute value, then the result will be that NewAttribute is <missing> for feature 100.

Miss Vector says...
My reader format supports nulls and includes known null values in the data. My writer format is a simple
text format that does not support nulls. What must I do to get my workspace to work correctly?
1. Delete the attributes with the AttributeRemover
2. Set the advanced reader parameter "Read Nulls as Empty" to Yes
3. Use the NullAttributeMapper to convert all <null> values to <empty>
4. Nothing, the writer will convert the values as necessary
If a format doesn't support nulls then the writer will write the data in a format as close to null as possible
for that format. Sometimes it will be an empty value, other formats have a specific value for null (like
-9999).
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Advanced Workspace Design
Workspaces can become quite complex, so it is important to know how to design a workspace so that performance is optimized. It
is also a good idea to learn how to read the log file to ensure you can spot the differences in performance as well as be able to
decipher errors and warnings to help you debug the workspace.

Jake Speedie says…
Hi, I'm Jake Speedie, and I'm here to power you through this section on Advanced Workspace Design.
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Feature Caching
Sometimes it is important to inspect data at any step of the translation. Adding an Inspector transformer at every step would be
tiresome, so instead FME has an option to cache data automatically.
This behavior is activated using Run > Run with Feature Caching on the menubar:

With this option active, FME generates caches at every step of the translation when the workspace runs:

The caches are indicated by small icons on each object. In the above screenshot, the caches are green, but they can change to
yellow or red depending on how fresh the data is.

NEW
Run with Feature Caching is essentially the same as Run with Full Inspection in prior versions of FME. It
has been renamed in FME2018 to match new functionality that takes advantage of these caches.

Inspecting Cached Features
Cached features can be inspected by simply clicking on the icon on a particular object.
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Saving Caches
Caches can be saved in the workspace so work can continue later without having to re-run the entire workspace. This is done by
saving the workspace as a template file, using File > Save As Template... on the menu bar:

Then when saving the template file, enable Include Feature Caches:

This way when the template workspace is opened, anyone using FME2018 can inspect the saved caches and run the workspace.

TIP
It's certainly quicker to set up "Run with Data Caching" than to manually add Inspector transformers.
However, be aware that caching data naturally causes the translation to be slower, and to use system
resources such as disk space.
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Data caching is very useful while developing a workspace, but should be turned off before putting a
workspace into production.
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Partial Runs
When caching is turned on, running a translation causes data to be cached at every part of the workspace. In subsequent runs,
those caches can be used instead of having to re-run entire sections of a workspace.
Here, for example, a workspace has been run with caching turned on:

Now the author makes a change to the LineCombiner parameters:

Notice that the caches change color (to yellow) on the LineCombiner and subsequent transformers. This denotes that caches are
stale; their data contents no longer match what the workspace would produce. To get the new results, the author must re-run the
workspace. However, they do not have to re-run the entire workspace; they can simply start the workspace at the point of change the LineCombiner:

Run From This causes the workspace to run from that point only, using data cached up until that point. Notice how hovering over
the option causes all "downstream" transformers to be highlighted. They are the only ones that will be run. That makes the
translation quicker. The other option is Run To This. The author could use that option on the writer feature type and get much the
same effect:
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...but notice how the second branch from the LengthCalculator does not get highlighted. It will not be run. That shows how you
can avoid running a particular section of workspace, in much the same way as if that connection had been disabled.

.1 UPDATE
F6 is the shortcut key to "Run From This".
Normally Run From This will check prior transformers, and prompt the user to run them too if the prior
caches are stale. However, in 2018.1 the F6 shortcut bypasses the user prompt and runs only any required
transformers.
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Bookmarks
Bookmarks play an important role in a well-styled workspace for a number of reasons, including:
Design: As a way to subdivide a workspace and manage those sections
Access: As a marker for quick access to a certain section of the workspace
Editing: As a means to move groups of transformers at a time
Performance: As a means to improve workspace performance when caching data

Design
Bookmarks are a great way to plan and design your workspace. Using bookmarks to create a wireframe mockup before adding
transformer:

Access
Bookmarks can be navigated through, which creates a presentation type form that zooms in on your bookmark of interest. This is
also incredibly useful once your workspace extends beyond the view of your screen:

To set up bookmark navigation, open up the properties of the bookmark and then select Include for Bookmark Navigator:
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Editing
Bookmarks can be used to move a group of transformers at a time. This is useful for organizing and cleaning up a workspace.

Deleting Bookmarks
To delete all of the contents of a bookmark, including the bookmark itself, collapse the bookmark then delete it. This is useful for
removing entire sections of your workspace:

To remove only the bookmark, leave the bookmark expanded and then delete it:

NEW
Collapsible bookmarks are an entirely new feature for FME2018.

Performance and Bookmarks
When using Feature Caching, performance is adversely affected, especially when working with large workspaces. Caching all of
the data can be prevented by using bookmarks. When a bookmark is collapsed, only the output features are cached when the
workspace runs:
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This means that data is cached only for the final transformer in the bookmark, saving considerable time and resources.
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Exercise 1

Public Art in Parks - Feature Caching

Data

City Neighborhoods (Google KML)
Public Art (Microsoft Excel)
Parks (MapInfo Tab)
City Orthophotos (GeoTIFF)

Overall Goal

Plan out a workspace and determine which parks do not contain public art

Demonstrates

Workspace layouting and running a translation with feature caches

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex1-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex1-Complete.fmw

The provincial government has given the city a grant to fund new public art in parks. To maximize the use of funds, the city would
like to add art to parks without existing art.
You are tasked with creating a workspace to determine which parks should get new artwork. Before any art is commissioned, the
proposal needs to have public input so your output data will need to be broken down to a neighborhood level.
This workspace will also be passed on to several different departments so you will need to ensure that it runs efficiently and is
well designed.

1) Start Workbench
Open a blank workspace (or open the starting workspace and skip to step two).
There is a lot to think about before you start creating your workspace, so you have decided to create a quick wireframe design
using bookmarks, to lay out what you need to do.
First, we'll need to read in the following datasets:
Parks.tab
NeighbourhoodBoundaries.kml
PublicArt.xlsx
The entire folder of GeoTiff orthophotos
For now, just mark their place in the workspace with a bookmark. We don't know how large each section will be, so make them all
the same size for now.
Next, we will need to create points and reproject the public art, then overlay the public art on the parks to find out which ones are
contained within a park boundary; so add a bookmark for this section.
Then we will need to test for parks without art and create a label for our map.
Next, we will handle the orthophoto data, and clip it to the neighborhood boundaries. There might need to be some raster postprocessing after we clip it, so add in a section for that.
Finally, we will overlay the parks without art on the raster images and write it all out to GeoTiff:
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2) Read in the data
Now we can start adding substance to the workspace. Let's read in all the data, each with an individual reader:
Reader Format

MapInfo Tab (MITAB)

Reader Dataset

C:\FMEData2018\Data\Parks\Parks.tab

Reader Format

Microsoft Excel

Reader Dataset

C:\FMEData2018\Data\Culture\PublicArt.xlsx

Reader Workflow Options

Single Merged Feature Type

Reader Format

Google KML

Reader Dataset

C:\FMEData2018\Data\Boundaries\VancouverNeighborhoods.kml

Reader Workflow Options

Individual Feature Types

Reader Format

GeoTIFF (Geo-referenced Tagged Image File Format)

Reader Datasets

C:\FMEData2018\Data\Orthophotos\02-03-HI.tif to 14-15-RS.tif

Reader Workflow Options

Single Merged Feature Type
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When you read in the VancouverNeighborhoods.kml, you can read in all the Feature Types, just move them to the side. We are
only interested in the Neighborhood Feature type, so move that one into your bookmark.

3) Create points and reproject
For this first exercise, we will focus only on parks and public art. We will need to create points from our Excel data. Add a
VertexCreator transformer to the canvas and connected to the Public Art Feature Type. In the parameters set the X Value and Y
Value to Longitude and Latitude, respectively:

Add a Reprojector transformer connected to the VertexCreator:Output port. In the parameters set the Destination Coordinate
System UTM83-10:
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4) Run workspace with feature caching
Let's test that the point features are correct. Select Run > Run with Feature Caching on the menubar, then Run the workspace. This
will run the workspace, caching all features along the way.
Once the workspace is finished, data caches are represented by green magnifying-glass icons. These can be inspected individually,
but we wish to inspect two caches together.
So, click on the Reprojector transformer. Holding the Shift key on your keyboard, now click the Parks Feature Type to highlight it
as well. Right-click on either the Parks or the Reprojector and choose Inspect cached features... (Ctrl+I is the shortcut). This will
open the selected caches in the FME Data Inspector:

5) Add coordinate system and run from the Reprojector
If (as is probably the case) the two datasets don't line up, it's because there is no coordinate system set on the Microsoft Excel
reader. Let's go back to FME Workbench and fix that.
In the Navigator Window, under the PublicArt [XLSXR] Reader, set the Coordinate System to LL84:

Now the feature caches on the Public Art Feature Type, VertexCreator, and the Reprojector have all turned yellow. This means
that the caches are stale because something changed. We need to re-run the translation, but a good thing about the feature caches is
we only need to run the section that was changed.
Click on the Reprojector, on the popup menu, click Run To This; this will run only the section of the workspace that is highlighted,
in this case, the PublicArt feature type, VertexCreator, and Reprojector:
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Inspect the caches again and this time the data is lined up correctly:

6) Overlay the Public Art onto the Parks
Now let's overlay the Public Art points onto the Parks polygons using the PointOnAreaOverlayer transformer. This will give us an
attribute called _overlaps that we can then test for.
Add a PointOnAreaOverlayer transformer to the canvas. Connect the Parks to the PointOnAreaOverlayer:Area input port and the
reprojected PublicArt to the PointOnAreaOverlayer:Points input port. In the PointOnAreaOverlayer parameters, under Attribute
Accumulation, enable Merge Attributes. This setting ensures attributes from both features are on the output features:
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7) Test for overlaps
Add a Tester transformer to the canvas, connected to the PointOnAreaOverlayer:Area output port. In the Tester parameters dialog
create a test for _overlaps = 0:

This test separates parks with art, from parks without art.
Once you've created the test, click on the Tester and use Run From This (shortcut F6).
The PointOnAreaOverlayer transformer also needs to be run. If you chose Run From This on the menu, then you will see a
warning telling you that prior transformers need to be run as well:

If you use the F6 key, you'll find this is not just a shortcut to the Run From This option, but also bypasses the warning dialog and
runs the workspace including any prior requirements.
Once complete, inspect the Tester:Passed output port, to ensure that the test worked correctly. There should be 68 parks with no
Public Art.
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Don't forget to ensure that you made use of your bookmark wireframes, and resized them as needed. The workspace will be
continued in coming exercises.

CONGRATULATIONS
By completing this exercise, you have learned how to:
Plan out a workspace using bookmarks
Use feature caches to inspect a workspace
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Log File Interpretation
The FME log file is your best friend for assessing performance. It tells you how long a translation took, where the time went, and
how well FME was able to use the available system resources.

Log Messages
The first thing to notice is that the log is made up of a number of messages, each of which consists of a number of fields:
Absolute Date [Optional]
Absolute Time [Optional]
Cumulative Time (for translation)
Elapsed Time (for this message)
Message Type
Message
The Message Type field tells us the nature of the information. It will be one of the following:
ERROR: An error in the translation that usually requires FME to stop or cancel processing.
WARN: A warning that signifies a problem that is not sufficient to stop or cancel processing.
INFORM: An information message relating a non-error item.
STAT: A message on translation statistics such as the number of features processed.

Configuring the Log Window
There are a number of options to adjust the log file and what is displayed. To access these select Tools > FME Options >
Translation within FME Workbench.
These are the options and their default setting:

Some of the most important options are as follows...

Log Timestamps
With this option turned on each message in the log window gets stamped with the time and date it occurred. Timestamps are an
invaluable aid to assessing performance and should be kept on in most cases.
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NB: The log file always contains timestamps, regardless of this setting.

Log Message Filters
Filtering options allow each type of message to be turned on or off in the log window. It can be particularly useful to turn off
INFORM and STAT messages in order to make it easier to spot ERRORs and WARNs; however it does appear strange at first to
run a translation and not see the usual stream of information!

Log Debug
The Log Debug option turns on a series of extra log messages that are usually hidden from the user. Not only will a lot of the
underlying mapping file be exposed, but there will also be a number of ERROR messages labeled BADNEWS.

Log Window Filtering
When the log message filters are turned on, the various messages can be toggled on and off:

In the above image, the author is only viewing the error messages, which makes it easy to see what is causing their translation to
fail.

NEW
Toggle messages buttons have been added to the Translation Log Window for FME2018.

WARNING
Debug messages can help during debugging, but it’s doubtful you’ll want to keep them turned on in
general FME use. Many of the BADNEWS messages are “errors” that FME has trapped and kept to itself
(like an end-of-file message).
Also, note that the Log Debug setting persists in the workspace; in other words, if you turn that setting on
and pass the workspace to another user, it retains the setting and shows debug messages when that other
user runs the workspace!
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TIP
If the log window text is a little small for you, or not stylish enough, use Tools > FME Options >
Appearance > Log Font to change the font size and style.
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Deconstructing the Log File
This section looks in more detail at each part of an FME log.

Jake Speedie says...
Being able to interpret a log file is vital for performance tuning. If you can’t understand what FME is
doing, then there isn’t much chance you’ll be able to improve upon it!

The overall structure of an FME log is approximately four different sections.
Command-line statement
Configuration and setup information
The translation and transformation itself
A summary of the translation

Command Line Statement
At the very top of a log file appears the command line statement. This is the command that FME Workbench is using to run the
translation:

In terms of performance, this section doesn’t tell us much. However, it is useful to confirm which instance of FME is running,
particularly when you have several versions installed. Note that the version number in the above image is merely where FME is
installed; it's not necessarily the version number that's running.
This section also tells us what published parameters are in the workspace and what their values are.
Perhaps the most useful part of this section is that you can copy and paste this statement to run the workspace through a command
line or using a batch file.
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Configuration and Setup Information
Configuration and setup messages in the FME log tell us vital information about FME's version and configuration, the system
resources and how FME intends to use them, and what system paths are being used.

For example, here you can see which version of FME is being used (FME2018.1 beta, 64-bit), its license type (floating), and the
machine name (Training2018). If you do have multiple FME versions installed, here’s where you can check to ensure the correct
one is running.
Further on we can see that the system has 5.17 GB of free space in the FME temporary folder and 128 TB of virtual memory. We
can also see what operating system we are running FME on (Windows Server 10) and what the current language and encoding
settings are:

Later in the log is important information about the system resources and FME’s memory management:

In this case, there is a limit of 4GB memory per process. The following numbers indicate how FME will manage memory
resources. It will use 12GB of virtual memory and then it will start to release memory by caching features to disk. This caching
will stop once virtual memory use is less than 9GB.
This way FME will perform to its potential automatically, while not taking so much memory that the system may fail or other
processes on the system would suffer.
With 64-bit FME, address space is an impractically high number (128TB in Windows 8.1 or later) that has no practical value
(other failures would occur long before that number is breached). So instead of address space, on 64-bit FME the log reports
"Virtual Memory", a more realistic number that combines physical memory with a portion of disk called Swap Space.

32-Bit FME
32-bit FME gives a slightly different set of messages. The numbers reported include "address space", which is a theoretical limit
of the amount of memory FME could use, regardless of available physical memory and disk space:
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Temporary Folder
For performance tuning one of the most critical parts of the log reports the temporary folder being used. When physical memory
resources become low, FME starts to cache data to disk and swap that data in and out of physical memory as required.
The temporary folder is where it writes data to, so there are two important considerations for that folder.
Firstly it's important to ensure this folder does have enough temporary disk space for the translation being carried out. Depending
on the workspace, the transformations being carried out, and other processes happening on the computer; temporary disk space
requirements may be many times greater than the size of the original dataset.
Secondly, it's useful if the disk written to is both fast and unused by any other process. It will not, for example, help performance
to share the temporary disk with the operating system; additionally, a solid-state disk is much faster than a traditional hard drive.

Jake Speedie says…
The comparative benefits of RAM vs. SSD vs. HDD are hard to quantify. Do a web search if you don't
believe me; people quote RAM as being 4x as fast, 20x as fast, 100,000x as fast!
In reality, it depends on so many factors. However, in general, use as much memory as you can to avoid
caching, and use SSD so that - where caching/swapping is unavoidable - it runs as fast as possible.
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Translation and Transformation Statements
The main body of the FME log concerns the translation and transformation of data. This section often appears confusing to new
users, until they understand how FME operates.
Firstly, there can be several parallel streams of processing in a workspace. If you do not explicitly set the order of these streams,
the order of the log will be similarly indecisive.
Secondly, there is the issue of transformer type.
As you might know, some transformers operate on a feature-by-feature basis, while others work on a group of features at a time.
When a series of transformers are all feature-based, FME works by pushing features through on an individual basis, not as a
group. For example, the first feature is read and then processed by each transformer in turn. Then the next feature is read and
processed by each transformer, and so on.
This makes for a log file that is harder to understand because you don’t see one specific entry for each reader or transformer in
turn. Nor do you see a message for each feature. Instead, a cumulative time is calculated and output at regular time-based
intervals.

Feature Tables
Feature Tables are a new technology happening behind the scenes in FME. They are for vector or tabular data but resemble raster
or point cloud data in how they operate. Instead of reading and processing one feature at a time, as before, data is handled more in
"chunks", as a form of bulk processing.
This bulk processing makes interpreting the log window a little more difficult. So far only a handful of formats use this
technology (CSV, FFS, MapInfo Extended, SQLite Non-Spatial); but expect this number to increase with future releases.

Key Messages
There are several key messages that may appear in a log that signify specific events in a translation.

Emptying factory pipeline

This message signifies that reading of data is at an end. Because of how FME processes data, this message may appear near the
beginning of a translation or near the end. However, after this point, the source datasets are closed and only transformation and/or
writing take place.
By checking the timestamp for this message, you can get an approximate value for how long the workspace took to read the
source data.

Unexpected Input Remover

This message denotes where features read by a reader are tested against the available feature types (and merge filters) to see if
they are allowed to pass into the workspace.
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This message may indicate a performance issue as it highlights potentially unnecessary work, where features are being read but
not used in the translation.

ResourceManager: Optimizing Memory Usage. Please wait...

This message alerts you to the fact that some reorganization of memory usage is going on. For example, maybe the memory
management limits mentioned in the configuration part of the log have been reached, and FME is having to work around the issue.
If you see this message frequently, then it’s time to either redesign your translation or switch to a 64-bit setup. It is a key indicator
that a lack of memory is affecting performance.

Miss Vector says…
How would you find the Emptying Factory Pipeline setting in the log window?
1. Looking for the color: it is the only message highlighted in red
2. Looking for the message type: it is the first message of type STATS
3. By using the log search tools
4. By opening Tools > FME Options to turn off all other messages
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Translation Summary
The final part of a log file includes a report of the number of features read and written:

More importantly, from a performance point of view, it includes a brief report of the time taken by the translation and the amount
of memory used:

Peak memory usage is an important statistic. It signifies how hard FME is having to work. If this number can be reduced
performance will often improve.

Written Features
One of the most misinterpreted statistics in an FME log is the number of features written.
What this really means is “the number of features sent to the writer”. It doesn’t always mean the same number of features actually
gets written to the output dataset, or that the output dataset will contain only that number of features.
For example, in the above screenshot, 2 features are reported as sent to a writer. But, for example, if it were an (Esri Shapefile)
writer, a warning earlier in the log might appear:

So in reality, the writer rejected both of these features, in this case because their geometry was invalid. The writer was set up to
write point features, yet these are polygons.
Similarly, a format may have geometry limitations that cause the output dataset to be slightly different to the numbers logged.
For example, MicroStation DGN format has a limit on vertex numbers for each element (feature). If the MicroStation writer
receives a feature with too many vertices, it splits that feature into multiple MicroStation features (elements in MicroStation
speak) to avoid going over the vertex limit.
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Thus, the number of features that actually appear in the dataset can be different to the number of features logged as being sent to
the writer!

WARNING
Currently, features read or written by the FeatureReader/FeatureWriter transformers are not included in
the summary at the end of the log. To find this information you would need to examine the feature counts
displayed on the connections in or out of those transformers.
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Log Timings
The timestamps in FME logs are invaluable for assessing performance.
Remember, the structure of the log is this:
Absolute Time| Cumulative Time| Time for Operation| Message Type| Message Content

Time for Operation is the amount of time spent on that step of the translation, and Cumulative Time is the sum of those
operations.
Although cumulative time is the amount of time the FME process has spent translating or transforming data, it does NOT include
the amount of time spent waiting for other processes to do their work.
For example, examine this section of log timings:
2018-02-10 14:43:06|

8.5| 0.0|

2018-02-10 14:43:13|

8.8| 0.3|

2018-02-10 14:46:29| 18.0| 9.1|
2018-02-10 14:49:29| 25.8| 7.9|

The difference between the start absolute time (14:43) and the finish absolute time (14:49) is over six minutes. However, FME is
only reporting 25.8 seconds of processing time!
The “lost” time is down to external processes that FME was waiting on.
For example, maybe the message content would look like this:
2018-02-10 14:43:06|

8.5| 0.0| INFORM| Preparing SQL query

2018-02-10 14:43:13|

8.8| 0.3| INFORM| Sending SQL query

2018-02-10 14:46:29| 18.0| 9.1| INFORM| Received initial database response
2018-02-10 14:49:29| 25.8| 7.9| INFORM| Received data from database query

Now we can see that it was a database query that FME was waiting for. The more the query was not well-formed or the database
not well-structured, the longer the time difference would be.
Similarly, reading/writing data from/to a disk can account for missing time.
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Exercise 2

Public Art in Parks - Log File Interpretation

Data

City Neighborhoods (Google KML)
Public Art (Microsoft Excel)
Parks (MapInfo Tab)
City Orthophoto (GeoTIFF)

Overall Goal

Plan out a workspace and determine which parks do not contain public art

Demonstrates

Interpreting an FME Log file

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex2-Begin.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex2-Logfile.log

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex2-Complete.fmw

While designing your workspace, you were surprised to see 68 out of the 80 parks don't have public art. Worried that you made a
mistake or that your data is out of date, you passed the workspace to a colleague.
They confirmed the 68 parks and sent back the workspace along with a log file. Before continuing work on your workspace, you
review their workspace and the log file because they mentioned that they got an error last time they tried to run it.

1) Open Log File
Open WorkspaceDesign-Ex2-Logfile.log in a text editor.
This is the log file from your colleague. They said the workspace you sent was working fine but they added some new data and it
broke.
Review the command line section first to get an overview of what is being read into the workspace:

It looks like there are only three datasets, there used to be four. It looks like the PublicArt.xlsx dataset is missing. This might be
why the workspace isn't working, but we should continue reading just to confirm that.
There is a lot going on in a log file and it is easy to get overwhelmed. Scroll all the way to the bottom. The bottom of the log will
tell you if the translation was successful, if there are any error or warning messages and if the data was written out:

The translation failed due to a fatal error. Looking a couple lines above that line we can see why:

The dataset path must have gotten changed between their computer and yours. Thankfully this is an easy fix.

2) Fix Public Art Dataset Path
Start FME Workbench and then open the workspace WorkspaceDesign-Ex2-Begin.fmw.
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TIP
If you still have the workspace open from the previous exercise you can skip Step 2 and move on to Step 3.
The only thing that changed is the PublicArt.xlsx dataset path.

In the Navigator Window, expand the PublicArt [XLSXR] Reader. Double click on the Source Dataset to open the parameters:

Set the Source Microsoft Excel File(s) to:
C:\FMEData2018\Data\Culture\PublicArt.xlsx

Click OK and run the translation. Check the log to ensure the translation was successful:

3) Overlay Vectors on Rasters
Now that the workspace is reading in the correct dataset, we will overlay the park vector polygons on to the orthophoto rasters. To
do this we will use a VectorOnRasterOverlayer transformer. Add a VectorOnRasterOverlayer to the canvas. Connect the
VectorOnRasterOverlayer:Vector input port to the Tester:Passed output port. Then connect the Orthophoto Feature Type to the
VectorOnRasterOverlayer:Raster input port:
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4) Run the Translation
Let's run the translation and make sure the parks were overlaid correctly:

Oh, well it looks like all the featured were sent to the VectorOnRasterOverlayer:Rejected output port, but if we look at the
translation log, it looks like the translation was successful.
Sometimes the translation log doesn't indicate why the feature was rejected because the translation still completed. To find out
why these features were rejected we will need to inspect them. Click on the inspection icon on the
VectorOnRasterOverlayer:Rejected output port to open it up in the Data Inspector.
In the Data Inspector, drag your mouse over any section of the raster image to select all of it. It should be highlighted with a
yellow box. Then in the Feature Information Window look at the fme_rejection_code to find out why these features were rejected:

This error is because we can only overlay vectors onto one raster, so we need to mosaic all the raster tiles together first.

5) Mosaic Rasters
Back in FME Workbench, add a RasterMosaicker transformer between the Orthophotos Feature Type and the
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VectorOnAreaOverlayer so that the RasterMosaicker:Input port is connected to the Orthophotos Feature Type and the
RasterMosaicker:Output port is connected to the VectorOnRasterOverlayer:Raster input port. This transformer will mosaic all of
the orthophoto rasters into a single raster:

You can rerun the translation to ensure that the VectorOnRasterOverlayer is working correctly if you wish.

6) Reproject Neighborhoods
Now that the translation is running smoothly again, we will clip the orthophotos to the neighborhood boundary but first, we will
need to reproject the neighborhood KML file.
Add a Reprojector transformer connected to the Neighborhood KML Feature Type. In the parameters set the Destination
Coordinate System to UTM83-10:

The reason we are not using the Reprojector connected to the Public Art Feature Type is that we want to keep the data separate
until it is ready to be clipped.

7) Clip Orthophoto to Neighborhoods
Now we can clip the raster overlayed with the parks to the neighborhood boundaries. This will result in 6 images, each the shape
of a neighborhood.
In the Clip orthophoto to neighborhoods bookmark, we added in the last exercise, add a Clipper transformer. Connect the
Clipper:Clipper input port to the Reprojector_2:Reprojected output port. Then connect the Clipper:Clipee input port to the
VectorOnRasterOverlayer:Raster output port:

In the parameters, enable Merge Attributes. This will add all the attributes from the Neighbourhoods KML to our raster:
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8) Run and Inspect Data
Before we go any further we should make sure the Clipper did what we expected. Run the translation from the Clipper and inspect
the Clipper:Inside output port:

The orthophoto was clipped correctly with each neighborhood being a new image, but there are black borders around each image.
These black borders are considered nodata, and we will remove them in the next exercise as well as look at increasing the
performance of our workspace.

CONGRATULATIONS
By completing this exercise, you have learned how to:
Overlay vectors onto a raster
Mosaic rasters together
Debug a workspace by reading the log file and fme_rejection_code
Interpret the log file to understand what transformers are doing
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Performance Considerations
FME has, at its heart, a very powerful and speedy translation and transformation engine:

However, as fast as FME is, a significant factor in performance is in the design and optimization of the workspace. To create a
well-designed workspace you need to know what sort of design flaws can impair performance, you need to be able to measure
how well your workspace is performing, and you need to know what techniques you can apply to avoid performance bottlenecks.
But, in fact, perhaps the first thing to discuss is what we even mean by "performance"!

What do we mean by Performance?
According to Wikipedia, performance is a measure of the amount of useful work accomplished relative to the time and resources
used.
In FME terms, good performance is the ability to process spatial and tabular data with the correct results (useful) as fast as
possible (time) and using as little memory and disk space (resources) as possible.

What Can Impair Performance?
There are various factors – you might call them bottlenecks – that can cause FME to run slower than you might hope. Most of the
content of this chapter covers how to overcome or relieve these factors.

Excessive Disk Operations
Physical disk drive throughput is relatively slow compared to other computing processes; therefore the more FME has to read and
write to a physical disk drive, the more performance is impaired. The best performance comes from storing temporary data in
memory, rather than on disk.

Underuse of Resources
Performance can be impaired when an FME translation is not using all of the available system resources. For example, there are
few licensing limits to prevent FME from using all of the CPU cores on a system, and more memory resources are available to 64bit FME than 32-bit.

Excessive Data Amounts
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If performance is described as the amount of “useful” work, then nothing is going to impair performance more than unnecessary
processing. The more excess information that gets read, and the further it is carried into the workspace, the less useful the work is,
and the more performance suffers.
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64-Bit FME
64-bit FME is not for everyone, but used in the right place it can have tremendous benefits.

What is 64-bit FME?
A 32-bit operating system is capable of using memory addresses up to 232. This limits them to using a maximum of 4 gigabytes of
system memory.
A 64-bit operating system can use memory addresses up to 264. This allows them to use a theoretical maximum of 16 billion
gigabytes of memory! In practice, a 64-bit system uses nowhere near that much memory, but it still allows 64-bit software to
access a much greater amount of additional memory than 32-bit.
64-bit FME is a version of FME specifically designed to take advantage of a 64-bit operating system. It is well-suited to
processing huge amounts of data, due to its ability to use a greater amount of memory.

What are the Disadvantages of 64-bit?
There are a number of disadvantages to using 64-bit FME.

Operating System
64-bit FME requires a 64-bit operating system and the hardware to support it. On a 32-bit operating system, you would only be
able to run 32-bit FME.

Format Limitations
Not every format in FME is supported on 64-bit. Usually, that’s because the format itself – or its proprietary software – isn’t
available on 64-bit platforms. In that situation, you would need to use 32-bit FME.

64-bit Clients
Not a limitation, but 64-bit does require care in selecting the correct database clients; for example, when reading 64-bit Oracle
you’ll need to install a special 64-bit client for FME to be able to connect.

Jake Speedie says…
The Safe Software web site has a table of supported formats that can be filtered to show (among other
things) which are supported on 64-bit:
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Miss Vector says…
Let's see if you can figure out the one false statement from these facts about 64-bit FME:
1. 32-bit Windows can use only 32-bit FME. 64-bit Windows can use either 32-bit or 64-bit FME
2. You can install both 32-bit and 64-bit FME on a 64-bit computer, and use either one as necessary
3. You can install 32-bit and 64-bit engines on the same FME Server core
4. A workspace authored on 32-bit FME cannot be run on a 64-bit engine
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General Performance Tips
The core engine of FME is designed and continuously maintained, with the focus on performance. While performance is still
something to keep in mind, it doesn't require excess attention from the author.
However, even though FME is efficient, there are some key areas to be aware of that might impact your performance:
Unused Readers and Feature Types
Unused Writers
Blocker Transformers
Excess Loggers and Inspectors
Reading an entire database
Running with Feature Caching Enabled

Remove Unattached
When developing a workspace, it is easy to lose Feature Types that are unused, especially once the workspace grows in size. To
quickly remove these unused Feature Types go to Tools > Remove... > Remove Unattached in the menu bar.

Remove Loggers and Inspectors
Although you won't see a huge performance difference, it makes for a cleaner workspace. You can remove all of the Loggers and
Inspectors in one go before putting your workspace into production by going to Tools > Remove... > Inspectors or Loggers in the
menu bar. Then select which ones you would like to remove.

Run with Feature Caching
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Running a workspace with Feature Caching enabled takes a huge performance hit because each transformer caches data. It is best
to turn this feature off when it is not needed. If you do require Feature Caching but only for a section of your workspace, use a
collapsible bookmark to only cache the output feature.
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Assessing Performance
Assessing the performance of a workspace such as this:

...requires a bit of time and attention, but knowing how a workspace performs helps to make informed decisions on how to best
design (or redesign) it.
When testing for performance ensure that there is only one instance of FME running, and all other non-essential programs are
closed. You'll also require something to record your times on, like a piece of paper.

Assessing Reader Performance
To be able to improve the efficiency of a reader requires an estimate of how well it is working in the first instance, yet this can be
hard to separate out in a workspace that is also transforming data.
The key message that signifies reading is complete is “Emptying Factory Pipeline”. Here, for example, reading of the data
finished after 26.4 seconds of processing (of course the actual elapsed time might be longer if FME was waiting for a database or
the file system to respond):
2018-06-29 11:48:54|

26.4|

0.0|INFORM|Emptying factory pipeline

However, sometimes that message can be misleading. FME processes the data at the same time it is reading it, so that it won't read
an entire data set before processing. To avoid this confusion, disable all the transformers and simply run the reading part of the
workspace:

With the transformers disabled, the message now appears much sooner:
2018-06-29 11:49:35|

1.2|

0.0|INFORM|Emptying factory pipeline

So we can tell that reading the data is only taking 1.2 seconds.
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Assessing Writer Performance
As with readers, you can't improve the performance of a writer unless you can first assess how well it is already performing.
However, assessing the speed of writing has the same complexity as reading: FME starts writing data as soon as it becomes
available and doesn’t necessarily wait until processing is done.
So, how can we assess writer performance? Assessing a writer is clearly different to a reader. If you isolate the writers by
disabling everything else, there won't be any data to write!
The easiest way is to disable the writer itself!

If the original result was this:
2018-06-29 11:54:14|

26.5|

0.0|INFORM|Translation was SUCCESSFUL with 19

warning(s) (148 feature(s) output)
2018-06-29 11:54:14|

26.5|

0.0|INFORM|FME Session Duration: 26.7 seconds. (CPU:

22.5s user, 4.0s system)

...and with the writer disabled it is now this:
2018-06-29 11:56:48|

26.6|

0.0|INFORM|Translation was SUCCESSFUL with 19

warning(s) (0 feature(s) output)
2018-06-29 11:56:48|

26.6|

0.0|INFORM|FME Session Duration: 26.6 seconds. (CPU:

22.1s user, 4.4s system)

...then we can easily calculate that the writing process is taking merely 0.1 seconds.

TIP
Another method is a two-step process.
Firstly, add a Recorder as the final transformer, to preserve the data in FFS format at the moment it is
about to be written. Run the workspace.
Secondly, replace the Recorder with a Player transformer, to re-read the preserved FFS data. Disable
everything else up to that point and re-run the workspace.
The data is played back into the workspace and written to the output, giving us a measure of writer
performance.

118

Assessing Performance

Assessing Transformer Performance
Assessing the time taken in transformation requires a two-step process.
First, disable writers and run the translation, taking note of the elapsed time:

Then disable the transformers too and rerun the workspace, to calculate the time taken to read the data only. The difference in
elapsed time between reading the data and reading/transforming the data is the elapsed transformation type.
It's important not to add an Inspector or Logger transformer to the end to see what is happening to the output. This will slow the
translation down and give you a false measure. You must also be sure to disable the actual writer and not just the feature types or
connections to them.
The only writer that is useful in this scenario is the Null format writer. This causes a writer to be present, but it does nothing
except to count features and then discard them. The benefit is improved logging of feature counts, but without any data having to
be written.

WARNING
Naturally, where a FeatureReader or FeatureWriter transformer is used, assessing reading and writing
requires a different procedure:

It would be necessary to run the workspace twice; once with everything disabled after that point, and once
with everything disabled up to (and including) that point. Then subtract the two run-times to get the
correct result.
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Improving Reader Performance
The most important method to improve reading performance is to minimize the amount of data that is being read. As already
mentioned, reading excess features counts as unnecessary work and is therefore inefficient.

WARNING
It's bad enough to read extra features, but - in FME 2018 and newer - that effect can be multiplied many
times when Feature Caching is turned on. Therefore you need to be extra careful to read no more data
than is necessary.

Filtering Input
For example, this workspace reads nearly 14,000 features but immediately discards all except 419 of them (ones where the
owner's name begins with "C":

In this scenario, if possible, it would be much more efficient to simply just read those approximately 400 features. Not only does it
avoid reading unnecessary data, but it also avoids caching it twice over!
Fortunately, all formats have various sets of parameters that speed up feature reading, by filtering the amount of data being read.
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The first of these – search envelope – defines the data to read as a geographic area. Then only that area of data needs to be read.
These parameters are available on every spatial data reader but have the most effect when the source data is spatially indexed.
Then the query is being carried out at its most efficient.
Similarly, there are a number of parameters designed to let the user define how many features to read. These parameters include
the ability to define a maximum number of features to read, and what features to start with. There is also a parameter that defines
which feature types (layers or tables) should be read.
By using these judiciously, the amount of data being read can be reduced and the translation sped up. For example, if we knew
that the first records in the dataset were the ones beginning with "C", we could set Max Features to Read to 419.
Other formats – particularly databases – have additional clauses that can help reduce the data flow:

Here, for example, this Geodatabase reader has a ‘WHERE Clause’ parameter that applies the "owner name begins with 'C' test" in
a way that is more efficient than reading the entire contents of a large table and using a Tester transformer.
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Jake Speedie says…
In short, when you want to filter source data, and can use a specific reader parameter to do so, it is more
efficient than reading all of the source data and then filtering it with a transformer.

Excess Feature Types
Another potential bottleneck - specifically for formats with a table list – is the case where you have more feature types than are
necessary.
Here the user has added two tables to their Geodatabase reader:

However, if you look at the workspace, the PostcodeBoundaries table is not even connected to anything. The unconnected table is
still being read - and cached - but the data is being ignored:

Presumably, the user added the tables for some reason, but then decided they did not need them, In that case, they should delete
the feature type from the FME workspace. Then the table will not be read and performance will improve.
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Improving Writer Performance
There are various ways to speed up writing data. Compared to reading, tuning the underlying systems is a more important
improvement, whereas the number of features is less important as it's much harder to write extra data unintentionally.

File System Improvements
If you are writing to a file system then make sure the disk is fast and responsive – use solid state drives – and that the operating
system is not busy writing other files at the same time, as the latter could cause a significant bottleneck.
Also, check if you are using RAID; some configurations need multiple writes and can slow down a translation.

Database Improvements
If you are writing to a database, then existing indexes and joins can cause the process to be slower than expected. In many cases, it
will be quicker to drop an index, write the data, and then recreate the index.
More information on database performance with FME comes in a later section.

Multiple Writers
Perhaps the most important technique for improving writer performance involves the scenario where a workspace has multiple
writers.
In short, it’s important to get the writers into the optimum order, to ensure that the writer that is to receive the largest amount of
data is written first.
The reasoning behind this is that the first writer in a workspace starts to write data as soon as it is received. Other writers cache
theirs until they are ready to start writing.
Therefore, if the largest amount of data is written immediately, lesser amounts of data have to be written to, and stored in, a cache.
This can improve performance tremendously, particularly when the translation is especially unbalanced; for example, one million
features go to one writer, and only ten features go to another.

Jake Speedie says...
Think of it like an airport. It’s more efficient when you load the busiest flights first, because it empties the
terminal waiting areas quicker. For more information see this FME Evangelist article.

Setting Writer Order
There are two ways to affect the order that writing occurs in.
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Firstly each writer is listed in the Navigator window in Workbench and can be re-ordered by moving them up and down in the list
in the Navigator window:

The first writer in the list is the one that is initiated first, therefore it should be the one to receive the most data.
The second method is to use a workspace parameter called Order Writers By:

This parameter can be left to Position in Workbench Navigator in which case the order of writers as defined in the Navigator takes
priority. Alternatively, it can be set to First Feature Written. In that case, the writer that receives the first feature will be the first to
start writing data.

Miss Vector says…
Given this screenshot, which should we make the first writer in this workspace?

1. A
2. B
3. C
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4. Don't know!
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Optimizing Transformation Performance
In most cases, slow, memory-consuming translations are caused by group-based transformers.
Remember that in feature-based transformation a transformer performs an operation on a feature-by-feature basis where a single
feature at a time is processed. Such a transformation only takes as much memory as is necessary to store a single feature.
However, a group-based transformer performs an operation on a group or collection of features and it takes as much memory as is
necessary to store all features of the group!
It is this grouping of data that causes performance degradation. However, many group-based transformers have parameters that, in
effect, make them more feature-based.

Jake Speedie says….
You’ll get better performance when you put the least amount of data into a group-based transformer as
possible. For example, put feature-based filter transformers BEFORE the group-based process, not after it
(see following exercise). Another technique is to make group-based transformers more feature-based...

Input Ordered Parameter
A common parameter to Group-Based transformers is called "Input Ordered." and appears near the Group By parameter in most
transformer dialogs:

The condition for applying these is that the groups of features are pre-sorted into their groups. When this is the case, and the
parameter is set to By Group, then FME processes the data more efficiently.
For example, in the above screenshot, the user is using the ZoneCategory attribute as a group-by parameter (i.e. a set of statistics
is created for each set of features with the same ZoneCategory value). If the incoming data is already sorted in order of
ZoneCategory then the user can set the Input Ordered parameter and allow FME to treat this more like a feature-based
transformer.

WARNING
When using Input Ordered By Group on a transformer with two (or more) input ports, you need to arrange
data to arrive in group order (Port 1, Group A, Port 2, Group A, Port 1, Group B, Port 2, Group B, etc.)
i.e. it's not just a case of each stream of data being ordered correctly, you need to alternate streams/ports
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for each group - and that's very difficult to achieve.

Features First Parameter
Besides the "Input Ordered" parameter, some transformers have their own, unique, parameters for performance improvements.
Many of these specify one type of feature to arrive "first."
For example, the PointOnAreaOverlayer transformer expects two sets of data: Points and Areas. By default, FME requires all
incoming Points and Areas because it needs to be sure it has ALL of the Areas before it can process any Points.
But, if FME knows the Area features will arrive first (i.e. the first Point feature signifies the end of the Areas) then it doesn’t need
all Point features. It can process each one immediately because it knows there are no more Areas that it could match against.
The user specifies that this is true using the parameter Areas First:

But how does a user ensure the Area features arrive first? Well, like writers you can change the order of readers in the Navigator
so that the reader at the top of the list is read first.
Changing the reader order doesn’t improve performance per se, but it does let you apply performance-improving parameters like
the above.

Attributes and Transformation
As mentioned (in Reader Performance) reducing data helps performance because it saves FME from either holding it in memory
or caching it to a disk.
However, this isn’t just helped by reducing the number of features; it is also helped by reducing the size of each individual feature.
One aspect of this is attributes. Carrying attributes through a translation impacts performance, so if the attributes are not required
in the output, it’s best to remove them as early as possible in the translation.
For example, the incoming schema looks like this:
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But the outgoing schema looks like this:

Since so many of the source attributes are not required in the output, it makes sense to remove them from the translation, and as
early as possible. There are two ways to do this. Some reader formats (but not all) have a setting in the reader feature type to avoid
reading excess attributes:

With that, you can ensure that only attributes exposed are read. The other way to remove attributes is by using a transformer
(AttributeManager, AttributeRemover, or AttributeKeeper) directly after the source feature type:
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This ensures that none of the extra attributes become a drain on resources by being processed by any further transformers.

Lists
One specific type of attribute to beware of is a List. A list in FME is an attribute that can have multiple values. Because of this, it
can be a big drain on resources.
For example, use a Joiner to join a feature to 1,000 records and the list for that feature will have 1,000 sets of records. This is bad
enough, but if the list is exploded and all of the original attributes kept, then there will be 1,000 features each with 1,000 sets of
attributes!
In general, beware of creating lists unnecessarily and of keeping them in a workspace beyond the point at which they are still of
use.

Geometry and Transformation
Like attributes, geometry can be removed from a feature, in this case using the GeometryRemover transformer.
Many FME users create translations that handle tabular – non-spatial – data. If you are reading a spatial dataset, then writing it to
a tabular format, be sure to remove the geometry early in the workspace, just as you would an attribute.
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Another particular problem is carrying around spatial data as attributes. Spatial database formats - for example, Oracle or
GeoMedia - usually store geometry within a field in the database; for example GEOM. When FME reads the data it converts the
GEOM field into FME geometry and drops the field from the data.
However, if you read a geometry table with a non-geometry reader, the translation could end up with the geometry stored as an
FME attribute. A similar thing could happen when a workspace reads only one geometry column of a multiple geometry tables.
Geometry will create very large and complex attributes, which take up a lot of resources. If you don’t need them, then it’s worth
removing them.
Basically, you should only carry through the translation any geometry and attributes you need for the output of your workspace. If
the data is not required, then it can and should be removed as early in the workspace as possible.

Miss Vector says…
Which of these transformers have group-related parameters for improving performance (pick all that
apply and see if you can get the answers without looking at the transformers):
1. StatisticsCalculator
2. SpikeRemover
3. PointCloudCombiner
4. FeatureMerger
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Exercise 3

Public Art in Parks - Workspace Optimization

Data

City Neighborhoods (Google KML)
Public Art (Microsoft Excel)
Parks (MapInfo Tab)
City Orthophoto (GeoTIFF)

Overall Goal

Plan out a workspace and determine which parks do not contain public art

Demonstrates

Optimizing workspaces and raster processing

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex3-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex3-Complete.fmw

Our workspace is almost complete; we just need to remove the black borders that were created when the raster was clipped and
then write out the data to GeoTIFF. We should also look at making this workspace more efficient.

1) Open Workspace
Start FME Workbench and open WorkspaceDesign-Ex3-Begin.fmw or continue working on the same workspace from the last
exercise.

2) Remove Extra Feature Types
When we added the Neighborhood KML back in the first exercise, we added all of the feature types associated with it, but we only
ended up using the Neighborhood feature type. All these excess feature types can slow down a workspace. If there is data added to
the canvas that isn't used in the translation, it should be removed.
You can manually select all of the excess feature types and remove them, or you can bulk remove them. To bulk remove them
select Tools > Remove... > Unattached... on the menubar. Select all and click OK:
NB: Uncheck any nodes that are not the KML Feature Types
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TIP
You should also remove excess Loggers and Inspectors once you are done developing your workspace.

3) Remove No Data
Now that we have removed all the unused data we can continue with our workspace.
To remove the no data black borders we will need to use two raster specific transformers, the RasterSelector and the
RasterBandNoDataSetter. First, add the RasterSelector transformer and connect it to the Clipper:Inside output port. This
transformer allows you to select specific bands and palettes to manipulate with other transformers. We will select all of the bands
and palettes, so just accept the default parameters:

Next, add the RasterBandNoDataSetter transformer and connect it to the RasterSelector:Output port. In the parameters set the
NoData Value to 0. The RasterBandNoDataSetter will remove no data values on the selected bands and palettes:

4) Run the Translation
Rerun the translation and inspect the output from the RasterBandNoDataSetter:
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The data looks good, all of the black borders are removed, and it is split up by neighborhood, time to write it out.

5) Write to GeoTIFF Add a writer to the workspace using the following settings:

Writer Format

GeoTIFF (Geo-referenced Tagged Image File Format)

Writer Dataset

C:\FMEData2018\Output\Training

Raster File Definition

Automatic

Simply click OK to accept the default feature type definition.
Connect the new feature type to the RasterBandNoDataSetter:Output port. Open the writer parameters and set the Raster File
Name to the attribute NeighborhoodName. This will fanout our rasters so that each neighborhood will be written out as a separate
GeoTIFF:

While we are inspecting the parameters, we should also remove some of the attributes since we don't need to write them all out.
Switch the tab to User Attributes then select Manual for Attribute Definition. Now all the attribute can be edited. Select all rows,
then click the minus button at the bottom and remove all of the attributes:
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6) Write to Excel
Just as we are ready to press the run button for one final time, we were asked to provide an Excel spreadsheet to accompany the
park GeoTIFF files. This is easy to do since the workspace already creates this data, we just need to write it out.
Add an Excel Writer to the canvas:
Writer Format

Microsoft Excel

Writer Dataset

C:\FMEData2018\Output\Training\Neighborhoods.xlsx

Sheet Definition

Automatic

Once you've added it to the canvas, connect it to the Tester:Passed output port. Then go into the parameters and set the Sheet
Name to NeighbourhoodName:

Then switch to the User Attributes tab and set the Attribute Definition to Manual. Remove the _overlaps attribute that was created
by the PointOnAreaOverlayer, but keep the rest:
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7) Run the translation
Finally, run the translation. In the Output\Training folder, there will be a GeoTIFF for each of the neighborhood rasters, as well as
an Excel file with each neighborhood on separate sheets:

CONGRATULATIONS
By completing this exercise, you have learned how to:
Mosaic rasters together
Remove NoData from rasters
Debug a workspace by reading the log file

136

Exercise: Public Art in Parks - Optimization

Interpret the log file to understand what transformers are doing
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Database Optimization
FME can only be as fast as the database it is reading from or writing to. This section will help FME increase its efficiency when
working with databases.

Database Reading
Reading and filtering data (querying) from a database is nearly always faster when you can use the native functionality of the
database. Just as previously mentioned you can use the search envelope and WHERE clauses to narrow down what is being read
from the database into FME.

Database Transformers
Besides readers, transformers can also be used to query database data. The best to use is the SQLExecutor (or SQLCreator) as
these pass their queries to the database using native SQL. If you don’t want to write SQL then you can use the FeatureReader
transformer, but be aware this transformer is more generic and won’t give quite the same performance.
The SQLExecutor is particularly worth being aware of, as it issues a query for each incoming feature. This can be useful where
you need to make multiple queries.
For example, here a query is issued to the database for every library feature that enters the SQLExecutor:

Generally, the output from the SQLExecutor is an entirely new feature. If you want to simply retrieve attributes to attach to the
incoming feature, then the Joiner transformer is more appropriate.

Database Writing
Whereas the performance of reading from a database is largely dependent on the database setup itself, when writing to a database
there are very many FME parameters that can help to fine-tune the overall performance.
Remember that writing to a database incurs network overheads. There has to be a balance between various components:
The amount of data and number of requests being sent (network traffic)
The amount of data stored by FME awaiting transfer to the database (FME performance)
The amount of data stored in the database awaiting committal (database performance)
The risk of losing uncommitted data
Each database writer has a set of parameters for handling these components. Not every format supports these, but the two most
common parameters are Features per Transaction and Features per Bulk Write.

Features per Bulk Write
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The Features per Bulk Write parameter tells FME how many features to send at a time to the database.
Features sent to an FME database writer get cached in memory until the number of features specified by this parameter is reached.
Only then will they be sent to the database. This is also known as chunk size.
This parameter is a way to balance network traffic with FME performance. A higher number means FME caches more features (so
uses more system resources), but makes fewer requests to the database (and therefore causes less network traffic).
A lower number means FME caches less data, but there are more requests made to the database.
Features per Bulk Write also needs to be considered against the value of Features per Transaction.

Features Per Transaction
Features per Transaction (also sometimes called Transaction Interval) controls how many features are entered into a database
before a commit command is issued.
Features sent by an FME writer are cached in memory by the database until the number of features specified by this parameter is
reached. Only then are they committed.
Each commit adds delay to the writing process, so setting this parameter must balance the speed of the translation (a higher
number) against the risk that a translation may fail and features need to be rolled-back (a lower number).
For example, if this parameter is set to a value of 1, then each and every feature is committed individually. If the process fails then
only the last feature will be lost from the database, but the cost is much-reduced performance.
Alternatively, if the parameter is set to a very high value (more than the number of features being written) then only one commit
takes place and performance improves. However, if the translation fails, then all features previously written will be rolled-back
and lost to the database.
If Features per Transaction is less or equal to Features per Bulk Write, then FME basically caches a number of features and sends
them to the database where they are immediately committed.
If Features per Transaction is greater than Features per Bulk Write, then FME is sending features to the database where they will
be cached until the transaction commit total is reached.

Jake Speedie says…
The Transaction and Chunk parameters can differ from format to format. For example, SQL Server has a
single Bulk Option flag rather than a numeric setting. Therefore it’s very important that you check out the
FME Readers and Writers Manual to confirm what parameters are available for your database, and how
exactly they operate.

Writing and Indexing
Whereas indexes can improve performance for reading data, for writing they can cause a great reduction in the speed of
translation.
That’s because the index will often get updated by the database automatically with every feature that is written to the database.
This occurs on a per-feature basis, and regardless of commit intervals.
To remedy this it’s suggested that indexes are dropped (deleted) before carrying out bulk inserts of data into a database table.
A writer feature type also has options to truncate or drop tables when writing to them:
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For the above reason, dropping a table is more efficient than truncating it because the drop action also removes the indexes.
For similar reasons, you may want to turn off networking connectivity when writing data to a Geodatabase geometric network.
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Performance, FME Server, and FME Cloud
FME Server adds an extra dimension to FME performance, that of scalability. In terms of performance, the item most easily
scalable is the number of FME engines.
Increasing the number of engines supports a higher volume of jobs, and the FME Server Core contains a Software Load Balancer
(SLB) to distribute jobs to the FME engines in a balanced way.

Jake Speedie says…
FME Server is probably best-known for its web-based abilities; but it has huge potential in processing
large amounts of data in less time by creating multiple jobs on multiple engines.

Using Server for Bulk Translations
By default, utilizing multiple engines is only possible when you have multiple workspaces to run. When you have only a single
workspace and wish to process it more efficiently on FME Server, then you need to divide that workspace into multiple jobs.
To do so, I can create a parent workspace that divides my source data into separate parts and sends each to a different worker job
using the FMEServerJobSubmitter transformer.
For example, I can calculate the bounds of tiles to be created and share the load over multiple server engines by running the
workspace once for each tile.

FME Cloud
FME Cloud is an installation of FME Server hosted by Safe Software on Amazon Web Services technology and used on a pay-asyou-go basis. The benefit is that you don’t have to purchase FME Server, merely make use of it whenever you have a job that can
take advantage of its power.
The key to automating this for performance benefits are the FME Cloud custom transformers available on the FME Store:
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With the FMECloudInstanceLauncher transformer (or the FMECloudInstanceController), I can run my parent workspace, have it
automatically start an FME Cloud instance and run one or more worker jobs on it.
This way I can start a new instance for each job, or run several jobs on one instance, depending on the type of instance and how
many engines it has running on it.
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Exercise 4

Garbage Collection Day Project

Data

Addresses (PostGIS or Esri Geodatabase)
Garbage Zones (Esri Geodatabase)

Overall Goal

Analyze and improve the workspace performance

Demonstrates

Database Optimization

Start
Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-PostGIS-Begin.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-Geodatabase-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-PostGIS-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-GeodatabaseComplete.fmw

Members of the public often call the city to ask what day their garbage collection is. To help the city has an internal system hosted
on FME Server. Members of the planning department can lookup an address ID, enter it into a published parameter, and the
system retrieves the garbage pickup information.
The system works but is perhaps slower than it should be. Let’s run this short exercise to discover why.

Miss Vector says...
This exercise uses either a PostGIS database hosted on Amazon RDS or an ESRI Geodatabase. You can
use either one (no extra license is required). Be sure to open the correct workspace and follow the correct
instructions for your chosen format.

1) Create Database Connection (PostGIS Only)
To use a PostGIS database as source requires a connection to it.
In a web browser visit http://fme.ly/database - this shows the parameters for a PostGIS database running on Amazon RDS.
Start Workbench and select Tools > FME Options from the menubar
Click on the icon for the Database Connections category, then click the [+] button to create a new connection. In the "Add
Database Connection" dialog enter the connection parameters obtained through the web browser.
Give the connection a name (if you call it FME Training Database Connection it will match the starting workspace) and click
Save.
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NB: Yes, the password is fmedata as well!
Then click OK to close the FME Options dialog.

2) Open and Run Workspace
Open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex4-PostGIS-Begin.fmw or
WorkspaceDesign-Ex4-Geodatabase-Begin.fmw.
The workspace looks something like this:

Basically, a published parameter accepts an address ID. The postal address database is read and filtered against this ID. The
chosen address is used in a spatial overlay against garbage zones. The result is formatted in HTML and written out with a Text
File writer.
To get a comparison, run the workspace. Use Prompt Mode to be prompted for an address ID. A suitable address ID to use is
127209 (PostGIS) or 6135 (Geodatabase).
The result, in a web browser, is this:
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The performance will read like this:
PostGIS
INFORM|FME Session Duration: 10.8 seconds. (CPU: 3.9s user, 0.5s system)
INFORM|END - ProcessID: 7144, peak process memory usage: 123656 kB, current process
memory usage: 123520 kB

Geodatabase
INFORM|FME Session Duration: 2.8 seconds. (CPU: 2.5s user, 0.3s system)
INFORM|END - ProcessID: 8228, peak process memory usage: 133556 kB, current process
memory usage: 117920 kB

The Geodatabase is quicker because it is being read from your own file system, not a remote database.

3) Set Up WHERE Clause
Neither PostGIS or Geodatabase have a WHERE clause for the reader itself, but their feature types do. So inspect the properties
for the PostalAddress reader feature type and in the WHERE Clause parameter enter:
PostGIS
"AddressId" = $(AddressID)

Geodatabase
OBJECTID = $(AddressID)
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For PostGIS, be sure to notice the lower-case "d" in the "Id" part of the field name! Also, note the difference in use of quotes
between the two formats.

4) Delete Tester
Now we have the WHERE clause the Tester transformer is no longer required, so delete it.

TIP
If you collapse the bookmark then delete the bookmark it deletes both the bookmark and the transformer
in one step:

5) Re-Run Workspace
Re-run the workspace. This time only 1 feature is read from the database. The performance improves accordingly:
PostGIS
INFORM|FME Session Duration: 7.7 seconds. (CPU: 2.3s user, 0.3s system)
INFORM|END - ProcessID: 1756, peak process memory usage: 122344 kB, current process
memory usage: 122344 kB

Geodatabase
INFORM|FME Session Duration: 1.1 seconds. (CPU: 0.8s user, 0.3s system)
INFORM|END - ProcessID: 7260, peak process memory usage: 124604 kB, current process
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memory usage: 117016 kB

Memory usage hasn’t improved, but the translation ran faster.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a database connection
Use a SQL WHERE clause to avoid reading all data
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Parallel Processing
Parallel Processing is a way to improve performance on high-end machines.

What is Parallel Processing?
Each FME translation is usually a single process (fme.exe) on your computer. Parallel processing is when you transform your data
into several simultaneous processes. The fact that they run simultaneously means the whole translation can run several times
quicker than it used to.
Parallel processing allows FME to make use of multiple cores on a computer. There are four levels of parallel processing in FME,
and each maps to the number of cores in this way:
Parameter

Processes

Quad-Core Machine

No parallelism

1 Process

1 Process

Minimal

Cores / 2

2 Processes

Moderate

Cores

4 Processes

Aggressive

Cores x 1.5

6 Processes

Extreme

Cores x 2

8 Processes

So, as in the above example, on a quad-core machine, minimal parallelism results in two simultaneous FME processes. Extreme
parallelism would result in eight (assuming there are eight tasks that can be processed simultaneously).
There is also a hard cap for each license level:
FME Edition

Process Cap

Quad-Core Machine

Base Edition

4 processes

Maximum 4 processes

Professional Edition

8 processes

Maximum 8 processes

All Other Editions

16 processes

Maximum 8 processes

So, if you have a Base Edition license, you are never going to get more than four processes at one time, regardless of machine
type and the parallelism parameter. The quad-core machine in the above example can never have more than eight processes since
that is the maximum 'extreme' parallel processing allows.

Jake Speedie says…
Parallel Processing is very effective when you are offloading a task elsewhere – for example calling a
Server with the HTTPFetcher – as each process is a tiny impact on the FME system resources. However,
be aware, each parallel process involves starting and stopping an FME engine, and this takes time. So,
don’t parallelize your processes when the task already takes less than the time to stop/start FME!

Transformers and Parallel Processing
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A number of FME transformers have built-in options for parallel processing. Parallel processes work on groups of features, so the
transformer must be group-based and have a group-by parameter for the user to define the parallel processing groups.
For example, this Bufferer transformer is set up to buffer a set of street features:

Each street (i.e., each feature with the same street name) is processed as a separate group. To speed up the translation, each group
is handled as a separate process (sadly the user cannot confirm that the source data is already ordered by group, which could
improve performance even more).
When a translation is run in parallel mode, then a number of “worker” processes appear in your process manager:

Parallel Processing Groups
Best performance gains occur with a small number of groups and a large amount of data. With many groups and only a few
features, then performance gains will not be large and, in fact, the whole process might even be slower.
Because each group is processed independently, there can be no relationship between features in different groups. If features are
related, and their results depend on each other, then they must be in the same group.
However, if all data is unrelated and the contents of the group are unimportant, then it’s possible to make artificial groups using a
ModuloCounter or RandomNumberGenerator transformer.
For example, here the user has a large number of line features to buffer (separately) and uses a ModuloCounter to assign them to
one of four groups for parallel processing. Note the Group By parameter in the Bufferer is set to the _modulo_count attribute:
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Jake Speedie says…
See this blog article for more information about - and some special techniques for - generating parallel
processing groups.
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Batch Processing
Batch processing is the operation of a series of workspaces in FME or the processing of multiple files at one time.

Batch Processing Using the WorkspaceRunner
The WorkspaceRunner is a transformer that runs another FME workspace when used in a translation. Used in conjunction with the
Directory and File Pathname reader it can be used for batch processing.
For example, we have a workspace that reads in orthophoto tiles and clips them to neighborhood boundaries, writing them using a
combination of tile and neighborhood as the output filename:

Imagine we get new orthophotos each week. Instead of changing the data in the previous workspace each time, we create a
workspace to batch process all the new files. This allows FME to start multiple processes simultaneously so that the data is
processed faster:

To set up the WorkspaceRunner in a workspace (the Parent), the FME Workspace parameter is pointed to the workspace to be
batch processed (the Worker or Helper). The Source File parameter is set to path_windows, an attribute created by the Directory
and File Pathnames Reader:
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The option to Wait for Jobs to Complete ensures one job is completed before starting another. Setting this option prevents multiple
Concurrent FME Processes.
If the job order is unimportant, the parameter Maximum Number of Concurrent FME Processes can be set. This causes multiple
FME processes (up to a maximum of seven) to be launched, and these can be seen in the Details tab of Windows Task Manager:

Batch Processing Using the Batch Deploy Wizard
Batch deploy is available under the Run menu in FME Workbench. It supports both instant batch processing and the creation of
batch files. This allows you to process a large number of source datasets in the current workspace and produce a separate output
for each:
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Batch deploy operates in the form of a Wizard. The user specifies the input and output datasets plus any other relevant settings
such as a suffix for the output file names.
If the process is not carried out right away, a batch .tcl file is created containing the batch process settings, as well as a .bat file
which is used to start the process at a later date.
Using the same workspace as above in the Create Batch Translation Wizard, setting the Source Type to the GeoTiff Reader:

Then select your Source Data. You can select all of the data you want to be batch processed manually or you can use a * wildcard,
which will find all of the files ending in .tif:

You can select a different file destination as well as change the dataset basename if desired:
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Finally, you can choose to run this batch deploy now or save the scripts so you can run the workspace outside of Workbench:

If you chose to run the workspace now, clicking finish in the wizard will run the workspace immediately. If you saved the scripts,
you can browse to them and run the workspace at any time.

TIP
Batch Processing can also be done using the command line or an FME Command File. These techniques
are more advanced then we want to get into for this course, but if you are interested in learning more you
can check out the Knowledge Base Article FME Batch Processing Methods
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Exercise 5

Performance Review Project

Data

Various

Overall Goal

Analyze and improve the workspace performance

Demonstrates

Parallel Processing

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5a-Begin.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5b-Begin.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5c-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5a-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5b-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5c-Complete.fmw

Included here are a number of workspaces generated by your colleagues. As the resident FME expert, you have been asked to
assess the performance of each workspace.

1) Workspace A
Start Workbench and open workspace C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5a-Begin.fmw

This workspace carries out spatial overlays and nearest neighbor finding. It determines which neighborhood each postal address
and fire hall is located in, and finds the nearest fire hall to each address. The nearest fire hall must be in the same neighborhood.
Examine the workspace and assess it for its ability to employ parallel processing. You should answer the following questions:
Do any transformers permit parallel processing?
Is there an existing group I can use to process in parallel?
Is there an artificial group I can create to process in parallel?
Will parallel processing speed up the workspace performance, or make it worse?
The answers to these questions can be found in the finished workspace:
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5a-Complete.fmw

2) Workspace B
Start Workbench and open workspace C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5b-Begin.fmw
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This workspace reads contour data from Esri Shapefile datasets and converts them into raster DEM tiles - one tile for each
shapefile.
Again, examine the workspace and assess it for its ability to employ parallel processing. You should answer the following
questions:
Do any transformers permit parallel processing?
Is there an existing group I can use to process in parallel?
Is there an artificial group I can create to process in parallel?
Will parallel processing speed up the workspace performance, or make it worse?
The answers to these questions can be found in the finished workspace:
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5b-Complete.fmw

3) Workspace C
Start Workbench and open workspace C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5c-Begin.fmw

This workspace may be familiar to you. It comes from the Desktop Basic course and is a project to find all single-family addresses
within 50 meters of a major road.
Once more, examine the workspace and assess it for its ability to employ parallel processing. You should again answer the
following questions:
Do any transformers permit parallel processing?
Is there an existing group I can use to process in parallel?
Is there an artificial group I can create to process in parallel?
Will parallel processing speed up the workspace performance, or make it worse?
The answers to these questions can be found in the finished workspace:
C:\FMEData2018\Workspaces\DesktopAdvanced\WorkspaceDesign-Ex5c-Complete.fmw

CONGRATULATIONS
157

Exercise: Performance Review Project

By completing this exercise, you have learned how to:
Assess when to use parallel processing
Set up transformers to use parallel processing
Create an artificial group for parallel processing
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Module Review
This chapter looked at FME Performance and some of the techniques available to improve it

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
Feature Caching enables inspection of the data at any point in the translation
Bookmarks are good for planning a workspace and can be used to increase performance when caching features
Partial runs allow you to run sections of workspaces without running the entire thing.
Analyzing a log file helps to determine where performance improvements can be made
Performance is the measure of useful work done in a given time. Excess data and caching of data to disk are two factors that
can impact performance greatly
Improve reading performance by reducing the amount of data being read
Improve writing performance by ordering the FME Writers correctly
Improve transformation performance by removing excess attributes and properly managing group-based transformers
Upload larger tasks to multiple engines on FME Server
Make use of all reader/writer parameters to improve database performance
Employ parallel processing to make FME multi-threaded
Use batch processing to use multiple FME engines with multiple datasets

FME Skills
The ability to design a workspace before starting
The ability to analyze and deconstruct an FME log file
The ability to remove no data from rasters
An understanding of potential methods for improving reader, writer, and transformer performance
The ability to use database parameters to improve performance
The ability to apply parallel processing in an FME workspace

Further Reading
For further reading why not browse articles tagged with Performance on our blog?
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Let's see if you can figure out the one false statement from these facts about 64-bit FME:
1. 32-bit Windows can use only 32-bit FME. 64-bit Windows can use either 32-bit or 64-bit FME
2. You can install both 32-bit and 64-bit FME on a 64-bit computer, and use either one as necessary
3. You can install 32-bit and 64-bit engines on the same FME Server core
4. A workspace authored on 32-bit FME cannot be run on a 64-bit engine
#1 and #2: True. 64-bit Windows can have both 32-bit and 64-bit versions installed, but only the 64-bit
version will take advantage of any extra memory available to it.
#3: True. You can install engines of both types. Job Routing techniques will allow you to designate which
jobs should be processed by which engine.
#4: False. The authoring platform has nothing to do with the platform a workspace can be run on.
There are many helpful articles on 64-bit on the FME knowledge center.

Miss Vector says...
How would you find the Emptying Factory Pipeline setting in the log window?
1. Looking for the color: it is the only message highlighted in red
2. Looking for the message type: it is the first message of type STATS
3. By using the log search tools
4. By opening Tools > FME Options to turn off all other messages

Miss Vector says...
Given this screenshot, which should we make the first writer in this workspace?

160

Q+A Answers

1. A
2. B
3. C
4. Don't know!
Sorry, trick question, but it is impossible to tell from just this screenshot. That's because it's not just the
most features that is important, but the size of those features. There are more features in writer C, but they
are just point features. Writer B is writing features with no geometry, but we don't know how many
attributes there are and of what type. And writer A is writing unknown geometry. If they were park
boundaries consisting of many thousands of vertices, that may be more data in total than the others. In
short, you must use your own judgment and knowledge of the data being processed to make this sort of
decision.

Miss Vector says...
Which of these transformers have group-related parameters for improving performance (pick all that
apply and see if you can get the answers without looking at the transformers):
1. StatisticsCalculator
2. SpikeRemover
3. PointCloudCombiner
4. FeatureMerger
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Advanced Reading and Writing
Even "basic" reading and writing - with the ability to add readers and writers of multiple formats, import feature types, and set a
multitude of parameters - allow an author to construct very powerful data translations in FME.
So, when you master advanced capabilities - like web-based datasets, generic readers and writers, and dynamic translations - you
will be able to handle even the most complex translation and transformation scenarios.
If there is a common theme in advanced reading and writing tools, it is flexibility. This theme includes:
The flexibility to handle data in any location
The flexibility to handle data in any format
The flexibility to handle data with any schema

162

Writing Zip Files

Zip File Handling
Both FME readers and writers are capable of working with compressed (zip) files. Zip files are a convenient way to store datasets
that need handling as a single unit; for example, a set of multiple dataset files contained within a single zip file.

Zip File Reading
The dataset a reader reads is defined by the Source Dataset/Files parameter in the Navigator window:

As in the above screenshot, this dataset parameter can be a pointer to a zip file. You simply select the zip file in the source
parameter and FME will extract the data when it is being read.
It doesn't matter whether the dataset is file-based (like a single AutoCAD file) or folder-based (like the set of files that make up a
Shapefile dataset).
The only difficulty in setting this up is to remember that the file browser does not display zip files by default and that the file
extension being viewed must be changed:
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Zip File Writing
Writing data as a zip file is particularly useful for where the output data needs to be post-processed. For example, if you use a
shutdown script to move or copy output data to a new location, it’s more convenient to handle a single zip file than multiple data
files.
The simplest way to create a zipped output is to change the file extension to .zip in the output dataset field:

You can also specify the filename to be written inside the zip file. In fact, a shortcut button for setting a zip extension does this for
you:

Notice the small icon in the dataset field that indicates the zipped status.
When the workspace is run the log file reports the zip creation:
Finished updating output zip file: `C:\FMEData2018\Output\Parks.zip'

...and the output is, indeed, a zipped dataset:

Sister Intuitive says…
I’m Sister Intuitive from the order of Perpetual Translations. I’ll provide you with spatial guidance
throughout this chapter.

164

Writing Zip Files

Some users may want to zip data in order to move or copy it to a different location as a single entity. A
user parameter can be used in a TCL or Python shutdown script to find the name of the file just written,
and the FeatureWriter transformer also provides the name of the dataset as an attribute.

TIP
In case you were wondering, support for reading other file compression formats is coming in FME 2019
(it's already in the beta version). This includes .gz, .bz2, .zipx, .7z, .tar, .rar, and several others!
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Web-Based Datasets
There can be no doubt that there is a trend towards data being stored in the cloud, including spatial data. For that reason, FME has
comprehensive tools for reading datasets that are web-based.

Simple URL Selection
The easiest way to read a web-based dataset is to simply paste the URL into the source dataset parameter.

Here the workspace author is adding a reader to read a Shapefile directly from an open data FTP site.

Sister Intuitive says…
A folder-based dataset must be compressed to a single zip file for FME to read it from the web like this;
the above is a perfect illustration of that requirement. Datasets can be read from non-zipped datasets, but
only when the dataset consists of a single file (such as an AutoCAD DWG file).

The URL entered into a source dataset field may also be a reference to a shared resource on a web-based file storage system. For
example, here a user is reading a MapInfo TAB dataset directly from a Dropbox link into the FME Data Inspector:
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The key is to force the web service to provide a direct link to the file, rather than to their own web interface. For example, to cause
Dropbox to render data, you should set the dl query parameter to 1 in the URL, as in the above screenshot, instead of the default
value of 0 (zero).
However, there are better ways to read data from a web service...

TIP
If data is read from a website data needing authentication, most readers have parameters to enter such
information:

Web Services
Besides being able to read from a URL, FME can also directly access certain web services to read data. Direct access to a web
service is achieved with functionality inside FME called Web Connections.
Web Connections are created by selecting Tools > FME Options > Web Connections on the FME Workbench menubar and
clicking the plus button in the Web Connections dialog:
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There are a large number of web services to which a connection can be made - and the Manage Services button allows you to
integrate any other web service you require - but the key ones are:
• Amazon S3

• FME Server

• Autodesk A360

• Google Drive

• Box

• HDSF

• Dropbox

• Microsoft OneDrive

These are key types because they are capable of storing data in a way that can be accessed directly from the Add Reader dialogs:

In the above screenshot, an author is adding an Excel dataset from AutoCAD A360. This action opens a dialog in which they can
browse AutoCAD A360 for the required file:
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The reader is then added to the workspace and functions just as any other.
Note that if you wish to use a FeatureReader transformer instead of a reader, then the same "Select File From Web" option is
available.

WARNING
Obviously, there is an authentication step that needs to be carried out when adding a new web service
connection into FME, and if the workspace is published to FME Server or simply copied to another FME
Desktop installation, then the same authentication needs to be carried out in the new location.

Connector Transformers
Besides being able to direct a reader to a web service, various transformers exist that can read files. These relate to the same list
supported by readers, so we have:
• AutodeskA360Connector

• OneDriveConnector

• BoxConnector

• PintrestConnector

• DropboxConnector

• ProjectWiseConnector

• FMEServerResourceConnector

• SalesForceConnector

• GoogleDriveConnector

• SlackConnector

• HDFSConnector
These transformers don't read data in the traditional FME sense. Instead, they read a selected file and either add the contents to an
attribute or download the file to the local filesystem.
Here, for example, an author is using a Creator transformer to trigger the reading of a file from Google Drive:
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The contents of the file have been added to an attribute that can then be processed as required. For example, maybe it is a snippet
of XML that can be decoded with an XML transformer.

TIP
Connector transformers can also upload a file, list the contents of a web service, and delete files from that
service.

Given the "Select File From Web" tool on readers, Connector transformers are not generally intended for reading source data;
although they could be used to download a file that is subsequently read using a FeatureReader.
Another use would be to retrieve a list of files that are then read directly using a FeatureReader.
However, perhaps the more likely use is to transfer written data to the web. Writers don't have an equivalent "Select File From
Web" option, so the best alternative is to write data with a FeatureWriter transformer and then use a Connector transformer to
transfer that data to a web service of choice.
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Exercise 1

Web-Based Connections

Data

Point Cloud Data (LiDAR LAS) and Building Outline Data (AutoCAD DWG)

Overall Goal

Upload data to an online web service

Demonstrates

Creating a web connection and using a connector transformer

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\ReadWrite-Ex1-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\ReadWrite-Ex1-Complete.fmw

You've created a workspace that takes LiDAR point cloud data and creates a 3D PDF. You'd like to share it with your colleagues
but the file is too large to attach to an email. Your workplace has just recently acquired FME Server and you would like to try it
out for data storage and sharing.

1) Open Workspace
In FME Desktop open the ReadWrite-Ex1-Begin.fmw workspace.
This workspace takes a LiDAR point cloud and building outlines to create a 3D model that is written to the Adobe 3D PDF format
using a FeatureWriter transformer.

2) Add FMEServerResourceConnector Transformer
In the bookmark labeled Connect to FME Server, add a FMEServerResourceConnector transformer and connect it to the
FeatureWriter:Summary output port:

In the parameters ensure that the FME Server Action is set to Upload. For the FME Server Account open the drop-down menu and
click Add Web Connection:

In the FME Server Connection Dialog change the Connection Name, if desired. Then set following parameters, then click
Authenticate:
Server URL: http://localhost
Username: author
Password: author

171

Exercise: Web Based Connections

TIP
If you do not have FME Server installed, you can connect to any web connection for this exercise, just add
the appropriate connector transformer and create a connection the same way.
If you are using a Safe Software live training virtual machine and you get an authentication error saying
Retrieval Error : Unable to make the request to FME Server. Ensure your machine
has internet connectivity , we recommend restarting your virtual machine. Click the Start button >

Power > Restart. The machine will take a minute or two to restart, and your issue should be resolved. If
not, please use the GoToWebinar Questions panel to ask for help or email train@safe.com.

For the Source ensure that Upload is set to File. Then for File to Upload, click the drop-down icon then Attribute then select
_dataset:

Finally for the FME Server Destination click on the ellipsis next to Folder ID:
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This will connect to your FME Server Resources folder. Double click on the Data folder to open it. Then click OK:

Your parameters should look like this when it's all set up:
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3) Run Translation
Now when we run our translation the data will write to our local disk but also upload the output file onto FME Server where any
of our colleagues can download it.
Run the translation.

4) Test Upload
We need to check to see if our data was uploaded successfully without opening FME Server (that's a different course).
To do this we can use our FMEServerResourceConnector transformer. Open up the parameters and change the FME Server Action
to Download. Then click the ellipsis next to FME Server Source Object ID:

This opens the file browser for FME Server. Double click on the Data folder to open it and our 3DBuildings.pdf is there:
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Cancel out of all dialogs to return the FMEServerResourceConnector to the Upload state.

CONGRATULATIONS
By completing this exercise you have learned how to:
Set up a web connection
Upload data to FME Server or another online service
Download data from FME Server or another online service
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Fanouts
Fanouts are one of the most powerful pieces of functionality within FME, capable of producing impressive results with minimal
effort.

What is a Fanout?
A fanout is a tool applied to a writer in FME. They are a way for the workspace author to write data divided into groups of
features in the output dataset.
The groups are defined by either the value of a single attribute or a string constructed from a combination of attributes and fixed
strings.
For example, here an author is “fanning-out” a set of data into multiple outputs depending on a feature’s elevation attribute:

Because a fanout occurs as the data is written, it does not require multiple flows of data inside the workspace. Therefore this
technique makes it easy to create groups with minimal impact on the workspace canvas.
Another significant benefit of a fanout is the high degree of flexibility – and freedom from fixed-layer schemas – in return for
minimal effort.
There are two types of fanout: Feature Type Fanout and Dataset Fanout.
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Feature Type Fanout
A Feature Type Fanout delivers data to multiple feature types (layers/tables) within a single dataset. Taking the elevation example,
here the output is a different feature type for each elevation value:

The result of this fanout is a DXF dataset containing multiple layers of data.

Setting a Feature Type Fanout
A feature type fanout is defined in the Feature Type parameters by selecting an attribute for the feature type name, like so:

The Feature Type Name then changes to match what is selected:
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In this case, each park record with a different neighborhood gets written to a different sheet of the Excel output spreadsheet.
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Dataset Fanout
A Dataset Fanout delivers data to the same feature type, but in multiple datasets. Using the elevation example again, here the
output is a different dataset for each elevation value:

The result of this fanout is a series of DXF datasets, each of which has one elevation’s worth of contours on one layer.

Setting a Dataset Fanout
A Dataset Fanout is defined in the Navigator window in Workbench, just below the writer’s dataset parameter:

Double-clicking the Fanout Dataset parameter opens a dialog in which to define the folder to write to and the Fanout Expression
to use. It defaults to the original file name:
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To achieve a fanout (a different file per attribute value) edit the Fanout Expression to include an attribute name, such as this:

In this case, each different neighborhood produces a separate file of park features.

Miss Vector says…
Fanouts are an important part of writing data with FME, so tell me, which of these statements are true?
1. You can have both a Feature Type Fanout and a Dataset Fanout in the same workspace
2. You can use a Feature Type Fanout with a database format, but not a Dataset Fanout
3. A fanout expression can be an attribute, or a constructed string, but not a user parameter
4. A fanout cannot be based on a format attribute such as fme_color
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The Generic Reader/Writer
The Generic Reader and Generic Writer allow FME workspaces to be freed from format restrictions.
Where all other readers and writers are tied to a specific format of data, the Generic Reader and Generic Writer are not. The
Generic Reader is capable of reading almost any format of data, and the Generic Writer is capable of writing almost any format of
data.
In that way, a single workspace can be used to process different data formats without being specifically set up for that format.

The Generic Reader
A Generic Reader is used in the same way as any other reader; by specifying the format in the Add Reader (or Generate
Workspace) dialog:

There the source dataset is an AutoCAD DWG dataset, but FME does not know that yet. When the workspace is run FME
examines the extension of the file chosen to determine this for itself.
At a later time the end-user might then choose a different file - in a completely different format - to be read, like so:

Again, at runtime FME examines the file extension to identify the format of data and then - having discovered it is MicroStation
DGN - reads it just as if it were a true DGN reader.
That way a single reader can be made to read any format of data.

Sister Intuitive says…
You're thinking there must be a catch, right? Well, it's true. Firstly this technique only works with filebased formats (it won't work on a database or web format). Secondly, the Generic Reader is not immune
from the Unexpected Input Remover, so switching datasets - regardless of format - only works with a
compatible schema (see below).

Generic Reader Feature Types
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The Unexpected Input Remover is the function in FME that filters incoming data against the list of permitted feature types. If the
incoming data is not defined in the workspace, then it is dropped from the translation.
In the previous example, traffic signals in the AutoCAD dataset were stored on a layer called "TrafficSignals", and the workspace
names the reader feature type so. But, if the MicroStation file stored data on a different layer, then this would be the result:

All 778 records were dropped from the translation. So, although the Generic Reader allows you to read datasets of different
formats, the limitation is that each dataset must have its layers defined as feature types in the workspace.
Of course, an easy way to allow all layers to pass is to set a Merge Feature Type in the Feature Type Properties:

With that setup, any layer of data can be passed into the workspace, regardless of format. Of course, even then you need to be
careful about assuming what attributes will be available!

The Generic Writer
A Generic Writer is used in the same way as any other writer; by specifying the format in the Add Reader (or Generate
Workspace) dialog:

There the destination dataset is specified as a folder. FME does not know the format to be written yet and so will not know
whether it is file-based or folder-based. The format required to be written can be specified by the author through a parameter when
the writer is added:
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...by the author in the Navigator window, or the end-user can specify it at runtime using an automatically created user parameter:

That way a single writer can be made to write any format of data, the format being chosen by the end-user at runtime.

Sister Intuitive says…
Generic Readers and Writers by nature only deal with a flexible format, but can also be set up to be
flexible with layers using a Merge Filter or Fanout.
However, each dataset being read must have the same attribute schema. Additionally, each dataset written
receives an identical attribute schema. This part is not flexible.
Flexible attribute schemas require the use of either Automatic Attribute Definitions or a Dynamic
Translation.
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Exercise 2

Community Mapping Data Translation Project

Data

Community Mapping (Esri File Geodatabase)

Overall Goal

Create a workspace to translate Community Mapping data to a format of the end-user's choice and
zip it

Demonstrates

Generic Writer, fanout and writing zip files

Start
Workspace

None

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\ReadWrite-Ex2-Complete.fmw

As resident FME expert you are often asked to translate data (particularly the community map) between formats. You realize that
it would be way simpler if you created a workspace to do this - regardless of format - and let the end-users carry out the
translation themselves. In the future, this would make an excellent use for an FME Server Data Download service, but for now,
we'll let the users simply run the workspace in FME Workbench.

1) Start Workbench
Start FME Workbench and begin with an empty canvas. Select Readers > Add Reader from the menubar and add the following:
Reader Format

Esri Geodatabase (File Geodb Open API)

Reader Dataset

C:\FMEData2018\Data\CommunityMapping\CommunityMap.gdb

Workflow Options

Single Merged Feature Type

By selecting the single merged feature type option we will have a workspace that is nice and compact, plus it will allow the user to
select which tables they want to read from the source.
Click OK to close the dialog and add the reader.

2) Add Writer
Select Writers > Add Writer from the menubar and add a Generic Writer:
Writer Format

Generic (Any Format)

Writer Dataset

None

Writer Parameters

Output Format: Esri Shapefile

Add Feature Types

Feature Type Definition: Automatic

You don’t have to select an output location, but will you have to open the parameters dialog and set an original output format; so
do that and select a format like Esri Shapefile.
In the "Add Feature Types" section of the dialog, select Automatic for feature type definitions:
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Click OK, and the Feature Type Properties dialog for the new writer will open automatically. Set the Geometry field to fme_any.
This will allow any data to be written to this feature type:

Click OK to close the dialog and to add the new feature type. Connect it to the source feature type. When you make the
connection the attribute schema will automatically be updated to match the connected reader feature type:
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3) Check User Parameters
Look in the Navigator window at the user parameters that were created automatically with the reader and writer:

The parameter for SourceDataset_FILEGDB is something we won’t ever need (this translation will always use the same dataset)
so delete it.
Another automatically created parameter is called Feature Types to Read. This is very useful because when the user runs the
workspace, they will be prompted to select which tables to read from the source Geodatabase; so keep this parameter.
Similarly, keep the Destination Dataset parameter.
The Output Format parameter is interesting. Double-click on it as if you were going to set a value. Notice that the "More
Formats..." option in the drop-down list opens up the full FME formats list:
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It wouldn’t be fair to the end-user to expose so many formats when they don’t really need to see or select most of them. It would
be better to restrict this list. So, delete this user parameter, and we’ll create a new - more restrictive - one.

4) Add User Parameter
Add a new User Parameter by right-clicking on User Parameters and selecting Create User Parameter.
In the dialog that opens set the following:
Type

Choice with Alias

Name

OutputFormat

Published

Yes (checked)

Optional

No (unchecked)

Prompt

Select Output Format:

For the configuration field, click the browse button to open a new dialog. In that dialog, select Import > Writer Formats. Select a
handful of the most common formats like Esri Shapefile, AutoCAD DWG, GML, and MapInfo TAB; then click OK.
Then click OK twice more until all the dialogs are closed.

5) Link Parameter
Now, in the Navigator window, expand the parameters for the Generic Writer. Locate the Output Format parameter. Right-click it
and choose Link to User Parameter.
Select the newly created OutputFormat parameter and click OK:

Now when the workspace is run, the choice of output format will be among these few:
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6) Fanout on Format Attribute
The other, final, task we can do here is to output the features to their original table. To do this we need to know where they came
from, and that is obtained from a format attribute called fme_feature_type.
Inspect the properties for the writer feature type. Set a fanout by choosing fme_feature_type as the attribute supplying the feature
type name.

7) Save and Run Workspace
Save the workspace and then run it with the prompt option set. When prompted, select some source tables to read (include at least
the GarbageSchedule plus one other).
Then for Destination Generic (Any Format) Folder, we will create a zipped folder to contain all of our files. Set the location of an
output folder then at the end type:
\CommunityMapping.zip

This will create a zipped file called CommunityMapping.
Finally, set Esri Shapefile as the format to write. Click OK to run the translation
Examine the output folder. A zipped folder has been created which contains all the selected tables that have been written back to
Shapefile format:
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Now you have a solution that almost anyone will be able to open and run for themselves. Also, if you published the workspace to
FME Server it would automatically create a web page that matched the different user parameters.

Sister Intuitive says…
Did you notice that FME handled the different geometry types and output the files with the geometry as
part of the name? It’s a Shape format thing. FME can never – and will never – write more than one
geometry type to the same Shapefile .shp file.
The one drawback is that each output Shapefile has all of the attributes of all of the source tables. To
avoid that you would need to use a dynamic translation, as we shall see shortly.

CONGRATULATIONS
By completing this exercise you have learned how to:
Add a Generic Writer to a workspace
Set the initial format of a Generic Writer
Create a Choice with Alias parameter that prompts for a writer format
Use a Choice with Alias parameter for the Generic Writer output format
Use a feature type fanout on fme_feature_type to return features to their original layer
Use a .zip extension to create zipped output datasets
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Dynamic Translations
Dynamic Translations are a way to create "schema-less" workspaces.

What are Dynamic Translations?
Most translations - and everything this training has covered so far - involve a schema defined within the workspace. In other
words, the source and destination schema reflect the structure of the source data (what we have) and the structure of the
destination data the user requires (what we want).
The layout of a dynamic translation does not reflect either the source or destination schema. It’s a universal layout that is designed
to handle data regardless of the schema used.

Sister Intuitive says…
For this section, it’s useful to think of a schema as comprised of a trinity of objects: feature types,
attributes, and geometry type.

Dynamic Readers
On the reader side of things, a dynamic workspace is very similar to using Merge Parameters; feature types are given free entry to
a workspace, regardless of whether they are yet defined in there.
Data is also read regardless of attributes or geometry type.

Dynamic Writers
The writer side of a dynamic workspace mimics the reader part; feature types are written to the destination dataset, regardless of
whether they are defined in the workspace.
Additionally, all attributes and geometries get written, regardless of whether they too have been predefined in a writer feature
type.
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Miss Vector says…
It's important to get the concepts correct here, and I have some more statements only some of which are
true:
1. A Dynamic workspace will read/write any format of data
2. A Dynamic workspace will read/write any feature types in the source data
3. A Dynamic workspace will read/write any attributes in the source data
4. A Dynamic workspace will read/write any geometry in the source data
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Creating a Dynamic Translation
When an author creates a translation using the Generate Workspace dialog, there are two options for what is called workflow:
static schema and dynamic schema.

The Static Schema option is the default for a workspace including schema. Choosing the Dynamic Schema option creates a
schema-less workspace with dynamic readers and writers.
It is, however, possible to also create a workspace where only the readers are dynamic or only the writers...

Dynamic Reader Only
The Add Reader dialog has similar options for static and dynamic; however, in this case, we try to make them more user-friendly
by labeling them Individual Feature Types and Single Merged Feature Type:

In essence, a dynamic reader is similar to just setting the Merge Feature Type option.

Dynamic Writer Only
The Add Writer dialog has options for how feature types and their attributes are defined. The most commonly used ones are
Manual and Automatic. There is also an option that adds a writer in dynamic mode:
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Sister Intuitive says…
Let's clarify Automatic vs. Dynamic. Automatic attributes take their definition from whatever is connected
to them. If the Source Dataset parameter is changed, that change has no effect.
Dynamic attributes are different. If the Source Dataset parameter is changed, the attribute definition
comes from whatever source data gets read, regardless of what is connected to it.

How Does a Dynamic Translation Look?
Both dynamic readers and dynamic writers each have a single Feature Type, regardless of the schema of the reader datasets:

Notice that there is only a single feature type, regardless of whether the data is made up of several layers or tables.
Also, notice that the sole reader Feature Type is named <All> (which provides a clue to what is happening here) and that the sole
writer Feature Type is named <Dynamic>.
When the workspace is run, all of the source data is read through a single feature type. On the writer side, although there is only
one output type, the data will be dynamically divided back into its component layers, keeping its original attributes and geometry
type.
With this workspace, you can switch the source dataset to anything (in the correct format) and the output is a mirror image. There
is no need to worry about unexpected input or unsupported geometry types. Plus, if you used the Generic Reader/Writer, it could
read any dataset, of any format and create a duplicate output of it!
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Exercise 3

Dynamic Community Mapping Data Translations

Data

Community Mapping (Esri File Geodatabase)
Addresses (Esri File Geodatabase)

Overall Goal

Create a dynamic workspace to translate any Geodatabase dataset to a format of the end-user's
choice

Demonstrates

Dynamic Formats

Start
Workspace

None

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\ReadWrite-Ex3-Complete.fmw

In the previous exercise, a workspace was generated to translate a Geodatabase dataset into a number of formats using the Generic
Writer.
However, that workspace had a limitation with the output attributes (every output dataset got all of the source table attributes), and
you also feel it would be useful if that workspace could handle any source Geodatabase, not just the community maps dataset.
So, let’s create a new workspace to handle that scenario.

1) Start Workbench
Start FME Workbench and begin by generating a workspace as follows:
Reader Format

Esri Geodatabase (File Geodb Open API)

Reader Dataset

C:\FMEData2018\Data\CommunityMapping\CommunityMap.gdb

Writer Format

Generic (Any Format)

Writer Dataset

C:\FMEData2018\Output\Training

Writer Parameters

Output Format: Esri Shapefile

Workflow Options

Dynamic Schema

2) Inspect Workspace
Inspect the newly created workspace:

There is one reader feature type and one writer feature type. The reader feature type shows a list of attributes, but the writer
feature type doesn’t. It is, however, labeled <Dynamic>.
Again, there will be a user parameter for the Feature Types to Read and the output format.
If you wish, create a more-limited version of the output format parameter, by following steps 3-5 in the previous exercise;
although this isn’t totally necessary for what we’re doing here.
But don’t delete the Source Dataset user parameter; we’ll need that shortly.

3) Run Workspace
Run the workspace with the prompt option set.
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When prompted, select some source tables and set the output format. The workspace will run to completion. Check the output to
ensure it is all correct.

4) Re-Run Workspace
Now rerun the workspace.
This time click the browse button for the source Geodatabase and browse to C:\FMEData2018\Data\Addresses\Addresses.gdb
Choose the feature types to read, and this time you will be presented with a list of feature types from the newly selected
Geodatabase. Select one or both of them.
Click OK to rerun the workspace. Inspect the output. Notice that the output feature types are all as listed in the original data. Also,
notice that the attributes are as in the original too!
From this, we can see that a dynamic workspace is capable of handling any source schema and writing it out to a new dataset just
as it was in the source data.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a dynamic workspace
Use the Generic Reader in a dynamic workspace
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Dynamic Schema Handling
Checking the feature type properties for a dynamic translation reveals the checkboxes that turn on this behavior.
For a reader, all that is really happening is the merge feature-type setting is turned on:

Unchecking that box turns off the full behavior, and there are not many parameters to adjust. However, for a writer, the dialog is a
bit more complex:

The three components of schema - 1) feature type, 2) attributes, and 3) geometry - all have different ways in which they can be
set.
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Schema Sources
By default, the writer schema in a dynamic translation is defined not in the workspace, but by the source dataset. So whatever
dataset is chosen as input defines the chosen output structure.
However, the parameters in a writer feature type let us alter how that schema is defined. We can choose to take the structure from
an entirely different dataset to the source. Alternatively, we can individually define each component of our schema (Feature Types,
Attributes, Geometry) in a variety of ways.
The writer feature type has a dynamic parameter labeled Schema Sources:

This parameter defines from where the destination schema is going to be obtained. By default, this parameter is set to whatever
source dataset is being read. That way the output schema is always a duplicate of the input.
However, it can be set to use any reader dataset – in any format – as the source for the outgoing schema.

For example, here the workspace author is converting parks data to an Esri Geodatabase, but has chosen an Excel spreadsheet as
the required structure for the output dataset.
If the data is fanned out (say by NeighborhoodName) then the Excel spreadsheet should have a different sheet for each
neighborhood, and that structure is used as the schema of the output in this workspace.

Sister Intuitive says…
Let me make it clear if it isn't already. In this scenario the user is not writing to those database tables; the
user is writing to a File Geodatabase. However, the output Geodatabase receives the same schema
(structure) as the matching Excel sheets.
It's called “Dynamic” because the destination schema gets fetched at runtime. For example, if the Excel
sheets were to change in structure and the workspace ran a second time, it will produce Geodatabase
feature types to match the changes. The best part is that the workspace does not need updating to do so.
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Resource Readers
The Schema Source parameter can be set to point to any reader as the source of a dynamic schema. However, in most cases, all we
need from the dataset is the schema, not the data.
This is where Resource Readers can be used.
A Resource Reader is a reader that returns the schema of a dataset, but no data. One is added using Readers > Add Reader as
Resource on the menubar:

Here the user adds a PostGIS database as a resource, and it appears in the Navigator window:

Once available the resource reader can be used as the source of a schema for a dynamic writer.

Why Use an External Schema?
The main reason for using an external dataset schema is to adhere to a fixed standard. Perhaps the most useful aspect of this is that
if the schema of the dataset changes, then the workspace makes use of it automatically. There's no need to update the workspace
manually because the output requirements have changed.
However, as noted above, the data being written must match that standard or risk being dropped. So there is always likely to be
some data transformation required in the workspace to coax the input data into the required output schema.
The SchemaMapper transformer is useful for reconciling data with the required schema - that's because the SchemaMapper too
can use an external lookup table, meaning that the dynamic workspace can be changed to meet any required output schema
without having to make edits in Workbench!
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WARNING
Geometry is discussed shortly. However, for now be aware that permitted geometry types are (by default)
obtained from the schema source. If the schema source changes, you may not want its geometry type.
Therefore simply set Geometry to "First Feature Defines Geometry Type" to avoid issues.
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Dynamic Feature Types
There are three main components of a schema:
Feature Type
Attributes
Geometry
This section looks at Feature Types, and how a workspace author can change the feature types that are written in a dynamic
translation.

Defining Feature Type Names
In static writer feature types, the feature type name is usually a fixed value. However, it can also be defined by an attribute (or
string constructed from attributes). We call that a Fanout.
In a dynamic translation, a fanout is set automatically. By default an FME attribute called fme_feature_type is used as the feature
type name:

fme_feature_type is an FME attribute that stores the name of the original feature type on incoming features. It makes sense to
default to this attribute because then all data is written to the same feature type as it came from, and we get an output that is a
duplicate of the input.
However, should you wish, there's no reason why a different attribute couldn't be used, in order to define a different set of output
feature types:

Here, for example, the author is using NeighborhoodName to supply the name of the layers to create. For example, features might
have the value Downtown, West End, or Fairview.
At runtime, FME looks in each of the Schema Sources to find a table called Downtown. It will use the schema of that table to
define the attributes and geometry allowed in the dynamic writer's output.

Schema Requirements
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Of course, be aware that this isn't exactly the same thing as a fanout. A fanout creates layers from a static definition. A dynamic
workspace fetches that definition from somewhere else (the schema source).
Therefore, the feature type names chosen must match a layer that exists in that source schema.
Failure to do so will lead to the data being dropped - instead of written - with a log message reporting the problem. For example, if
the NeighborhoodName attribute had values (like "Downtown" or "Kitsilano") that didn't exist as a table in the schema source,
there would be log messages like this:

===========================================================================
FileGDB Writer: A feature with feature type `Downtown' could not be written
+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++
===========================================================================
FileGDB Writer: A feature with feature type `Kitsilano' could not be written
+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++

What the author must ensure is that the schema used actually contains these layers. Then the translation will proceed as expected.
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Dynamic Attributes
As we know, there are three main components of a schema:
Feature Type
Attributes
Geometry
This section looks at Attributes, and how a workspace author can change the attributes that are written in a dynamic translation.

Defining Attribute Names
This is probably the most complex part of dynamic translations, so let's take the explanation step by step, going back over some
old ground where necessary.
As we've seen, in a dynamic translation each incoming feature has an attribute (either fme_feature_type or another attribute) that
specifies to which feature type the data is to be written.
The Schema Sources parameter defines where those feature types exist and uses them also to define the attributes and geometry
types that are written to the output.

Here, for example, we have a set of parks data being written to Esri Geodatabase. Notice the output feature type (table) name is set
to the NeighborhoodName attribute.
The schema is obtained from an Excel spreadsheet, added as a Resource Reader. If, for a particular feature, NeighborhoodName =
"Strathcona" then the writer looks for a sheet in the Excel spreadsheet file called Strathcona, and writes the feature using the same
attributes as that table.
However... underneath the Schema Source parameter in this dialog is a setting for Schema Definition Name. The Schema
Definition Name overrides attribute definitions:
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Here, for example, the user still specifies NeighborhoodName to provide the feature type to be written, but overrides the attributes
by saying they have to come from a table called Parks.
What's interesting is that the feature type specified by NeighborhoodName no longer needs to exist; i.e. the "Strathcona" sheet
does not have to exist to get a "Strathcona" feature type in the output Geodatabase. It is enough that the Parks sheet does exist.

Sister Intuitive says…
In the above example, the Schema Definition Name was a fixed value; i.e. all output feature types got the
same attribute definitions. However, the Schema Definition Name can also come from an attribute;
meaning one attribute defines the feature type name, and another attribute defines a feature type from
which the attribute schema is to come!

Adding or Deleting Attributes
Besides specifying which set of attributes to use, sometimes - even in a dynamic translation - you need to add or delete specific
attributes. This is very simple to do.
Adding a New Attribute
Adding a new attribute to all output on a dynamic feature type is just a case of editing the feature type definition to add that
attribute:

In other words, any attribute you add to the feature type definition gets added to all features output through there – regardless of
source or resource schemas.
For example, above the user adds an attribute to store the result of an AreaCalculator transformer in the workspace.
Deleting an Attribute
Deleting an existing attribute is done through the dynamic Schema Definition dialog. At the foot of that dialog is a field for
removing attributes:
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The edit [...] button opens a dialog in which to select or manually enter attributes that are in the source schema but that you don’t
want in the output:

Here the user manually enters Country (an attribute from the external schema) to remove it from the output. They also select
RefParkId not to be output.
The result of all of the above changes is as follows:

The feature gets various attributes from the Excel schema (City had to be set manually because the input had no such attribute),
and adds ParkArea on its own account. Country and RefParkId have either been removed or just chosen to not exist in the output
schema.
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Dynamic Geometry
Of the three main components of a schema:
Feature Type
Attributes
Geometry
...the last of these to investigate is Geometry; in particular how a workspace author can decide which geometries are valid for a
particular feature type.

Schema Geometry Definition
The geometry permitted in an output dataset depends on the format used. Some formats allow any geometry - or mix of
geometries - to exist in a feature type.
However, some formats do not allow a mix of geometries in a single feature type, and that can cause problems.
For example, a standard (static) Geodatabase writer feature type allows you to pick the geometry allowed in that file:

In a dynamic workspace, this changes. The geometry type permitted depends on that defined in the chosen schema:

By default - when the Schema Source is the same as the source data being read by the reader - then the permitted geometry is a
duplicate of that source dataset's schema.
But when the Schema Source parameter is changed to point to another dataset, then the permitted geometry is what is defined by
that dataset's schema.
If the geometry of the data to be written is different from that schema, and the destination format does not support multiple
geometry types, then features would be dropped instead of written.
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Fixed Geometry Definition
Even in a dynamic translation, the workspace author may set the dynamic schema parameter for permitted geometry back to a
fixed value. For example, the author could choose geodb_polygon (for a Geodatabase) or shape_polygon (for a Shapefile).
This will override the geometry defined by the chosen schema source, so that polygon features (but only polygon features) can be
written.

First Feature Geometry Definition
The other option for defining geometry type is First Feature Defines Geometry Type.

Geometry type can be difficult to handle in a dynamic translation because there is a degree of uncertainty about what geometry
types might be in the source data, and how well they will match up to the geometry types specified in the source schema.
However, this same uncertainty makes it difficult to set a fixed geometry definition.
The First Feature Defines Geometry Type option solves this. When selected, the first feature to arrive at the writer gets to set the
geometry type. That way the author does not need to know in advance what geometry is being processed or what geometry the
schema permits.
For example, if the first feature is a polygon, then the geometry type for that feature type is set to polygon only; subsequent
features destined for the same feature type are refused if they do not have the same polygon geometry.

Sister Intuitive says…
If you've understood everything so far about dynamic translations, without having to read each section at
least twice, then you are doing very well. This is a very advanced topic, and not everyone will understand
it the first time.
Basically all of these settings allow us to create an output dataset whose schema is defined in multiple
ways.
If you can keep that idea in your head when faced with schema handling beyond the usual static
workspace, you'll know what functionality is required and can look it up in this manual or on the FME
Knowledge Centre, and be able to figure out what techniques match your particular need.
Also, this table may help...
I Know the
Format

I Don't Know the
Format

I Know the Layers

Static

Generic + Static

I Know the Attributes

I Don't Know the
Layers

Fanout

Generic + Fanout

I Know the Attributes

I Know the Layers

Dynamic

Generic + Dynamic

I Don't Know the
Attributes
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I Don't Know the
Layers

Dynamic

Generic + Dynamic

I Don't Know the
Attributes
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Exercise 4

Dynamic Community Map Translation (Schema Handling)

Data

Community Mapping (Esri File Geodatabase)

Overall Goal

Create a workspace to generate a new Community Mapping dataset using an existing schema

Demonstrates

Dynamic Schemas

Start Workspace

None

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\ReadWrite-Ex4-Complete.fmw

Previous exercises have involved translating the Community Mapping dataset, used by the planning department for various
community mapping tasks.
However, as time has moved on the Community Mapping dataset has become out of date. The planning department, therefore,
wants to start building a new community map dataset. The dataset will have new data, but use the existing schema where possible.
They also – in order to use an open standard – want a format change to GML.
At the moment two source datasets have been identified as being required in the new community mapping "database". They are
fire halls (source format: GML) and city parks (source format: MapInfo TAB).
So, let's create a new workspace to handle that scenario.

1) Inspect Data
Inspect the two source datasets in the FME Data Inspector, to become familiar with them.
Format

GML (Geography Markup Language)

Dataset

C:\FMEData2018\Data\Emergency\FireHalls.gml

Format

MapInfo TAB (MITAB)

Dataset

C:\FMEData2018\Data\Parks\Parks.tab

There was already parks data in the community mapping, but this time it is polygons, not points. The FireHalls data is entirely
new for community mapping.

2) Start Workbench
Let's get started by generating a workspace as follows:
Reader Format

GML (Geography Markup Language)

Reader Dataset

C:\FMEData2018\Data\Emergency\FireHalls.gml

Writer Format

GML (Geography Markup Language)

Writer Dataset

C:\FMEData2018\Output\Training\NewCommunityMap.gml

Workflow Options

Dynamic Schema

The dynamic option is chosen so that we can use a schema other than that of the dataset being translated.

3) Add Reader
So far, so good. Now let’s add a reader for the new parks data by selecting Readers > Add Reader and using the following details:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2018\Data\Parks\Parks.tab
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Single Merged Feature Type

Workflow Options

Connect the new reader feature type up to the existing writer feature type, and add bookmarks for the feature types for easier
recognition.

4) Add Resource Reader
One of the requirements was to use the existing community mapping schema where possible. With the fire halls, it isn’t possible
since that never existed in the Community Mapping Geodatabase. However, the parks dataset did exist in that Geodatabase, so
we’ll need to use that schema.
So, select Readers > Add Reader as Resource and, when prompted, enter the following details:
Reader Format

Esri Geodatabase (File Geodb Open API)

Reader Dataset

C:\FMEData2018\Data\CommunityMapping\CommunityMap.gdb

NB: If you see the parameter for "Individual Feature Types/Single Merged Feature Types" then you chose "Add Reader" not "Add
Reader as Resource". Click Cancel and pick the correct menu entry this time!
Click OK, and the reader is added as a Resource:

5) Adjust Dynamic Parameters
Now we need to make sure that the resource schema is being used.
Inspect the properties for the writer feature type. Click the Schema Sources browse button.
Put a checkmark against CommunityMap. Ensure Parks is NOT checked but that FireHalls is:
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Check the other dynamic parameters. Since we are writing both points and polygons, for some formats we might have to change a
Geometry setting. But since GML can cope with both geometry types we won't have to take any action; in fact, there will not even
be a parameter for geometry type! Accept the parameter changes to close the dialog.

6) Save and Run Workspace
Save the workspace and then run it.
Inspect the output. There should be two layers: one for fire halls, the other for parks. The parks dataset should have the schema
from the Geodatabase (not the MapInfo parks), including attributes for ParkName, ParkAddress, and ParkURL (even if there is no
data to fill some fields yet):

Notice that it also has OBJECTID, which came from the Geodatabase and we don’t really need.

7) Delete Attribute
Revisit the writer feature type parameters. Under Attributes to Remove type OBJECTID into the first row. You won’t be able to
select it from the drop-down list because it comes from a resource reader, not a real reader:
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But don't accept the changes yet...

8) Add Attribute
A last-minute request is to add an attribute – LastUpdatedBy – to all tables in the output.
So, click on the User Attributes tab and add this new attribute. Make it a 30 character string.

As you can see, there is no need to change the attribute definition mode - it should stay as dynamic.

9) Re-Run Workspace
Save the workspace and rerun it.
Inspect the output. Notice that OBJECTID will not appear as an attribute. LastUpdatedBy does appear, albeit that it doesn’t have a
value yet.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a dynamic workspace with multiple readers
Add a Resource Reader
Change the source of a dynamic workspace schema
Add and remove hard-coded attributes in a dynamic workspace
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Alternative Dynamic Schema Sources
In general, the schema for a dynamic translation comes from either the source dataset itself or from a different dataset (such as the
database table the data is being written to).
However, there are two other scenarios for providing the output schema:
A schema can come from a lookup table (text file or spreadsheet) in which definitions are stored
A schema can be defined dynamically as a list of attributes in a workspace

Table-Based Schemas
In this scenario, the output schema is stored as some form of a table in a text file or spreadsheet; for example:

Here the author has listed a series of feature types, attributes, and geometry types that define the output schema. In FME they
would use this schema by adding a Resource Reader. The format of the Resource Reader would be Schema (From Table):
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In the parameters dialog for this reader there are parameters to specify which fields in the table represent which parts of the
schema:

Geometry type is optional but used in this example.
Attribute sequence is another optional parameter. It defines a field in the table that records the order that attributes should appear
in.
Then, of course, this reader must be used as the source for the output schema:
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As always, the incoming attributes must be mapped to the outgoing schema. The best way here is the SchemaMapper transformer
since it too can use a lookup table to create its mappings.

Sister Intuitive says…
A significant advantage of this method is that you don’t need to edit the workspace, or edit a dataset, to
make schema changes. Once you change the output schema in the table, then that is automatically applied
in the FME translation. That’s heavenly!

Constructed Attribute Schemas
This scenario is a way to construct an attribute schema using lists in FME. The schema is defined by using attributes in the list, for
example:

The writer is told to use this schema in preference to any others by selecting it as the Source Schema:
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FME Data Types
Both of the two preceding tools allow the user to define attribute type in an output schema. There are a set of valid datatypes in
FME, which are as follows:
General Field Type

Specific Field Types

Character Fields

fme_varchar(width), fme_char(width), fme_char

Integer Fields

fme_uint8, fme_int16, fme_uint16, fme_int32, fme_uint32, fme_int64,fme_uint64

Numeric Fields

fme_decimal(width,decimal), fme_real32, fme_real64

Date-Time Fields

fme_datetime, fme_time, fme_date

Other Fields

fme_buffer, fme_boolean

Miss Vector says…
The ability to construct a dynamic schema from attributes in a workspace has lots of possibilities. In fact,
one of these FME transformers automatically creates dynamic schema attributes specifically so you can
create a new schema. Which is it?
1. SchemaMapper
2. AttributePivoter
3. PythonCaller
4. Clipper
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Exercise 5

Dynamic Community Map Translation (Table-Based)

Data

Community Mapping (Esri File Geodatabase)

Overall Goal

Generate a new Community Mapping dataset using a table-based schema

Demonstrates

Table-based schemas for dynamic translations

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\ReadWrite-Ex5-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\ReadWrite-Ex5-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\ReadWrite-Ex5-Complete-Advanced.fmw

In a previous exercise, you created a new community map dataset for the planning department using a dynamic schema. At the
time only two tables were defined, but now another one is required, and the planning department wants you to update the
workspace.
Rather than having to make changes each time they add more datasets, you believe that you can simply create an Excel
spreadsheet containing the schema definition. That way the planning team can edit it themselves and do the same for all future
updates.

1) Inspect Spreadsheet
Open and examine the spreadsheet at C:\FMEData2018\Resources\DesktopAdvanced\CommunityMapSchema.xlsx.
If you don’t have Excel then open it in the FME Data Inspector and switch to Table View.

The table has schema definitions for Firehalls, Parks, and Zones feature types.

2) Start Workbench
Start FME Workbench. Open the workspace from the previous exercise or the begin workspace listed above.
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3) Delete CommunityMap Resource Reader
Because we are using a spreadsheet to define our output schemas, the CommunityMap Resource Reader is no longer needed.
Locate it in the Navigator window, right-click on it, and choose Delete.

When prompted, click OK to confirm that all references relating to this dataset will also be removed.

4) Add Excel File as Reader Resource
Now select Readers > Add Reader as Resource. In the dialog that opens choose:
Reader Format

Schema (From Table)

Reader Dataset

C:\FMEData2018\Resources\DesktopAdvanced\CommunityMapSchema.xlsx

*NB: Be sure to use the Schema (From Table) format and not the Excel format!*
Before clicking OK, click the parameters button (if you don't you will be prompted to anyway). This dialog is where we can
define how the table maps to the required schema.
Check the reader parameters at the top. They should show the dataset is an Excel format file. Select Sheet1 as the table to use:
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The first row should get used as the field names. If this is not the case, then click the parameters button above and set the values
correctly:
Next, select the appropriate fields to match to the required parameters (for example Feature Type = FeatureType):

Click OK to close the dialog and again to add the resource reader.

TIP
The fields in such a lookup table can be given any name you desire. In this example, they have been given
the same name as the parameter to which they are being applied, but only to make the relationship as
obvious as possible.

5) Set Dynamic Parameters
Now inspect the feature type parameters for the writer feature type.
Under the User Attributes tab remove the LastUpdatedBy attribute, as we’ve added this to the spreadsheet definition for each type
and no longer need it in here.
In the Parameters tab click the Schema Sources edit button. Uncheck FireHalls and check CommunityMapSchema
[SCHEMA_FROM_TABLE]:
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Accept the changes to these parameters.

6) Add Reader
If you noticed, the schema spreadsheet included an entry for the Zones dataset, so add a reader (not a Resource – we really want
the data this time) as follows:
Reader Format

MapInfo TAB (MITAB)

Reader Dataset

C:\FMEData2018\Data\Zoning\Zones.tab

Once added, connect its reader feature type to the dynamic writer feature type.

7) Save and Run Workspace
Save the workspace and then run it.
Inspect the output. Notice that all three feature types have been written and that their attribute schema matches what was defined
in the Excel spreadsheet; including the LastUpdatedBy field for each one.

Advanced Exercise
Let's do a couple more advanced steps if you have the time.
If you aren't able to make edits to the Excel file (as in the next two steps) simply inspect and substitute an
advanced copy of the file at:
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C:\FMEData2018\Resources\DesktopAdvanced\CommunityMapAdvancedSchema.xlsx

8) Update Spreadsheet - 1
The planning team has decided they should rename some attributes, so open the spreadsheet and rename the following attributes
for the FireHalls feature type:
Name to HallName
Address to HallAddress
PhoneNumber to HallPhone
NB: If you don't have Excel, instead of this step merely change the Resource Reader to use the advanced schema version of the
file, C:\FMEData2018\Resources\DesktopAdvanced\CommunityMapAdvancedSchema.xlsx

9) Update Spreadsheet - 2
If you run the workspace now, it will run to completion, but there will be no values in the renamed fields. That’s because FME has
no way to tell how to map the source data to the new schema.
We could just add an AttributeRenamer transformer to handle this change, but the better way is to use the SchemaMapper. That
way it can be made a little more dynamic.
So, in sheet 2 of the spreadsheet, enter:
OldAttrName

NewAttrName

Name

HallName

Address

HallAddress

PhoneNumber

HallPhone

Then save the spreadsheet.
NB: Again, if you don't have Excel simply change the Resource Reader to use the advanced schema version of the file,
C:\FMEData2018\Resources\DesktopAdvanced\CommunityMapAdvancedSchema.xlsx

10) Add SchemaMapper
Add a SchemaMapper transformer to the workspace, connected to the output feature type:
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Inspect the SchemaMapper's parameters. It is a wizard, rather than a single dialog. In the format panel select the edited Excel file.
In the next panel select Sheet 2 as the table to use.
In the final panel, select Add > Attribute Map:

When prompted, select OldAttrName as the source field and NewAttrName as the Destination field. Check the box to Remove the
original attributes (i.e. this is a renaming, not copying):
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Click OK to close this dialog, then click Finish. Now save and rerun the workspace.
This time the output will have its attributes properly mapped. So now the planning department can translate their data, decide on
the output schema, and map source to destination attributes dynamically; all by editing this one Excel spreadsheet.

CONGRATULATIONS
By completing this exercise you have learned how to:
Set up a spreadsheet for use as a dynamic translation schema
Use the Schema (from Table) reader to read a schema from a spreadsheet
Map attributes in a dynamic workspace using a SchemaMapper transformer
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Module Review
This chapter looked at advanced techniques for reading and writing datasets with FME.
What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
Datasets stored on the web can be read either using a simple URL or through an FME Web Connection.
A Fanout is a way to divide data into a number of layers or a number of datasets, according to the value of a user-defined
attribute.
The Generic Reader and Writer allow a workspace to be dynamic in terms of format; it can read any format of data and write
any format of data.
Schema is composed of Feature Types, Attributes, and Geometry. A Dynamic translation is a universal workspace that can
handle any combination of schema.
The Schema in a dynamic workspace does not need to come from the source datasets; it can come from another dataset
entirely, come from a lookup table, or can be constructed as list attributes inside the workspace.
FME Skills
The ability to create a web connection and upload to FME Server
The ability to read and write datasets from and to a zip file
The ability to read data stored on the web or in a web service
The ability to use a Feature Type Fanout and a Dataset Fanout
The ability to use the Generic Reader and Writer
The ability to create a simple Dynamic workspace
The ability to add a Resource Reader
The ability to use a Resource Reader or Lookup Table as the schema source in a dynamic translation.

Further Reading
For further reading why not browse articles tagged with Dynamic Schema or Fanout on our blog?
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Fanouts are an important part of writing data with FME, so tell me, which of these statements are true?
1. You can have both a Feature Type Fanout and a Dataset Fanout in the same workspace
2. You can use a Feature Type Fanout with a database format, but not a Dataset Fanout
3. A fanout expression can be an attribute, or a constructed string, but not a user parameter
4. A fanout cannot be based on a format attribute such as fme_color
It's true you can have both types of fanout in the same workspace, but a database writer won't do a
Dataset Fanout (it can create multiple tables, but not multiple databases). A Fanout Expression can be
any attribute (including FME attribute or format attribute) or string, and it can be a user parameter too!

Miss Vector says...
Now tell me which of these statements about Generic Reading/Writing are true?
1. Because you select an output folder, the Generic Writer won't write to a file format like AutoCAD DWG
2. If the feature types of the chosen format are limited to a single geometry, the Generic Writer will drop
all features except a single geometry type
3. The Generic Writer does not support either type of Fanout
4. The ParameterFetcher transformer can be used to retrieve the format of data being Read/Written in
order to route features in a specific way through the workspace
Most of these are untrue. The Generic Writer will create files, even though you only pick the output folder,
and it will create multiple feature types if it's necessary to split data because of clashing geometry types.
On a similar vein, fanouts are supported.
And, yes, the ParameterFetcher transformer will fetch the value of the format parameter letting you
redirect data in the workspace (for example you might route data through a KMLStyler if KML is the
chosen output format).

Miss Vector says...
It's important to get the concepts correct here, and I have some more statements only some of which are
true:
1. A Dynamic workspace will read/write any format of data
2. A Dynamic workspace will read/write any feature types in the source data
3. A Dynamic workspace will read/write any attributes in the source data
4. A Dynamic workspace will read/write any geometry in the source data
Feature Types, Attributes, and Geometry are the three schema parts handled by dynamic workspaces.
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However, format is not handled. This is the role of the Generic Reader/Writer. If you don't use the Generic
Reader/Writer your dynamic workspace will not handle any format.
Basically, the term Generic means “any format”, while Dynamic means “any schema”. A workspace may
be generic, or dynamic, or both, or neither!

Miss Vector says...
The ability to construct a dynamic schema from attributes in a workspace has lots of possibilities. In fact,
one of these FME transformers automatically creates dynamic schema attributes specifically so you can
create a new schema. Which is it?
1. SchemaMapper
2. AttributePivoter
3. PythonCaller
4. Clipper
The AttributePivoter creates a whole new series of attributes that are completely different to the source
schema; therefore it also generates a dynamic schema to assist you in writing the data. Check it out and
you will see it creates a whole series of attribute_name{} and attribute_data_type{} list attributes.
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Advanced Parameter Use
Parameters are controls that define how FME operates; for example, how a reader reads data, how a transformer transforms it, and
how a writer writes it. Almost every component in FME has parameters of one type or another.

Types of Parameter
When looking at the types of parameter, it’s helpful first to consider the types of people who use FME and their role in the
process.
Workspace Authors are the people who design and create a workspace. Authors use FME Workbench and set parameters to
control how the workspace runs.
Workspace Users are the people who make use of a workspace, without necessarily having created it first. Users might have very
little knowledge of FME, and may never have used FME Workbench, but they still may need to set parameters to control how the
workspace runs.
In light of these two roles, we can say there are two different types of parameters: FME Parameters (for authors to use) and User
Parameters (for FME users to use).

Ms. Analyst says...
Hi, I'm Ms. Analyst. I'm here to help leverage your user parameter strategies and will touch base from
time-to-time throughout this chapter.
The concept of workspace users who have never heard of FME sounds like an oxymoron. However, think
about users that are on the client side of an FME Server installation; they might be using a custom web
page or application that triggers a translation on FME. So it's entirely possible to need to set workspace
parameters without even knowing what a workspace is!
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FME Parameters
FME parameters are those built into the FME Workbench interface. They directly control a translation and can be found in various
places, such as transformer dialogs or feature type dialogs. However, for the most part, you will find all FME Parameters in the
Navigator Window of FME:

Here, for example, are the FME Parameters for a text file writer. They include options to overwrite or append to an existing text
file and the type of character encoding that should be used.
These are parameters the workspace author will use. The user is not expected to set these because they are not assumed to have
enough experience of Workbench to know where to find the parameter or how to set it.
For example, the author might decide that the Byte Order Mark should not be written in this output.

They double-click the parameter to open a dialog in which they can change the parameter value.

Ms. Analyst says...
In case you were wondering, the Byte Order Mark (aka BOM) is a special character found in the header
of a text file. It denotes whether the text is in a Unicode encoding, which Unicode encoding it is, and what
the endianness of the text is. It helps different applications to read the data correctly.
You want to know what "endianness" means now, don't you? It's not important. Outside of our training's
core competency.

228

User Parameters

User Parameters
User Parameters are those that are created by an FME author, but for an FME user to use. In other words, they are a way for the
end-user of the workspace to provide their input to a workspace.

Creating a User Parameter
User parameters appear in a particular section of the Navigator window, labeled User Parameters. Here, for example, two user
parameters have been defined:

Each of these user parameters allows the end-user of a workspace to enter information into the translation; whether to process line
features and what color to write them in.
A user parameter is easy to create by right-clicking on the User Parameters label and choosing Create User Parameter:

A dialog appears in which the author can define the parameter. In this case, they are creating a parameter in which the user can
enter their name:
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You can also duplicate, copy and paste user parameters. This allows the workspace author to duplicate existing parameters and
make changes - instead of having to build several near identical parameters from scratch - and includes being able to paste a
parameter definition into a different workspace from which it was copied.

Entering Information into a User Parameter
Once a user-parameter is defined, when the workspace is run the user is prompted to give their input.
In FME Workbench (or the FME Quick Translator) the user is prompted through a simple dialog:

In FME Server, the user is prompted through a web page:
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Ms. Analyst says...
In the FME Quick Translator, the user is always prompted to fill in user parameters when running a
workspace. However, in FME Workbench, prompting only happens when the prompt option is turned on in
the menubar:

Think of it as a nano-paradigm shift between the two applications.

Using a User Parameter
Getting input from a user is pointless if it is not used, so it’s also necessary to actually do something with that input.
User parameters can be exploited in a number of places. Firstly they can be tied to an FME parameter (more information on that in
the next section), but they can also be used to provide values to transformers and attributes in a workspace.
For example, here the author is making use of the color and username parameters (in the FeatureColorSetter and
AttributeManager transformers):
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The author set up these transformers to use the parameter input by selecting it in the transformer like so:

Now when the workspace is run, the end user can select the color of features to write, plus enter their name into a text field and
have it entered into the UpdatedBy attribute in the output.

Miss Vector says...
Do you remember me? I'm Miss Vector. I ask the hard questions around here. But to start with tell me this,
what are our two roles of FME user?
1. Creator/Inspector
2. Author/User
3. Reader/Writer
4. Maker/Consumer
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Here's another question, only slightly less easy. Look at the ParameterFetcher transformer. What does it
do?
1. Fetches the name of a user parameter
2. Fetches the value of a user parameter
3. Fetches the type of a user parameter
4. Fetches the user a cup of tea
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Exercise 1

Parameterize a Metadata Writer

Data

Parks (MapInfo TAB)

Overall Goal

Allow user input to metadata fields

Demonstrates

Use of FME parameters.
Creation and use of User Parameters

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex1-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex1-Complete.fmw

In this example, imagine that you are a GIS technician working for a city planning department.
The team responsible for maintaining parks has a workspace that translates their data from the source MapInfo TAB format to
Google KML. It also writes a file of XML metadata to show who translated the data and when.
At the moment there are a number of problems they face.
The XML output is not particularly well formatted
The date attribute is being rejected by an online XML validator
All of the XML metadata fields are hard-coded in an AttributeCreator transformer. This is quite inconvenient (especially
when they want to run the workspace on FME Server!)
You have been assigned to help solve these problems. At least one of these requires you to create user parameters to take the place
of hard-coded values.

1) Start Workbench
Start Workbench and open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex1-Begin.fmw

.1 UPDATE
FME2018.1 has a new version of the AttributeCreator transformer, with improved performance. If you
wish, right-click the AttributeCreator and choose Upgrade Transformer to upgrade the transformer in this
workspace.

The metadata part of the translation consists of the two transformers and an XML writer feature type.
The Sampler transformer ensures that only one record is written to the output metadata, by discarding all but one feature, and the
AttributeCreator creates a set of attributes to write to the metadata.
Check the parameters for each transformer in turn. These are FME parameters, set by the workspace author and not available to
the end-user. Here, for example, are the parameters for the Sampler transformer:
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You can find these parameters in the Parmeter Editor window, the transformers' Parameters Dialog, and under the Transformers
section of the Navigator window.

2) Change XML Writer Parameter
An FME parameter called Pretty Print controls the style of the XML file being written:

To ensure the output is always well-formatted, we should set this parameter to Yes - but we won't create a user parameter from it
because we don't want the end-user to change it.
In the Navigator window locate the XML writer, expand the parameters list, and locate the parameter labeled Pretty Print. Doubleclick on it.
In the dialog that opens, change the value to Yes and then click OK to close the dialog.

We have now - as a workspace author - changed an FME parameter.

3) Create User Parameter
The output schema has three variable attributes: username, user company (organization), and user email. We should create a user
parameter for each of these to allow the end-user to enter that information.
Firstly, locate the User Parameters section of the Navigator window, right-click on it, and choose the option to Add Parameter:
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In the new dialog, select Text as the type of parameter to create (there is more on parameter types in the next section). Each
parameter needs a name, so call this one UserNameParam. Now enter a prompt, such as "Enter your name."

Click OK to close the dialog and create the parameter, which now appears in the Navigator window.

4) Create Remaining User Parameters
The quickest way to create the other two required parameters (UserEmailParam and UserCompanyParam) is to duplicate the
UserNameParam parameter.
So, right-click on the UserNameParam parameter and choose the option to Duplicate:
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A settings dialog for the duplicate parameter will open. Call it UserMailParam and set the prompt to “Enter your email address”.
Repeat the duplication process, this time creating a parameter called UserCompanyParam with the prompt "Enter your company
name."
When done the Navigator window looks like this:

5) Use User Parameter – Method 1
Each of the user parameters we've just defined provides values that need to go into attributes in the writer schema. There are a
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number of ways to extract the value for such a purpose, and we’ll use a different way for each parameter, just to illustrate the
different methods.
So, firstly locate the parameters for the AttributeCreator (either the Parameter Editor window or AttributeCreator Parameters
dialog). This transformer is what currently creates the attributes for the output.
Click the Attribute Value field for the AuthorName attribute. Click on the drop-down arrow, then select User Parameter >
UserNameParam.
Once done the value field will change to a special icon and show the parameter that was chosen:

While here, click on the AuthorEmail and AuthorCompany fields, and press the minus button to delete them, so that we can
demonstrate dealing with these a different way.

6) Fix Date Attribute
Looking at the AttributeCreator, we can see that the date field is being entered as a fixed value. Although not a user parameter as
such, it's evident that the user must be setting this manually at runtime.
Additionally, the date structure does not conform to an ISO standard, which is why the output fails XML validation.
Let's fix these issues. First click on the drop-down arrow next to the UpdateDate Attribute Value field, then choose Open Text
Editor:
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In the text editor remove any existing content and replace it with:
@DateTimeFormat(@DateTimeNow(),%Y-%m-%d)

This uses FME Date/Time functions to return today's date in a structure matching the ISO date standard.

Firefighter Mapp says...
An alternative method is to simply set the date value to @DateTimeNow() and using the
DateTimeConverter transformer to convert it to a real date in an ISO date standard:

7) Use User Parameter – Method 2
A second way to extract the value from a user parameter is with a ParameterFetcher transformer.
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Place a ParameterFetcher transformer (after the AttributeCreator is fine). Inspect the parameters.
Select UserEmailParam as the parameter to fetch. Enter AuthorEmail as the name of the target attribute, then select
UserCompanyParam and enter AuthorCompany as the target attribute:

Ms. Analyst says…
Did you notice that the list of parameters available includes many FME-related system parameters? These
are particularly useful for use with FME Server.

8) Use User Parameter – Method 3
The final method to extract the value from a user parameter is with a schema attribute value.
To achieve this, we will create one more attribute, this time to record the FME Build Number. Open the ParksMetadata feature
type parameters and switch to the User Attributes tab. Switch the Attribute Definition to Manual if it isn't already. Then enter
BuildNumber under Name and set the type to xml_char. Click OK:
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Now right click on BuildNumber attribute on the ParksMetadata feature type. Then select the Edit Value option:

In the dialog that opens, you can enter a fixed (constant) value, but in our case, we’ll click on the drop-down arrow, select User
Parameters, then FME Parameters and then select FME_BUILD_NUM:
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Click OK to close the dialog, and the feature type should look like this. Notice how the attribute that has had its value set is now
highlighted with a specific icon:

9) Save and Run Workspace
Save the workspace and then – as if you were the end-user – run it. Be sure to set the Prompt option on the toolbar first:

When prompted enter your details into the fields that have been newly created, notice that the BuildNumber parameter we created
isn't in the prompt. This is because it is an FME specific private parameter that the user doesn't need to change:
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Locate and open the XML file to ensure the contents have been inserted as expected:

CONGRATULATIONS
By completing this exercise you have learned how to:
Set an FME parameter (on the XML writer)
Create a text type user parameter
Duplicate an existing parameter
Use a user parameter in a regular transformer
Use a user parameter in a ParameterFetcher transformer
Use a user parameter in an Edit Value dialog
Use the DateTimeNow and DateTimeFormat functions in a text editor to create an XML-valid date
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Types of User Parameters
There are many different types of user parameters and many different ways to make use of them. The most common parameter
types can be grouped as:
Text Parameters
Numeric Parameters
Choice Parameters

Text Parameters
Text parameters are a simple way to accept plain text values into a workspace. A Text parameter allows a single line of text, while
Text (Multiline) parameters allow the user to enter text broken over a number of lines.

There is no limitation on the characters that can be entered. However, Text (Multiline) is better for large amounts of text spanning
several lines. Additionally, Text (Multiline) is the preferred parameter for entering encoded (not plain ASCII) characters.

Ms. Analyst says…
It's worth being aware that not every transformer and format in FME handles encoded text. If you are
unsure, then it’s safer to use a Text parameter – that everything will support – rather than a Text
(Multiline) parameter that is not universally supported.

Numeric Parameters
Unlike text, there is just one type of numeric parameter: number. However, this type of parameter has settings that allow you to
define whether it is a float or integer type number.
Here, for example, the workspace author is creating an integer parameter. The number of decimal places is set to zero:
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When the user is prompted for a value, they are not able to enter a floating point (non-integer) number. Because this is a number
field, FME also stops the user entering text (alphabetic) characters.
This is a good example of how FME parses input to ensure it matches the parameter type, as shown in the following screenshots:

Invalid input: 12.3 is not a valid integer
Invalid input: abcd is not a valid float
Valid input: negative numbers are fine
Invalid input: 123.4567 is a valid float, but has 4 decimal places of precision, when the definition was only 3
Valid input: 123 is a valid integer
Valid input: 123.456 is a valid float with the correct decimal places of precision
The Upper/Lower Limit settings for a numeric parameter also allow FME to parse the input to ensure it matches what is required:

Invalid input: needs to be greater than 3
Invalid input: needs to be less than or equal to 10
Valid input: between 3.001 and 10.000

Choice Parameters
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A choice parameter is when the user is presented with a fixed list of options and selects one of them. Different choice type
parameters allow the user to pick from a list, pick multiple entries from a list, or type in text as an alternative to a list:

Here the user will be asked to enter their name. However, since the names of all users are already known – presumably this is for a
particular company’s staff – a list of them is created:

That way, the user is prompted to select their name from a list. They don’t have to type it in manually:

A Choice with Alias parameter is the same as a Choice parameter in that the end-user gets to pick a value from a list. However, a
lookup table maps the chosen entry to a value that gets provided to FME.
For example, this workspace takes incoming features and matches them to a database using an EmployeeID.
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EmployeeID is provided by the end-user, but they can’t always remember their own ID number. So, the author creates a Choice
with Alias user parameter.
The parameter is configured like so:

Notice that there are two fields in this configuration dialog; the display name and the actual value.
When a user selects their name from the list, then the value provided to the workspace is actually their employee ID. That way
employee ID can be used as a match in the DatabaseJoiner, without the end-user having to remember it!

Ms. Analyst says…
Choice (Multiple) and Choice with Alias (Multiple) are very similar parameters (to Choice and Choicewith-Alias), but let the end user select multiple values. For example, if a manager wanted to run reports
on several employees, this is what they could use. Multiple values are returned space-delimited.

Miss Vector says...
Besides the above, there are some more - specialist - parameter types. Which of the following is NOT a
valid parameter type?
1. Coordinate System Name
2. Password
3. String Encoding
4. URL
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Linking Parameters
As we know, there are FME parameters that control FME directly and user parameters that allows input from a user.
Sometimes a workspace author needs the user's input to apply directly to an FME parameter, and this is done by linking the user
parameter to the FME parameter.
For example, an FME author has a workspace that writes to a KML dataset. There is a parameter called "Author Email" that adds
the user's email as metadata.
The workspace author wishes for the end-user to enter their own email address, but doesn't want them to have to search for that
parameter.
So, besides the FME parameter, they create a user parameter:

Their user parameter allows the user to enter a value, but as yet the workspace does not do anything with that value. To do so, the
user parameter must be linked to the FME parameter.
The author does this by right-clicking the FME parameter and choosing Link to User Parameter:
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Then they select their user parameter to link to.

Ms. Analyst says...
Alternatively, they can do the reverse; right-click the User parameter and choose Apply To [FME
Parameter]. But there are usually more FME parameters than user parameters, so the 'Link' method is
usually easier and quicker.

Because the FME parameter is now linked to the user parameter, whatever value the user sets for that user parameter is applied
directly to the FME Parameter (Author Email):
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Ms. Analyst says...
If the author changes their mind, there is always an option to unlink the user parameter and return the
FME parameter to direct author control.

Creating Direct Links
In the previous example, a user parameter was created separately and then linked to the FME parameter. However, there is a
shortcut to this, where it is possible to both create and link a parameter simultaneously.
In the Navigator window, simply right-click an existing FME parameter and choose the option to "Create User Parameter":

This opens the Add User Parameter dialog as before, but this time the definition to create a parameter is filled in automatically:

Click OK and the user parameter is created and automatically linked to the FME parameter.

Ms. Analyst says...
You can do the same one-step action inside a transformer dialog too, like so:
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Here the workspace author is creating a user parameter linked to the Elevation FME parameter in a
3DForcer transformer.

Advantages and Disadvantages of Direct Links
You might be wondering why you would ever link a user parameter separately, or why we showed that process first. It's because
there are advantages and disadvantages to both methods.

Direct Link Advantages
Creating a linked FME parameter directly has an obvious advantage that it is a single-step process. The creation and linking of the
user parameter are done in a single action.
Additionally, a user parameter created from an FME parameter is automatically given the correct data type.

For example, in the 3DForcer, elevation requires a floating point number; any user parameter created from this FME parameter
will automatically be of type float, without the option to change it.

Direct Link Disadvantages
The inability to set data type can, however, be a limitation.
Say, for example, the author wanted to provide a list of permitted elevations for the 3DForcer; 0.0, 10.0, 50.0, etc. This could not
be achieved by creating the user parameter directly because it would create a Float parameter when a Choice is the required
option.
So the author should create a choice user parameter separately and then link it to the FME parameter:

251

Linking Parameters

Of course, the author needs to take care that the values provided by the user parameter were of a type that matched those expected
by the FME parameter. FME isn't able to parse all input from a user parameter (especially Choice parameters) to ensure it matches
the FME parameter it is linked to.
Another disadvantage is one of a persistence of the user parameter.
It's like this: if a user parameter is created directly from an FME parameter on a transformer, then it is forever tied to that
transformer. If the transformer is deleted, then the FME parameter will be deleted too.
However, if a user parameter is created separately, and linked manually to a transformer’s FME parameter, then it will remain in
the workspace, even if the transformer is deleted.
This could be seen as either an advantage or disadvantage, depending on whether you would like this behavior or not!
Finally, a user parameter created directly has no control over what is known as Attribute Assignment (more on that later in this
chapter).
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Pre-Linked Parameters
In some scenarios, user parameters are created automatically and linked to an FME parameter, without any manual action by the
workspace author.
For example, any time a reader or writer is added to a workspace, their source/destination dataset parameters are automatically
turned into user parameters.
Here, a Source MapInfo TAB parameter is linked automatically to a user parameter called SourceDataset_MITAB:

Automatic linking occurs for parameters that are important to the end-user, and that appear in nearly all workspaces.

Miss Vector says...
If you – as the workspace author – don’t want or require the end-user to have access to pre-linked
parameters, then what can you do?
1. Delete the Reader/Writer
2. Unlink the user parameter
3. Delete the FME parameter
4. Delete the user parameter
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Exercise 2

Code Review a Colleague's Workspace

Data

Community Map (File Geodatabase)

Overall Goal

Simplify a workspace using user parameters

Demonstrates

Creation and use of complex User Parameters

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex2-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex2-Complete.fmw

The Public Safety department at the city has just bought into FME and started using it for data translations.
However, having not (yet) taken the FME Desktop training course, they are not confident users and would like some assistance.
You have been tasked to carry out a "code review" on one of their workspaces. At least one of the issues you find is likely to
involve creating user parameters to take the place of hard-coded values.

1) Start Workbench
Start Workbench and open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex2-Begin.fmw
This is the workspace created by your colleagues:

.1 UPDATE
FME2018.1 has a new version of the AttributeCreator and AttributeCopier transformers, with improved
performance. If you wish, right-click each such transformer in turn and choose Upgrade Transformer to
upgrade them in this workspace.
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Notice that it converts from an Esri Geodatabase to Esri Shapefile format. Currently, the tables that are to be processed are chosen
by disabling unwanted ones in the workspace. Similarly, they are setting the destination coordinate system and data encoding
using Navigator parameters. This is all very user-intensive.
Also, notice that the only annotations in the workspace are there to help the end user make such edits. There should be no need for
that; published parameters should prompt the user instead, and that is what we will implement here.

2) Clean Up Auto-Created User Parameters
Open up the User Parameters section of the Navigator window. Notice how there are already user parameters for the source and
destination datasets:

Your public safety colleague tells you that the source data will never change, so that parameter is of no use. So delete the user
parameter labeled “SourceDataset_FILEGDB.”
However, she tells you that the destination location can be set by the user, so keep the parameter for DestDataset_ESRISHAPE.

3) Create Encoding Parameter
The Public Safety team want to make it easier to set the encoding of the output dataset. Currently, users are pointed towards the
point on the Navigator where that writer parameter exists by a workspace annotation!

This shows you how difficult it is for them to locate the correct parameter in the Navigator window. Let's solve that with a user
parameter.
Locate the Shape writer in the Navigator window and expand the list of FME parameters. Identify the Character Encoding
parameter, right-click on it and choose Create User Parameter:

Simply click OK on the dialog that opens and a user parameter is created and linked to the FME one. Now there is a user
parameter to make it easy to set that FME parameter.

4) Create Coordinate System Parameter
Another requirement, you are told, is an ability to set the output coordinate system. Again this is currently done by using an
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annotation to point the user towards the Navigator Window.
However, if you simply publish the writer’s coordinate system parameter – try it and see – then there will be a problem. The
parameter will allow the end-user to select ANY coordinate system supported by FME.
This is not necessarily very useful. Since the data is located in Vancouver, BC, it makes little sense for the user to be able to
reproject it to (for example) NZMG (a New Zealand coordinate system).
It would be preferable if the parameter only allowed the end-user to select a coordinate system from a smaller list.
Now create a new user parameter (Right-click User Parameters > Create User Parameter), and set the Type to be Choice with
Alias. Set the Name to be CoordSysParam, and set the prompt to be Select Output Coordinate System:

Now click the [...] button to the right of the Configuration setting. This opens a dialog in which to configure the parameter.
Normally we would enter values manually in a Choice with Alias parameter, but for coordinate systems (and reader/writer
formats) we have the option to have FME define them for us.
Click on the button labeled Import and choose Coordinate System(s):

This opens a list of coordinate systems that we can import as values in our user parameter.
Locate and put a checkmark in the box for the following coordinate systems:
UTM83-10
BCALB-83
LL83
CANBC-LCC
Then click OK to close this dialog. You will be returned to the configuration dialog and find that names and values have been
automatically entered for these coordinate systems:
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The left-hand side shows what the user is prompted to select, the right-hand side what the value fed to FME will be.
Click OK and then OK again to close the remaining dialogs and create the user parameter.

5) Link Coordinate System Parameter
Now we have the user's selection, but we still have to apply it to the real parameter. So locate the writer’s coordinate system
parameter, right-click on it, and choose Link to User Parameter:

When prompted, select the newly created CoordSysParam and click OK to accept the selection. Now when the workspace is run
the user is prompted to select a coordinate system, and that system's short name value is passed to FME.

6) Create Tables Parameter
The final task for us here is to create a way to decide which tables are going to be read. If you remember, at the moment the way
your colleagues do this is by disabling various reader feature types. However, there has to be a better method.
This is an interesting task because we want to control the source tables (Libraries, Parks, etc.), but based on the selection of
destination tables (CommunityFacilities, Environment, and Miscellaneous).
For example, we want the user to select output feature types like "Environment", which needs both "Parks" and
"DrinkingFountains" reader feature types.
However, this we can do very easily. Firstly locate the Feature Types to Read parameter in the CommunityMap reader "Features to
Read" parameters (in the Navigator window):
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Right-click on it and choose Create User Parameter. A dialog will open that is already populated with a list of feature types:

Check the box that is labeled Use Alternate Display Name. This provides the ability to give alternative names for each feature
type. What we need to do is use this dialog to group common reader feature types together under a single display name.
Delete the entry for GarbageSchedule, as this data isn’t connected and is not needed.
Then, match the contents of the workspace by editing the Display Names. They should match as follows (the order is not
important):
Display Name

Feature Type

Community Facilities

Libraries

Community Facilities

CommunityCentres
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Environment

Parks

Environment

DrinkingFountains

Miscellaneous

FoodVendors

Miscellaneous

TransitStations

Miscellaneous

AccessibleParking

Underneath that change the prompt to read “Tables to Write” and then click OK to close the dialog.

What we have done here is set up a list of output layers to select from, with a list of input layers that each refers to.

7) Save and Run Workspace
Save the workspace. Then start up the FME Quick Translator application, located on the Start menu under the FME Desktop
Utilities folder. By using this tool, we'll ensure that the user is prompted for parameter values.
In there, select Run from the Getting Started menu:
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Browse to the newly saved workspace, select it, and click Open. You will be presented with a list of published parameters, just as
the end-user would see it:

Pick Unicode 8-bit (utf-8) as the encoding. Select a coordinate system, noting how the user is restricted to those chosen by us.
Select one or two of the tables to write and click OK to run the workspace.
The translation will be carried out. Inspect the data to ensure the results are correct. The CommunityFacilities – for example –
should be made up of both libraries and community centers.

Advanced Exercise
Speaking of Best Practice, don't forget to tidy up the workspace and give it a better style and structure!

CONGRATULATIONS
By completing this exercise you have learned how to:
Remove pre-linked parameters
Create a simple pre-linked parameter
Create a Choice with Alias user parameter
Use a Choice with Alias parameter to define coordinate systems
Manually link a user parameter to an FME parameter
Publish the Feature Types to Read parameter
Set up and use alternative names in the Feature Types to Read parameter
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Shared, Embedded, and Scripted Parameters
Shared and Embedded parameters are not specific types of parameters; instead, they refer to two different ways in which
parameters might be used.
Scripted parameters are a way to include Python or Tcl code in the way a parameter is defined.

Shared Parameters
There is no limit on the number of times a user parameter can be used or linked to an FME parameter. The value obtained from a
user parameter can be used as many times as is required.
When a parameter is used in two or more places, it can be described as a shared parameter.
For example, a workspace has a user parameter called TOLERANCE (here being used inside a Generalizer):

However, the workspace author has decided to apply the same parameter in three places in total; two Generalizers and a Clipper:

The advantage is that the same value can be used without the user having to enter it multiple times.

Embedded Parameters
Sometimes in FME, parameter values need to be constructed from multiple components. When one parameter is constructed so as
to include the value of another parameter inside it, this is called Embedding Parameters.
For example, here the name of a file is constructed from two user parameters: one is a fixed output path and the other is a user's
name:
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The technique is called embedding because the user parameters - UserName and OutputFolder - are embedded inside the FME
parameter (Target Filename).

Scripted Parameters
Scripted parameters go one step further than an embedded parameter. Instead of simple concatenation, a scripted parameter allows
a full Python or Tcl script to be used to construct a value.
For example, this Tcl script creates a filename from a fixed path and an embedded user parameter. However, in this case, the script
is used to test whether the workspace is being run on a Windows or Linux system, so that it can set the output path accordingly:
set realname ''
if {[string match 'C:*' $FME_MacroValues(FME_HOME)]} {
set realname 'C:\Output\'+$FME_MacroValues(UserFileName)
} else {
set realname '/Output/'++$FME_MacroValues(UserFileName)
}
return realname

Note that the script must include a return statement, to return a value to the parameter. A Scripted Parameter is purely for use by
an author. The user is not prompted for a value, as it would be absurd to expect them to enter Python code when a workspace runs!

Ms. Analyst says…
Use the ‘print’ command (in Python) or ‘puts’ command (in TCL) to write from the script to the FME log
file.
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Parameter Settings
When a user parameter is created two checkbox options exist; one is labeled Published and the other Optional.

Published Parameters
The purpose of this option is to expose or hide the parameter from the end user. If the Published box is checked, then the end user
is able to enter a value. If the box is unchecked, then they will not be prompted to enter a value, and the parameter will be treated
as "private".

Private Parameters have two uses.
Firstly a private parameter is a way for a workspace author to create a shared parameter without having it exposed to the user.
For example, if they want to supply the same tolerance value to several Snapper transformers – but the author, not the user, sets
that value – then a private parameter is used.
The second use of a private parameter is to embed a user's partial input into a larger parameter.
For example, here the workspace author prompts the user to enter a folder in which a file is to be written (1). The full folder path
is then defined by the author as a private parameter (2) as a mix of a fixed path and a job ID:
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Finally (3) the Private Parameter is embedded inside the FME Parameter for the destination Shapefile dataset.

Ms. Analyst says...
You might have noticed that there are a number of FME Server Parameters available to workspace
authors who intend to deploy their creation on an enterprise scale.
In fact, if you look at the above screenshot, you might notice that a Server parameter (FME_JOB_ID) has
been embedded into the FullPath private parameter!

Optional Parameters
The Optional checkbox tells FME whether the user parameter is compulsory or optional.
Here, for example, the DateTimeCalculator is being used to calculate the time a park closes, given its opening time and user input
on how many hours and minutes it is open:
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The MINUTES user parameter has a checkmark in the Optional setting, meaning it is not compulsory. For example, the user can
just enter that the park is open for eight (8) hours and ignore the MINUTES parameter.
Alternatively, a user parameter might provide a tolerance value to a Generalizer transformer. In this case, the author will want to
turn off this checkbox and make the parameter compulsory. A Generalizer that is not given a tolerance value will usually fail, and
making tolerance compulsory is one way to prevent that from happening.

Miss Vector says...
Tell me, is it possible to have a compulsory, private parameter? (i.e. both settings boxes are unchecked)
1. Yes
2. No
3. Yes, but you need to set a value immediately
4. Yes, but only for text or numeric parameters
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Parameters and Attributes
Sometimes an FME parameter is designed to accept either a fixed value or the value of an attribute. We call these parameters
_OR_ATTR parameters because they allow a value OR an attribute.
For workspace authors, it's also possible to define a user parameter to allow this. Specifically, a user parameter can allow either:
A fixed value only
A fixed value or an attribute
An attribute only
The first two of these capabilities are controlled by a setting in the user parameter called Attribute Assignment.

FME Parameters and Attributes
Some FME parameters - but not all - allow an attribute to be used in place of a fixed value. We call this Attribute Assignment:

When a user parameter is created or linked to one of these FME parameters, then it too picks up that capability:

So, this allows the end user to enter either a fixed value or to select an attribute that supplies the value.

Attribute Assignment and User Parameters
Attribute Assignment is important when an author creates a user parameter and has to decide whether to allow the end-user to
select an attribute or not.
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For example, here the workspace has an UpdatedBy field, and an AttributeManager transformer that sets UpdatedBy using a user
parameter where the user is prompted to enter their name:

When prompted the user can enter their name; but they can also select an attribute:

Obviously, this makes no sense. The author does not want the user to have the ability to select an attribute, only to enter a string.
The setting that lets the author control this is called Attribute Assignment, and is found on the parameter definition dialog:

267

User Parameters and Attributes

By changing this from Default to Off, the user is no longer allowed to select an attribute in the Translation Parameters prompt:

Ms. Analyst says...
You might now be wondering what "Default" means. You might think that we should just have Yes/No as
the options.
Well - as you saw above - not every FME parameter allows attribute assignment and making it a user
parameter will not change this. For example, the Snapper tolerance is never allowed attribute assignment.
Having a Yes/No option for a user parameter linked to it is pointless, because Yes is never allowed. That's
why we use the term "Default".
Of course, what this means is that where you apply the user parameter is important. Default means, the
default of where it is applied. If linked to an FME parameter that allows attribute assignment, then
Default will let the user pick an attribute. If linked to an FME parameter that doesn't allow attribute
assignment, then Default will not let the user pick an attribute.
And - because I know you are wondering - if it is shared and linked to both an FME parameter that allows
attribute assignment, and one that doesn't, then FME takes the safe option and disallows attribute
selection.

Attribute Name Parameter
So Attribute Assignment handles the case where you want the user to enter a fixed value, and you may also give the end user the
option to select an attribute.
However, the reverse case must also be handled: you don't want the user to be able to enter a fixed value, you only want them to
be able to select an attribute.
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For example, here an author is adding a label to the data:

The author wants to allow the user to select an attribute to provide the label, but not be able to enter text. In this scenario they
need to create a user parameter with a special type called Attribute Name:

After linking this user parameter to the LabelPointReplacer's FME parameter, when the workspace is run the user is permitted to
select an attribute and ONLY an attribute:

However!
There is a catch to this operation. The user parameter – as the type suggests – is merely returning an attribute name; it does not
return the attribute value.
If the workspace is run in this state then the LabelPointReplacer is supplied with the attribute name (not value) and uses it as the
label, like so:
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What the author must do is embed the user parameter name inside an FME Function to fetch the value of the attribute to which it
refers.
To do this, the author finds the LabelPointReplacer parameter and changes it (either directly in the FME parameter, or via the Text
Editor window) to be: @Value($(UserAttrSelection))
The @Value() function replaces the name of the attribute with its actual value:

Now when the workspace is run the output will be correct:
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Exercise 3

Grounds Maintenance Project

Data

Parks (MapInfo TAB)

Overall Goal

Parameterize and implement a translation log

Demonstrates

Creation and use of complex User Parameters

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex3-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex3-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex3-Complete-Advanced.fmw

In a previous project (in the FME Basic Desktop training) you created a project to transform parks data by calculating the size and
average size of each park.
The team who are using this now want to implement it on FME Server. At the same time, they want to improve some of the
functionality and implement a custom translation log.
As you created the original workspace, you are assigned to carry out these upgrades to your former work.
Set the output to write to a folder for that user
Ask whether to filter out dog parks
Ask which attribute to use to create labels
Create a translation log in CSV format

1) Start Workbench
Start Workbench and open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\Parameters-Ex3-Begin.fmw

You can see that the workspace reads some MapInfo parks data, filters out dog parks, calculates park area and average area,
creates labels, and writes out the data back to MapInfo.

.1 UPDATE
FME2018.1 has a new version of the AttributeManager transformer, with improved performance. If you
wish, right-click the AttributeManager and choose Upgrade Transformer to upgrade the transformer in
this workspace.

There are two existing published parameters - one for the source dataset and one for the destination:
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The source dataset will never change, and we are going to create a new parameter for the destination, so delete these two
parameters.

2) Add User Parameter
If we are going to write the output to a folder specific to the current user, we need to know who that user is.
So, next create a text format user parameter to ask for the user's name:

Ensure that the optional checkbox is unchecked; we want users to have to enter a value in here. Also, make sure Attribute
Assignment is Off because we don't want them to be able to select an attribute.

3) Add User Parameter
There are various ways we can implement the requirements here; we'll do the version that involves sharing user parameters.
So, create a new user parameter of type Folder (Output). Uncheck both of the Published and Optional fields; i.e. it will be a
private parameter for us to use (not the end user) and it will be required.
Set the Name field to something like OutputFolder and for the Value browse to C:\FMEData2018\Output\Training

273

Exercise: Grounds Maintenance Project

Set Attribute Assignment to Off, although it doesn't really matter because this will be a private parameter anyway.

Dr. Workbench says...
Technically, we could use a text-type parameter. The only benefit of a folder parameter is it lets us browse
to the location. But since it's a private parameter that the user will never see, it doesn't really matter.
Anyway, both methods will meet our requirements.

4) Set Output Location
Now let's use the two parameters we've created.
NB: First ensure you deleted the two existing source/destination user parameters in step 1, else this step won't work!
Locate the FME parameter for Destination MapInfo Folder in the Navigator window and double-click it to open the editing
dialog.
In that dialog manually enter:
$(OutputFolder)\$(Username)

Alternatively, use the text editor where you can add these by double-clicking, to reduce the chance of error.
You've basically concatenated/embedded the two user parameters into the FME parameter.
When you run the workspace, you will be prompted to enter your name, and then the output data will now be written to
C:\FMEData2018\Output\Training\<Username>

Dr. Workbench says...
There are various ways we could have done this. We could have set the OutputFolder parameter to
C:\FMEData2018\Output\Training\$(Username) and then linked it to the FME Destination MapInfo
parameter. You'll see in a moment why we didn't do that!

5) Add User Parameter
The next task is to check whether dog parks are required in the output. The Tester transformer in the workspace shows that an
attribute (DogParks) has a value of Y or N to denote its status. We need to ask the user and add their decision to the Tester.
Now create a new user parameter. It will be a Choice type parameter that is not optional:
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Set it up to be a simple Yes/No question of whether to include dog parks in the output. Turn off Attribute Assignment because again - we don't want the user to be able to select an attribute.

6) Update Tester
To use the DogParks parameter open up the Tester parameters dialog. Add a second test clause:
$(DogParks) = Yes

Now when the workspace runs, if you choose not to keep dog parks they will be filtered out from the workspace. This concept - of
directing features depending on the value of a user parameter - is a very useful one to be aware of.

7) Add User Parameter
OK. Next task is to allow the user to pick which attribute to use for a label.
As noted in the previous section of training, if we just publish the label parameter in the LabelPointReplacer the user will be able
to enter text as well as select an attribute. We want them to have to select an attribute and not to be able to enter text.
So, create a new user parameter of type Attribute Name. This one can be optional, as the user failing to select an attribute is
equivalent to saying "no labels required":
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Dr. Workbench says...
Click the run button and see what appears in the list of prompts; you should see a parameter to Select the
Label Attribute. But look! The parameter shows "No Attributes Available". Why is this?
This is because the list of available attributes depends on where the parameter is used. Since we have not
used the parameter yet, no attributes are available!
Similarly, if we used the parameter in a location where we have attributes A and B, and also in a different
location with attributes B and C, the only attribute available to the parameter is B. That's because a
parameter of this type will only show attributes that exist in all places that it is used.

8) Update LabelPointReplacer
To use the LabelAttribute parameter inspect the LabelPointReplacer parameters.
Remember (again from the previous section) that we can't just apply this user parameter to the Label FME parameter. That would
just return the name of the attribute; we want the attribute value.
So in the Label parameter manually enter (or open the text editor and enter):
@Value($(LabelAttribute))

Now when the workspace runs you are also prompted to select an attribute with which to label the parks. If you choose no
attribute, no labels are created (just point features).

9) Add Log Writer
The final task is to create a CSV format translation log. That is not too difficult to do.
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Use Writer > Add Writer to add a new CSV format writer with the following setup:
Writer Format

CSV (Comma Separated Value)

Writer Dataset

C:\FMEData2018\Output\Training

Writer Parameters

Overwrite Existing File: No
Write Field Names Row: If Writing First Row

Add Feature Type(s)

CSV File Definition: Manual...

When you click OK, the dialog will open for you to define the table schema.
On the General tab set the CSV File Name as TranslationLog:

In the User Attributes tab, define the attributes User and Date:

Click OK to close the dialog.

10) Connect Feature Type
We need a single record to trigger this feature type; but only one feature, else we will get multiple records.
Place a Creator transformer down and connect it to the TranslationLog feature type:
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11) Set Output Folder
We should set the output location for the log to be relative to where the user files are being written.
So, locate the destination dataset parameter for the CSV writer, right-click on it and choose Link to User Parameter:

When prompted select the OutputFolder (private) parameter that we created earlier.

Dr. Workbench says...
You might be wondering what the point of that last part was. Why did we link the parameter when both
were pointing to the same folder already?
The point is that now the MapInfo and CSV writers share a parameter defining their output folder. If we
wish to change where they are being written to (say when the path changes from FMEData2018 to
FMEData2019), we only need to edit the private parameter to fix both writers. That's why we did what we
did in step #4.
If you don't believe me, try it and find out for yourself!

12) Set User Attribute
The very last step here is to provide values for the User and Date fields of the translation log (CSV writer).
Right-click on the attribute called User on the feature type and choose the option to Edit Value:
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In the dialog that pops up enter $(Username) for the value (you'll be prompted to select it as soon as you start to type):

This is another example of sharing user parameters. This parameter is now used here and in the MapInfo writer name.

13) Set Date Attribute
Now - to provide a value to the Date attribute - repeat the above step for the Date field, but this time entering the DateTimeNow()
function instead of a user parameter:

We are done! Save the workspace and then run it!
You should find your choice of data (with or without labels) written to a folder under your name, and a record of the translation
added to the CSV file in the main folder.

Advanced Exercise
If you have time for one more task, why not add a transformer to round the ParkArea and
AverageParkArea attributes and create a user parameter to control how that rounding occurs? You can
choose any type of parameter you think would be best for allowing the user to select the number of
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decimal places to round to. It could be a Choice parameter, a Choice with Alias parameter, a Number
parameter, or something else.
You could also expand on the information that is written to the CSV log file; for example add the build of
FME used in the translation, which is available as a parameter called $(FME_BUILD_NUM).

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a user parameter that is not optional
Create a private user parameter
Create a Folder type user parameter
Control Attribute Assignment for a user parameter
Embed/Concatenate user parameters inside an FME parameter
Create a choice type user parameter
Use a user parameter in a Tester transformer to redirect features
Create and use an Attribute Name user parameter
Share a user parameter by using it in multiple locations
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Module Review
This chapter looked at User Parameters and some of the more advanced techniques involved in their use.

What You Should Have Learned from this Module
The following are key points to be learned from this session:

Theory
FME is used by both workspace authors and end-users. In general, authors make use of FME Parameters; end-users make
use of User Parameters.
User parameters accept user input that can be used within a workspace
User parameters can be linked to FME parameters as an indirect form of control
Many types of user parameters exist to allow the user to enter different types of information in a controlled way
Parameters can be shared to reuse their content in multiple places
Parameters can be embedded or scripted to construct complex values from a simple input
Parameters can be made to accept fixed values, attribute values, or both

FME Skills
The ability to use FME parameters and to create user parameters
The ability to extract information from user parameters and/or link user parameters to FME parameters
The ability to use complex parameter types such as Choice with Alias, or Attribute Name.
The ability to use shared, embedded, and private parameters
The ability to accept fixed values only, or attribute values only

Further Reading
For further reading why not browse articles relating to Published Parameters on our blog?
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Who are our two roles of FME user?
1. Creator/Inspector
2. Author/User
3. Reader/Writer
4. Maker/Consumer

Miss Vector says...
Look at the ParameterFetcher transformer. What does it do?
1. Fetches the name of a user parameter
2. Fetches the value of a user parameter
3. Fetches the type of a user parameter
4. Fetches the user a cup of tea
Of course, in most cases, you can easily use the AttributeManager instead.

Miss Vector says...
Which of the following is NOT a valid parameter type?
1. Coordinate System Name
2. Password
3. String Encoding
4. URL

Miss Vector says...
If you – as the workspace author – don’t want or require the end-user to have access to pre-linked
parameters, then what can you do?
1. Delete the Reader/Writer
2. Unlink the user parameter
3. Delete the FME parameter
4. Delete the user parameter
The user parameter does not have an unlink option, and FME parameters cannot be deleted, so you would
delete the user parameter. You could choose unlink on the FME parameter - but that would automatically
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delete the user parameter anyway!

Miss Vector says...
Is it possible to have a compulsory, private parameter? (i.e. both settings boxes are unchecked)
1. Yes
2. No
3. Yes, but you need to set a value immediately
4. Yes, but only for text or numeric parameters
Yes, you can have a private, compulsory parameter - but when you uncheck both boxes the default value
field turns red and requires an immediate value.
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Custom Transformers
Custom Transformers are very powerful tools at either a basic or an advanced level.

What is a Custom Transformer?
A custom transformer is a sequence of standard transformers condensed into a single transformer. Any existing sequence of
transformers can be turned into a custom transformer.

This MeasureInterpolator is a custom transformer available on the FME Hub.

Custom Transformer Purposes
Among other functions, custom transformers help to:
Reuse Content
A sequence of transformers encapsulated in a single object can be reused throughout a workspace and shared with
colleagues.
Employ Advanced Functionality
Using a Custom Transformer enables additional functionality to be used, such as looping and parallel processing
Tidy Workspaces
By condensing chunks of content, the workspace canvas becomes less cluttered but this is of less importance with the
use of collapsible bookmarks

First Officer Transformer says…
Welcome aboard this Safe Software training chapter on Custom Transformers. I’ll be your guide to all of
the functionality involved. As you can see, Custom Transformers are excellent tools for carrying out Best
Practices in FME, both speeding up your projects and reducing turbulence in the Workbench canvas.

Creating a Custom Transformer
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A Custom Transformer can be created from scratch – i.e. you start with an empty custom transformer and add content into it – or
can be created from an existing sequence of transformers.
Custom transformers are created by either selecting Create Custom Transformer from the canvas context (right-click) menu or by
selecting Transformers > Create Custom Transformer from the menubar. The shortcut key for this function is Ctrl+T.

If a number of existing transformers are selected when you issue the Create Custom Transformer command, then they are
automatically added to the new custom transformer; otherwise, the new custom transformer is created empty except for an input
and output port.
Here a user is creating a new custom transformer based on a series of existing ones:

The new custom transformer will be pre-populated with these four transformers.

Naming a Custom Transformer
All Custom Transformers require a name and (optionally) a category and description. A dialog in which to define these
automatically appears when you create a new custom transformer.
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The category can be set to match any existing category of FME transformers or a custom category of your own.
Notice also the “Use Extended Description” parameter. This allows you to enter extra information about the custom transformer,
such as requirements for use, development history, and legal terms and conditions; in fields that support the use of rich text.

These fields are particularly important when you intend to share the custom transformer with work colleagues or clients.

The New Custom Transformer
A newly created custom transformer then looks like this:

Notice that it appears under a new tab on the Workbench canvas and consists of the original transformers with additional input and
output objects.
When you click on the Main tab, to return to the main canvas view, the original transformers have now been replaced by a custom
transformer object that is automatically connected to the existing workspace:

This custom transformer looks and behaves in the same way as any standard FME transformer; with input and output ports (that
match the input/output objects in the custom transformer tab), plus a parameters dialog.
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Editing a Custom Transformer
To edit the contents of a custom transformer, simply click on the tab for that transformer. This opens the transformer definition
and you may edit the content in the same way that you would in the main canvas.
In the Navigator window, where a workspace would have a section labeled Workspace Parameters, a custom transformer has
Transformer Parameters:

This is where the information – name, category, description, etc. – that was entered earlier can be edited.

First Officer Transformer says…
If a custom transformer has been created from scratch, without any original transformers selected, it
would start out empty and look like this:

Then you can start building or editing the transformer from scratch. There is not a lot of difference
between creating content in the main canvas and turning it into a custom transformer, and creating an
empty custom transformer and creating the content in there.
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Using Custom Transformers
Once a custom transformer has been created, it is connected to the workspace and - apart from a different color - looks just like a
normal FME transformer would.
However, the resemblance to a normal transformer is not just in appearance. In the same way that multiple instances of a
transformer can be used in a workspace, a custom transformer can be used any number of times too. This makes Custom
Transformers not just a way to tidy a workspace, but also as a way of re-using content.
To place extra copies of a custom transformer - again like a regular transformer - you use the Transformer Gallery (look under a
section labelled “Embedded Transformers):

...or you can use Quick Add:

As with FME transformers, each newly placed instance of a custom transformer will be renamed (or numbered) as necessary, in
order to avoid a clash of names.

TIP
The transformer name, category, and description all appear in the Quick Add tool - as well as appearing
in the help window - so it is definitely worthwhile setting these parameters.

Editing a Re-used Custom Transformer
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Multiple instances of a custom transformer all use the same core definition; i.e. there may be multiple copies on the Main tab, but
only a single tab for the custom transformer definition.
A key benefit of this approach is that every instance can be updated or edited simply by editing the custom transformer definition.
For example, if a parameter is changed for the Aggregator inside this custom transformer:

...then the parameter automatically changes for ALL instances of the transformer that have been placed.
This makes the editing of a sequence of transformers much easier because the edit only needs to be made once, no matter how
many times that sequence has been used.
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Exercise 1

Creating a Custom Transformer

Data

Neighborhoods (Google KML)

Overall Goal

Create a custom transformer out of a workspace

Demonstrates

Basic custom transformer creation

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex1-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex1-Complete.fmw

A colleague - new to FME - has created a workspace that calculates the population density for neighborhoods in the city of
Vancouver, and comments that this technique could be reused for other projects.
You mention custom transformers as a way of doing this and will now demonstrate to her how to turn this workspace into a
general solution that calculates the average density of items in a known space.

1) Start Workbench
Start by opening your colleague's workspace: C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex1Begin.fmw
You may wish to run the workspace and examine the output to see what it does and how it works. Basically, it calculates the
population density (persons per square kilometer) for the years 2001 and 2011:

2) Create Custom Transformer
The key components for the custom transformer are the AreaCalculator and ExpressionEvaluator transformers. If you examine the
workspace you’ll see two ExpressionEvaluators (one for the year 2001, one for 2011) but we don’t need to include both in the
custom transformer.
So select the AreaCalculator transformer and ExpressionEvaluator_2001 (the first ExpressionEvaluator), right-click on them, and
choose the context menu option Create Custom Transformer (or just press Ctrl+T).
In the Create Custom Transformer dialog enter a name, category, and description for the new custom transformer. A good name
for the transformer will be the DensityEvaluator.

First Officer Transformer says…
You can’t call it the DensityCalculator; FME already has one of those!

Be sure the Attribute References parameter is set to “Handle with Published Parameters” (more on that later) and click OK:
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The custom transformer will now be created.

3) Inspect Custom Transformer
Flip back and forth between the DensityEvaluator tab and the Main tab to see how the custom transformer is constructed, and how
it is placed in the workspace itself.

Back in the Main tab, inspect the parameters for the custom transformer.
The main parameter is one created automatically by FME to accept the attribute to be processed. You'll see it is automatically
preset to the TotalPopulation2001 attribute.

4) Run Workspace
Save the workspace and then run the workspace, to ensure the output has not changed. However, note that this is just the start of
this custom transformer, and we should tidy it up (make it more generic) before trying to reuse it in other scenarios.
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Miss Vector says…
Why do you think that we left the CSMapReprojector transformer out of our custom transformer? Any
ideas?

CONGRATULATIONS
By completing this exercise you have learned how to:
Create custom transformers from a sequence of existing transformers
Handle attribute references automatically in a custom transformer
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Custom Transformer Input/Output Ports
Again, like a normal FME transformer, a custom transformer has a number of input and output ports:

These input and output ports are defined by input/output objects in the custom transformer definition itself:

Renaming Ports
The first thing to know is that these input/output objects can be renamed, in order that the transformer ports get named
appropriately. You can either double-click the object, choose Rename from the context menu, or press F2, in order to rename the
object.
For example, here the user is renaming an input port from StringConcatenator_Input to simply Input.

Renaming the input and output ports is useful for making the custom transformer object more legible, and for helping the user to
understand what data is supposed to connect to the port.
For example, after editing the transformer might look like this:
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First Officer Transformer says...
Here the user has simply renamed the ports to Input and Output. However, renaming the input port to
"Strings", "Lines", or "Raster" (for example) help guide other users of the transformer as to what data is
required as input.
Likewise, the output port could be renamed to illustrate the type of data that will emerge; for example
"Contours", "Labels", "Concatenated", etc.

Adding or Removing Ports
Besides renaming ports, it is also possible to add new ports to a custom transformer.
To do so simply click the tab to display the custom transformer’s definition and select Transformer Input (or Output) from either
the canvas context (right-click) menu or the menubar:

For example, here a user has added ports to handle two streams of input data and has two output ports (one for the required output,
another that handles "bad" features:
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This means that each instance of the custom transformer in the main canvas will now have an extra input port, like so:

Miss Vector says...
Here are some questions for you.
Q) Which of these is NOT a reason to use Custom Transformers?
1. To make my content available in Quick Add
2. To use advanced functionality like looping
3. To reuse chunks of content in a simple way
4. To tidy and declutter the main workspace canvas
Q) Consider this section of workspace. If I select the three transformers highlighted with arrows, and
create a custom transformer, how many input and output ports will it have by default?

1. One Input and One Output port
2. One Input and Two Output ports
3. Two Input and Two Output ports
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4. Two Input and Three Output ports
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Exercise 2

Editing a Custom Transformer

Data

Neighborhoods (Google KML)

Overall Goal

Make use of a custom transformer created out of a workspace

Demonstrates

Basic custom transformer re-use and editing

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex2-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex2-Complete.fmw

A colleague - new to FME - has created a workspace that calculates the population density for neighborhoods in the city of
Vancouver, and comments that this technique could be reused for other projects.
We've turned her workspace into a custom transformer as a way of doing this and now need to show how to use it multiple times
and apply edits to its definition.

1) Start Workbench
Continue with the workspace from exercise 1, or open the workspace:
C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex2-Begin.fmw

2) Duplicate Custom Transformer
Notice that we started with two ExpressionEvaluators and now have one ExpressionEvaluator and one custom transformer. Let's
place another instance of the custom transformer in place of the ExpressionEvaluator.
Click on the ExpressionEvaluator_2011 and press the delete key to delete it.
Click on the DensityEvaluator custom transformer and press Ctrl+D (or right-click > duplicate) to create a duplicate copy of it.
This is the same effect as placing a new instance, but quicker. You could do the same task through Quick Add or the Transformer
Gallery if you desired.
Connect the second DensityEvaluator into the workflow, in parallel and not in series:

3) Set Custom Transformer Parameters
By creating a second instance of the custom transformer we've started to re-use our content, which is great. However, the second
instance is currently processing the wrong data.
Inspect the parameters for the second DensityEvaluator and set the population parameter to TotalPopulation2011 (not 2001):
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4) Run Workspace
Run the workspace and inspect the output to ensure the data is being processed correctly.
One obvious problem with the output from the transformer is that the result is put into an attribute called PopulationDensity2001,
regardless of what data is being processed.
This is not useful; for example, the 2011 results also get the same name, as would any other scenario where we used this
transformer. We should improve this by making the output name more generic.

5) Edit Custom Transformer
Click on the tab labeled DensityEvaluator to switch the canvas to the custom transformer definition. Inspect the
ExpressionEvaluator_2001 parameters. Change the Transformer name to ExpressionEvaluator since we are processing more than
just 2001 data. Then change the name of the New Attribute parameter to DensityResult:

If you run the workspace again you’ll notice that DensityResult is the attribute output by both instances of the custom transformer;
i.e. one edit has fixed both of them!

6) Rename Ports
One other edit we ought to make is to the port names of the custom transformer. At the moment they are not very elegant.
Still, within the DensityEvaluator tab, click the input port object in the custom transformer definition (currently labeled
AreaCalculator_Input). Inspect its parameters and change the name to Input.
Now repeat the process for the output port object, renaming it to Output.
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Click the Main tab to check back on the main canvas and confirm the changes have been made:

CONGRATULATIONS
By completing this exercise you have learned how to:
Use multiple instances of a custom transformer
Make a custom transformer generic for use anywhere
Rename output ports in a custom transformer
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Custom Transformers and Schema
Schema Handling is one of the most misunderstood components in Custom Transformers. That's because there are consequences
that arise from allowing the re-use of content, and these consequences are not always apparent to the workspace author.
In brief, the ability to re-use a custom transformer means that it might be used in places where the schema does not match the
custom transformer design.

First Officer Transformer says...
The best analogy I can come up with is this: I have a laptop computer. I can use it at home and in the
office. I can also use it overseas. The difference in power supply (110v against 240v) was considered by
the manufacturers and the computer will work on both. It's well designed.
In much the same way, the author of a custom transformer must be aware of the limitations that might
apply if it is used outside of its expected area, and try to adapt to them. Schema is a key consideration.

Handling Attribute Schema
One part of the schema to be considered is the set of attributes available to the custom transformer.
For example, in this workspace a custom transformer carries out processing on incoming data using an attribute called AddressID
as a key field:

However, if that transformer is duplicated and used elsewhere, there is no guarantee that AddressID will exist:
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These cases are both flagged red as "incomplete"; the first schema has ADDRESSID (not AddressID) and the other
AddressUUID. Without FME's help, the end user would need to edit the transformer definition to fix these.
Therefore it’s vital that there is some form of mechanism for protecting against problems of a mismatched schema of this type.
In fact, there are two ways this can be handled: FME can automatically take care of the schema, or the workspace author can
handle it manually.
Before looking at those solutions, let's take a look at a similar problem...

Handling User Parameters
Besides attributes, the other part of the schema to be handled is user parameters.
Here, for example, a LabelPointReplacer transformer has user parameters to allow user input for label content and height:

Now let's assume that LabelPointReplacer is incorporated into a custom transformer, and that transformer used in several places in
a workspace:

There's no problem with attributes because the transformer isn't using any.
But both instances of the custom transformer are using the same user parameter, and perhaps the user doesn't want to enter the
same value for each instance. We need a mechanism for the user to enter different values.
As with attribute schema, there is an automated method for handling these; you just need to be aware of it in order to make some
adjustments.
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Automatic Schema Handling
Let's look at how we can handle the schema complications that might arise if a custom transformer is reused.

Automatic Handling of User Parameters
To take the handling of user parameters first, when a transformer with a published parameter is incorporated into a custom
transformer, the published parameter is automatically moved from the main workspace to the custom transformer.

This means that the user is no longer prompted for these when the workspace is run! But... those parameters instead become
available on the Custom Transformer itself:

That way the parameters can be set differently for each instance of the custom transformer. If user input is required at run-time,
then these new parameters can be published themselves - and shared if you want them all to have the same value.

Automatic Handling of User Attributes
Now let's look at how attributes are handled. When a custom transformer is created, one of the parameters in the Create Custom
Transformer dialog is labeled Attribute References:
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"Handle with Published Parameters" is the automatic way of handling attribute references in the custom transformer. It makes sure
that every attribute referenced within the custom transformer is supported outside of the transformer definition.
It does that by creating a published parameter for each attribute:

...and then using that instead of the attribute reference:

Now, when this transformer is used in a place where the schema doesn't match, the transformer will still be flagged red as
"incomplete". However... the user can use that published parameter to select an attribute that is available.
So (in the above) if AddressID is not available, the user can select ADDRESSID or AddressUUID instead.

First Officer Transformer says...
Referring to my previous analogy, without an adapter I would need to manually open up my laptop's
power supply, and rewire it with a new plug, in order to use it overseas.
However, this FME solution is like an adapter with a dial I just have to turn to the correct country setting.
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This illustrates how FME has automatically solved the attribute reference problem using published parameters. To make the
custom transformer more generic, the workspace author can change the prompts on these parameters; for example, change the
prompt from "AddressID" to "Select an ID Attribute to Process".

Miss Vector says...
What do you think would happen if you changed the parameter from "Handle with Published Parameters"
to its other possible value, "Fix Manually (Advanced)"? Pick as many of these answers as you think are
correct:
1. The workspace won't run by default because no attributes are available in the custom transformer
2. There will be no way to pick attributes to use from the main canvas
3. The author will need to manually fix the custom transformer by exposing attributes in its definition
4. The custom transformer won't work on a different schema unless the exposed attributes are also
published
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Post-Creation Schema Handling
As we know, custom transformers can be edited after creation.
The "Handle with Published Parameters" setting handles attributes used in a custom transformer only when it is created. There
also needs to be a mechanism for handling future edits to a custom transformer (or where the custom transformer is simply created
from scratch).

Handling Incoming Attributes
Attributes entering a custom transformer are handled using a setting inside the transformer definition.
As an example, an author puts a StringConcatenator inside a newly created custom transformer. The author wishes to concatenate
AddressID and PostalCode.

AddressID is available in the custom transformer because it was being used when the custom transformer was created (and Handle
With Published Parameters was set).
However, PostalCode is not available. It was not being used when the custom transformer was created.
Therefore the author must expose that attribute. They do so by inspecting the parameters for the Input port, where they are able to
specify other incoming attributes to expose:
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Now PostalCode becomes available to the StringConcatenator and, additionally, made into a user parameter so that back on the
main canvas the custom transformer can accept a different attribute selection should PostalCode not be available.

Handling Outgoing Attributes
Besides incoming attributes, there is also the question of what attributes should emerge from the output of a custom transformer.
Best Practice suggests that we shouldn't output more attributes than are expected by the user. We should hide or remove any
attributes that are part of a calculation, or any attributes that are otherwise generated inside the custom transformer but aren’t
necessary to the output.
Here a custom transformer is calculating the average area of a number of polygon features. It has renamed ports and a specific
output port to deal with bad features, but it is outputting more attributes than are useful:

The workspace author should clean up this output. They can do this by visiting the custom transformer definition, viewing the
output port object, and there choosing which attributes are to be output:
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The Attributes to Output setting gives the option of outputting all attributes, or only those that have a checkmark next to them, as
above.
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Exercise 3

Custom Transformers and Published Parameters

Data

Neighborhoods (Google KML)

Overall Goal

Edit a custom transformer to use published parameters

Demonstrates

Published parameters and custom transformers

Start
Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex3-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex3-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex3-CompleteAdvanced.fmw

A colleague - with our help - has created a custom transformer that calculates density for a particular area. However, we need to
work on it further to make it more generic - and to expand its capabilities.
This transformer was created using the automatic schema handling parameter and the workspace will already be handling schema
properly. So, to an extent we don't have to worry - but there are improvements we can make.

1) Start Workbench
Continue with the workspace from exercise 2, or open the workspace:
C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex3-Begin.fmw
Notice that, currently there are two instances of the custom transformer. Both produce an attribute with the same name
(DensityValue). It would be helpful if the user of the custom transformer could define what the name of that attribute should be.
Let's set up the transformer to allow that.

First Officer Transformer says...
This is why - so far - we've had the two transformers in parallel streams. If we had them in series in the
same stream then the results of the second custom transformer would overwrite the results of the first.

Click on the tab labeled DensityEvaluator to switch the canvas to the custom transformer definition. Inspect the parameters for the
ExpressionEvaluator. Next, to New Attribute (DensityResult) click the down-arrow and choose User Parameter > Create User
Parameter:
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When prompted, click OK to accept the default settings. Return to the main tab and check the parameters for each custom
transformer instance. There should be the option to set the name of the attribute to output:

You can now move the instances so they are joined in sequence (rather than parallel) and change the two output attribute names to
something different (PopulationDensity2001 and PopulationDensity2011):

First Officer Transformer says…
At first glance it might appear that we've simply reverted the custom transformer right back to where we
started from. To an extent, that's true. However, the point is that we've now got a solution that can work in
other scenarios (i.e. where something other than population density is being calculated).

2) Set Parameter Prompts
Looking at the custom transformer parameters we can also see that the prompt for the attribute to analyze is called
"TotalPopulation2001". Obviously, this is not very generic.
Return to the DensityEvaluator tab and browse the Navigator window to find the related published parameter. Right-click on the
parameter and choose Edit Definition.
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In the dialog that opens set the parameter Name to DensityAttribute and the Prompt to Attribute to Analyze:

Click OK to close the dialog. Return to the Main tab and check the custom transformer parameters to prove the label change
worked, and run the workspace to show that the output is still correct:

First Officer Transformer says…
It's because we chose to handle schema automatically that we can simply change this user parameter
name and not worry about where it is used. FME will handle the name change wherever is necessary.

3) Implement Units Selection
At the moment this workspace is calculating the number of items (in this exercise, persons) per square kilometer of land. This
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works for the original scenario, however, other uses of this transformer might find different units to be more useful.
Therefore we’ll implement a parameter for users to be able to select their units of choice.
In the DensityEvaluator tab, browse the Navigator window and right-click on the entry labeled User Parameters. Select the Create
User Parameter option.
In the Add/Edit User Parameter dialog, set the following parameters:
Type

Choice with Alias

Name

DensityUnits

Prompt

Density Units:

Uncheck the checkbox parameter labeled Optional because the user has to select a value.

Now click the [...] button to the right of the Configuration parameter. This opens a dialog in which to define choices for the user to
select from. Make two entries into this dialog
Display Name

Value

Sq Meters

1

Sq Kilometers

0.000001

To save you counting, that's five zeros after the decimal place:

Click OK to close that dialog.
Back in the Add/Edit User Parameter dialog set:
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Attribute Assignment

Off

Default Value

Sq Kilometers

Then click OK to close this dialog and add the published parameter.

First Officer Transformer says…
Feel free to add any other units that you want. The units for this coordinate system are in metres, which is
why that has a value of 1. So other units would need to be a fraction of that; for example, square miles
would be 0.0000003861.

4) Implement Parameter
Now we’ve defined a published parameter that the user can set the units with, but we still have to apply it in the custom
transformer.
Inspect the parameters for the AreaCalculator transformer. For the Multiplier field, click the drop-down arrow and select the
newly defined user parameter, DensityUnits:

Back in the main canvas the custom transformer now has a parameter for the end user to select the output density units:

Experiment by running the workspace using different units, to prove that the changes were implemented properly. Notice that,
because Attribute Assignment was set to "Off" that the end-user isn't able to select an attribute.
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Advanced Exercise
Although it’s not needed for this population density calculation, another useful function for this
transformer would be the ability to apply a weighting to the density calculations. If you have time, carry
out the following steps to set it up.
The weighting will come from an incoming attribute, which means we need to be able to handle this in the
custom transformer’s schema.

5) Add RandomNumberGenerator
Our source data doesn't have any fields we could reasonably use for weighting the output. Therefore return to the Main canvas tab
and add a RandomNumberGenerator transformer in order to generate a test attribute:

Inspect the parameters dialog for the RandomNumberGenerator and, for the purposes of this exercise, set:
Minimum Value

0.1

Maximum Value

1

Decimal Places

1

Result Attribute

WeightedAttribute

6) Expose Attribute in Custom Transformer
Now we have an attribute we need to expose it in the custom transformer, in order to use it.
Return to the DensityEvaluator tab where the transformer is defined. Inspect the parameters for the Input port object. Put a
checkmark against the WeightingAttribute attribute:
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This will cause the attribute to be exposed in the custom transformer definition.
It will also cause a user parameter to be created. Locate the parameter in the Navigator window (it should be called
WEIGHTEDATTRIBUTE) right-click on it and choose Edit Definition.
Put a checkmark in the Optional field, as this should not be compulsory (the user might not have an attribute to weight the results
by):

7) Duplicate ExpressionEvaluator
Now we can use the attribute inside the custom transformer.
Make a duplicate copy of the existing ExpressionEvaluator and connect it in parallel to the current one. Then put a Tester in
beforehand where the Passed port goes to one ExpressionEvaluator and the Failed port goes to the other:
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8) Set up Tester
Inspect the Tester parameters and make a test for where WeightedAttribute > 0

9) Adjust Equation
Now that the attribute is exposed in the custom transformer, we can use it in the equation for calculating density. Inspect the
parameters for the ExpressionEvaluator transformer connected to the Tester:Passed port.
Change the equation to:
@Value(TotalPopulation2001)/(@Value(NeighborhoodArea)*@Value(WeightedAttribute))

i.e. multiply the existing NeighborhoodArea attribute by the WeightedAttribute and place parentheses around that part of the
expression.
Save the parameter changes and run the workspace to check the result. Remember – the results will be different every time
because we’re generating the weighted attribute randomly at runtime!
Experiment selecting the weighted attribute in the main canvas, and not selecting it. When no attribute is selected then the features
should pass through the Failed port and no weighting is used in the calculation:

First Officer Transformer says…
It may seem odd – especially to experienced users – that we would use the attribute in the expression, and
not the published parameter. But this is all part of how FME handles this behavior automatically. It avoids
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the author needing to know about published parameters and how to use them, and uses hidden
functionality to replace the attribute with the published parameter wherever necessary.

CONGRATULATIONS
By completing this exercise you have learned how to:
Publish an FME parameter inside a custom transformer
Create a new user parameter inside a custom transformer
Expose attributes inside a custom transformer
Use an exposed attribute inside a custom transformer
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Custom Transformer Types
There are two types of custom transformers.
An embedded transformer is one that exists only in the workspace itself. Its definition is stored (embedded) inside the workspace
file, and it is not available to any other workspace.
A linked transformer is one that exists outside of a workspace. Its definition is stored in its own file, and it is available to any
other workspace, which references it through a link.
On a workspace canvas, embedded transformers are identified by their green color, while linked transformers are colored cyan:

First Officer Transformer says…
It's important to know that the transformer type can be changed inside the workspace. You can switch an
embedded custom transformer from being embedded to being linked, and switch a linked custom
transformer to being embedded.

Linked vs. Embedded Transformers
Both types of transformers can be used in an FME workspace, and there are various advantages and disadvantages to each type.
Embedded Transformers
Embedded transformers are perhaps easier to understand, need no external files, and their definition is embedded into the
workspace. They are particularly useful for tidying a workspace but also work for employing advanced functionality like parallel
processing.
However, sharing and re-use of content are not as simple with an embedded transformer. The custom transformer cannot easily be
shared with other users, unless they are given a copy of the same workspace, and it is not easy to maintain a consistent definition
among several users.
Linked Transformers
Linked transformers are perhaps a little harder to understand and manage. They exist as a file (.fmx) outside of the workspace,
which is less convenient, and when used to employ advanced functionality such as loops they can be more complex.
However, a linked custom transformer is a little easier to edit (you open the .fmx file rather than the .fmw file) and is much easier
to share among users. Not only can the file be given to any FME author to use, but any number of authors can actually point their
FME to the same custom transformer file.
Sharing the same file is useful because any changes made to the definition are automatically propagated to all workspaces that use
it.
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First Officer Transformer says…
Like embedded transformers, linked transformers also show up in the transformer gallery and Quick Add
dialog. Also notice that they have a special icon to signify that you are about to use a linked version,
rather than the embedded:

319

Creating Linked Transformers

Creating a Linked Custom Transformer
All custom transformers start out as an embedded version. To create a linked version the custom transformer is exported from the
workspace.
This is easily done by clicking on the canvas tab for the embedded definition and choosing File > Export as Custom Transformer
from the menubar:

First Officer Transformer says…
It’s best to debug your custom transformers before exporting them because the Run with Breakpoints tool
does not work inside exported transformers, only embedded.

At this point a dialog opens in which you can confirm the transformer name and category, plus some other parameters including
the save location:
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Let's look at some of the different options:

Name and Category
It's obvious what these are - the same fields as when the transformer was originally created - but it's interesting to note that you
can save it with a different name/category to what was used for the original version.

Insertion Mode
The Insertion Mode parameter specifies how the custom transformer can be used. It is an important parameter when I am the
author of a custom transformer, who has created it for other workspace authors to use.
There are four different modes:

If I export my custom transformer in Embedded mode, it means that an author who uses this transformer in his workspace finds it
gets embedded (rather than a link to a file).
If I choose Embedded By Default, it means that the author can choose to make the transformer linked instead. If I choose
Embedded Always it means that the author is stuck with using that custom transformer in embedded mode.
Similarly, if I export my custom transformer in Linked mode, it means that an author who uses this transformer in his workspace
finds it gets linked to a file (rather than embedded).
If I choose Linked By Default, it means that the author can choose to make the transformer embedded instead. If I choose Linked
Always it means that the author is stuck with using that custom transformer in linked mode.
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Which Mode to Use
Embedded Always is a good choice when the person using the transformer is less experienced with FME; it's easier for them to
manage and if they make changes they won't affect other people. Embedded is also a good choice where the custom transformer is
intended for use by individuals (i.e. not sharing it as a group).
Linked Always is a good choice when the custom transformer is intended to be shared among a group of users. Because it is
linked, the users will always receive updates if the transformer definition is changed, and because the definition is shared, it
becomes a standard that is applied to all users.
Only when the end-user is experienced in FME and can understand the consequences, is it advisable to use a “By Default” setting
and allow type switching.

Password
The password field allows you to password-protect the custom transformer. This makes it impervious to edits from unauthorized
persons. Additionally, the file contents are (very mildly) encrypted so that they cannot be copied by opening the source file in a
text editor.
This allows authors to make transformers available for purchase without any fear that their work will be copied or edited. Of
course, it’s important not to forget or lose the password yourself, in case you wish to make edits!

Licensing
Although not part of the export dialog, it's worth mentioning licensing along with passwords. Custom transformers can be licensed
so that they cannot be used without the proper registration code. This is of benefit when you want to restrict access (perhaps
within your own organization) or you want to license a transformer just like any other item of software (perhaps you made it for
general sale to users).
A special transformer – the LicenseChecker – and a license generator tool are provided for authors to implement such a setup:

Here, for example, the LicenseChecker is being used to protect a custom transformer. If the transformer is licensed, then it will
work as expected. If it is not licensed, then it will terminate. Of course, there's not much point in this custom transformer - let
along license protecting it - because it only has a single FME transformer inside it, but you get the idea.
For more information on obtaining licenses for a custom transformer, contact the Safe Software support team.

Save Location
FME has a specific installation folder in which custom transformer files can be saved. If a custom transformer is saved in this
folder, then it becomes available in Workbench and can be used the same as any other transformer. If it is saved elsewhere then
FME won't be able to find it unless that path is set under Tools > FME Options > Default Paths.

Miss Vector says…
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Here is a question for you to investigate: Can you nest custom transformers? That is, can you put one
custom transformer inside another?
1. Yes, with no restrictions
2. Yes, but you can only nest transformers of the same type (Linked or Embedded)
3. Yes, but you cannot nest Linked Custom Transformers
4. Yes, but only a single level of nesting
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Switching Custom Transformer Types
When a custom transformer is designed to allow type switching, to switch a custom transformer instance from embedded to linked
mode is very straightforward. Simply right-click on the instance and choose Link:

Of course, switching types requires the custom transformer to be exported already. If not, there is no option to link the transformer
because there is no file to link to!
When you switch to linked, then the custom transformer definition tab will be closed, and the custom transformer replaced with
one that simply references the external fmx file definition.
If there is more than one instance of the Custom Transformer, you are asked whether you want to switch all of them:

The usual answer to this is yes because having the same transformer both embedded and linked could be quite confusing! If you
answer no, then be aware that the transformer you clicked on will be linked (but none of the other instances will).
In a similar manner to above, to switch from Linked to Embedded right-click and choose the option Embed.

First Officer Transformer says…
Switching from Embedded to Linked only works as long as the two versions are the same.
In other words, if you embed a linked transformer and then make changes to the embedded definition, you
won’t be able to revert to the linked version.
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Custom Transformer Versioning
FME includes functionality so that a linked custom transformer can exist as a number of versions. Each time a custom transformer
definition is edited, a new version can be saved.
In that way, a single fmx file can contain multiple versions of the same custom transformer.

Why use Versioning?
One advantage of versioning a custom transformer is that you have a record of previous versions and therefore can revert to a
previous one should the need arise. For example, maybe some recent edits were incorrect, and you need to switch back to the
definition that existed before those edits were made.
However, a more significant advantage relates to FME releases and new functionality.
For example, a custom transformer created in FME2017 and shared by many users could be updated to use new behavior in
FME2018. If that custom transformer is versioned, then the 2017 version remains available to users who have yet to update to that
version of FME; while users who have updated their FME can also update their custom transformer to take advantage of the new
updates.

Creating a Versioned Custom Transformer
When you open an unversioned custom transformer definition file and later attempt to save edits, a dialog opens asking what you
wish to do:

The two versioning options are to Overwrite the existing version or to create a New Version.
Basically, you are being asked whether to implement versioning. Clicking New Version versions the transformer and saves the
edits as version 2. Note that creating a new version does not create a separate fmx file; instead, it creates a separate version of the
transformer within the same fmx file.
The title bar in Workbench illustrates the version number of a custom transformer file:

If you choose Overwrite in the Save Transformer dialog, then the transformer remains unversioned.
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Editing a Specific Transformer Version
Whenever a versioned custom transformer is initially opened in Workbench, you are prompted as to which version you wish to
edit, or whether you want to just start with a new version:

This way you can:
Create a new version to make edits to
Continue making edits to the existing version
Make edits on an older version (particularly useful when that version is tied to a particular FME release)
It's important to be aware that you aren't creating a new version every time you click the Save button. A new version is created
only when the dialog prompts you to "Create New Version". To forcibly create a new version you need to close and reopen the
file, which causes the Select Transformer Version dialog to appear.
Each version of a custom transformer has a record of which FME version with which it was last edited. You can choose to make
edits to a transformer that was last edited in an older version of FME, but you will receive a warning message:

Here version 1 was created with FME2017, and the author is attempting to edit it in FME2018. Should they go ahead and do so,
version 1 of the transformer will no longer be valid for use in FME2017.

First Officer Transformer says…
Sometimes you can get confused about these dialogs (well, I can) so let me set you straight:
When a custom transformer is first exported, you don't get the Select Version dialog (because the
transformer is still unversioned) and you don't get the Save Version dialog (because why create a new
version when this transformer was just exported?)
When you open the definition (fmx file) the next time, you again don't get the Select Version dialog
(because it is still unversioned), but you will get the Save Version dialog when you save the changes,
allowing you to make the transformer versioned.
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From that point on, you'll always get the Select Version dialog when you open the fmx file (because the
transformer is now versioned) but for the same reason, you'll never get the Save Version dialog when you
save edits.

Updating a Transformer Version
If the option to display transformer version is turned on (Tools > FME Options > Transformers > Display transformer version)
then each linked custom transformer displays its version number in summary annotation:

When FME detects that a new version is available - i.e., the author has made edits and saved them as a new version - then an
option appears on the context menu to allow an update to the new version:

Choosing to upgrade means the summary annotation would display the newest version number.

First Officer Transformer says…
FME checks for new versions only when Workbench is first started. If Workbench is already open and you
wish to check for a new custom transformer version, you can force FME to check by clicking the refresh
button on the Transformer Gallery window:
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Miss Vector says…
You have a workspace with a linked custom transformer (version 1). The author of that transformer makes
a series of edits and updates it to version 4. What do you think the upgrade option does to the custom
transformer in your workspace?
1. Upgrade it to version 2
2. Upgrade it to version 3
3. Upgrade it to version 4
4. It depends on what version of FME you and the author are using
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Exercise 4

Custom Transformer Modes

Data

Bicycle Routes (Esri Shapefile)

Overall Goal

Create a custom transformer to calculate the average length of a number of linear features

Demonstrates

Custom Transformer Modes

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex4-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex4-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\AverageLengthCalculator.fmx

You arrive early at the office for a meeting, but it is canceled at the last minute. Typical! Still, it gives you time to carry out an
FME project that has been on your mind: a transformer to calculate the average length of linear features.

1) Open Workspace
Open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex4-Begin.fmw
You’ll see that the workspace is reading a set of bicycle path data, and then doing some minor processing to get it into a
reasonable state for use in the custom transformer.
You may want to run the workspace to examine the output and see what data we are dealing with, but remember the custom
transformer we will create is to be designed to work on any linear data.

2) Add LengthCalculator
The contents of the transformer will be fairly straightforward and we’ll start out with just two transformers. So, simply add a
LengthCalculator and a StatisticsCalculator transformer to the workspace.

3) Create Custom Transformer
Select the two newly placed transformers and turn them into a Custom Transformer called AverageLengthCalculator. Make sure
the attribute references are handled automatically, although at the moment there aren’t any references to handle.
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4) Edit Custom Transformer
Now we have a new custom transformer, let’s tidy it up and make it functional.
Firstly rename the input port object to Lines (thus identifying what geometry is expected), then add an output port object (if you
don’t have one already) and rename it to Output. It should be connected to the StatisticsCalculator:Complete port:

Inspect the StatisticsCalculator parameters. Set Attributes to Analyze to _length. Rename the Mean Attribute result to
AverageLength
Finally, inspect the parameters for the Output port object. Change Attributes to Output to ‘Specified Attributes Only’ and ensure
that AverageLength is output, but _length and any other StatisticsCalculator attributes are not:
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5) Run Workspace
Run the workspace (unless you need to reattach an Inspector transformer, you don’t even have to return to the Main tab to do this).
Inspect the output to ensure everything is working as expected.

6) Export Custom Transformer
Now let's experiment with different transformer modes.
Select File > Export as Custom Transformer from the menubar. In the Export as Custom Transformer dialog make sure the Insert
Mode option is set to Linked by Default. Make sure the Save Location is the default for storing custom transformers
(<user>\FME\Transformers):

Click OK to close the dialog. The custom transformer is saved (as AverageLengthCalculator.fmx) and this file opened up in a new
instance of FME Workbench.

7) Examine Workspace
Go back to the instance of FME Workbench where the original workspace is open. The custom transformer is now a cyan color to
denote that it is now a linked transformer (it's linked because we chose "Linked By Default"):
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Notice that you can right-click and choose to embed the transformer, and then switch back to the linked version. In a real-life
scenario, which you choose would usually depend on whether you are planning to share the transformer.
In embed mode, right-click the transformer and choose Edit. You’ll find that you can no longer change back to Linked mode
because the two definitions are now considered different!
Delete the embedded transformer. You’ll be prompted whether you wish to delete the definition too. Click Yes.

First Officer Transformer says…
It’s important to realize that the definition of an embedded custom transformer can remain in the
workspace, even if it’s not used. If you clicked "No" above, that's what would have happened. You’ll be
able to tell if such a definition remains by looking in the Embedded Transformers section of the
transformer gallery.
You'd usually click No (and keep the definition) if you wanted to make use of it later. You'd usually click
Yes (and remove the definition) if you have made so many mistakes creating an embedded transformer that
you decide to delete it and start again.

8) Examine Custom Transformer
Using the Quick Add menu or the Transformer Gallery, place a new instance of the AverageLengthCalculator custom transformer
in the workspace (it will be linked by default, which is fine). If you hover the mouse cursor over the transformer the pop-up text
will show that it is version 1.

TIP
If you don't see the version number when hovering over the AverageLengthCalculator it means that
feature is turned off.
To enable version numbers to go Tools > FME Options > Transformers then enable Display Transformer
Version:
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Go back to the instance of Workbench where the fmx file is open. Move one of the objects about to activate the save button. Then
save the file. Notice that you aren’t prompted to save a new version. That’s because versioning has not been applied yet. There is
only one version of the transformer to make edits to.
So, leaving Workbench open, close the fmx file. Then go to the start tab and select it from the Recent Files list. Now it is reopened
we are in a new editing session, and we will be prompted to apply versioning when we save the transformer.

9) Update Custom Transformer
Rather than just jiggling objects about to prove a point, let’s make a real update to this transformer. One thing we could do is filter
data by geometry, so we aren’t trying to measure the length of a point feature, or similar.
So, add a GeometryFilter transformer, in front of the LengthCalculator:

Inspect the parameters and select Line and Arc as the geometries to filter by:

Adjust the feature mapping so that the Line and Arc ports are directed into the LengthCalculator. Add a second output port object
by right-clicking on the canvas and selecting Insert Transformer Output. Call the newly placed port Rejected and connect the data
to it, like so:

Now click the save button to save the custom transformer. You’ll be prompted whether you want to create a new version. Click the
button labeled New Version to do so:

334

Exercise: Custom Transformer Modes

You can tell a new version is created by the information at the very top of the Workbench window.

TIP
If you when you saved you weren't prompted with the Save Transformer dialog box, this is because you
forgot to close the first edit session. Undo your changes back to how the original custom transformer was
(without the GeometryFilter and Rejected output port) and save again. This time close the .fmx file and reopen it. Now when you make your changes you will be prompted to create a new version.

10) Update Workspace
Go back to the instance of FME Workbench where the original workspace is open. Click the refresh button on the Transformer
Gallery in order for FME to scan all custom transformers and discover the new version we’ve just created:

Now right-click on the AverageLengthCalculator custom transformer and there should be an option to upgrade to the latest
version. Choose this option:

The transformer will be refreshed and updated, which you can tell by the presence of a Rejected port.

First Officer Transformer says…
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Now you have this custom transformer you have various options to share it.
- You can put the transformer into a shared folder and then have other users use Tools > FME Options >
Default Paths to link their FME to that shared folder.
- You can send (email) the fmx file to other users and have them install it in their FME. They can install it
either by double-clicking the file or saving it to their default FME resource folder.
- You can publish the transformer to FME Server for you (and others) to use there.

CONGRATULATIONS
By completing this exercise you have learned how to:
Export a custom transformer
Switch the mode of a custom transformer instance
Delete an embedded custom transformer
Edit and create a new version of a linked custom transformer
Update a linked custom transformer instance to the latest version
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Custom Transformers and Parallel Processing
Parallel Processing is a way to improve performance on high-end machines, by running multiple actions at once as a set of
separate processes.
Some FME transformers have parameters to implement parallel processing, but all custom transformers also have a mechanism to
do this.

Activating Parallel Processing
Each custom transformer has a set of parameters - located in the Navigator window - that relates explicitly to parallel processing.
Here you can determine the level of parallel processing, and an attribute that defines groups of data that will be transformed as a
separate process:

By default, these are set not to carry out parallel processing. However, when the author sets a level of parallelism then the Parallel
Process By parameter becomes active, and a user parameter is created automatically:

Defining a Group
Parallel processing groups are defined by attribute values; however, because of how parallel processing works in a custom
transformer, you can’t just double-click this parameter and pick an attribute to use.
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Instead, this parameter is published for the end-user to have access to it.

If, as an author, I don’t want the end user to be setting the group-by, then what I can do is locate that published parameter, edit its
definition, and unset the Published setting:

To set it myself I then expose the attribute I want to use and apply its user parameter to the Parallel Process By parameter:
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First Officer Transformer says…
Are you using raster data?
Raster is an oddity in FME as most of the transformers do very little to the data. For example, the
RasterResampler doesn’t actually resample the data; it just tags it as being resampled. The actual
resampling is carried out when the data is written.
On the one hand, this is great for performance. It means – for example – if you resample then clip some
raster data, FME knows to resample only data that falls inside the clip boundary, as the rest is ultimately
going to be discarded.
On the other hand, it does mean that parallel processing doesn’t help performance that much, as most
work occurs in the writers. That’s why few raster transformers have parallel processing options, and why
it’s not worth doing in a custom transformer.
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Exercise 5

Custom Transformers and Parallel Processing

Data

3D Point Clouds (ASPRS Lidar Data Exchange Format (LAS))

Overall Goal

Create a custom transformer to parallel process data

Demonstrates

Custom Transformers and Parallel Processing

Start Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex5-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex5-Complete.fmw

The city has recently started collecting point cloud data and now it is ready for sharing with different departments. You have been
asked to create a solution that converts the point clouds to a vector format that other departments can use.
You quickly create a great workspace that nicely tiles and thins the data too so the destination datasets aren’t overwhelming in
terms of size.
However... the workspace takes longer to run than you like. Because it will be run on a daily basis it would be useful to speed up
the translation using parallel processing.
Since none of the transformers used has a parallel processing parameter, you’ll have to create a custom transformer to do this.

1) Open Workspace
Open the workspace C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex5-Begin.fmw.
As you’ll see, this workspace processes some incoming point cloud data. Inspect the data to see what we’re dealing with. If you
run the workspace as-is it will take approximately three minutes. To make it run a little faster you can increase the Thinning
Interval parameter in the PointCloudThinner (say to 25).
Open a task manager (process manager) tool for your operating system. Run the workspace. You’ll see an FME engine process
running (fme.exe). If there is more than one then any other could be FME Server engine; a low CPU use indicates a Server engine
idling while it waits for a new job:

First Officer Transformer says…
You’ll also see an fmeworkbench.exe process, which is the process running the Workbench interface. This
isn’t responsible for processing the workspace; the two are completely separate processes.

2) Create Custom Transformer
Now select the PointCloudThinner and PointCloudCoercer transformers and turn them into a custom transformer.
It's important you don’t include the Tiler transformer, as this is creating the tiles that we’ll be using as a way to parallel process.
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You can call the transformer something like PointCloudProcessing. It doesn’t matter what attribute reference handling you choose.
The transformer definition should look something like this:

3) Set Parallel Processing
In the Navigator window (of the custom transformer definition) locate and expand the section of custom transformer advanced
parameters.
Double-click the Parallel Processing parameter to set it. Set the processing level to Moderate.
Click OK to close the dialog and you’ll notice the Parallel Process By parameter is now published.

4) Set Process By
Return to the main canvas and inspect the parameters for the custom transformer instance. Select both _column and _row as the
attributes to Parallel Process By:
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This means that each unique combination of _column and _row (i.e. each tile) will be run under a separate process, up to a
maximum of one process per core processor.

5) Run Workspace
Run the workspace, again with a task manager or process monitor window open. Once the tiling is complete and the rest of the
workspace is being processed, you’ll notice a number of FME worker processes (fmeworker.exe):

In moderate mode, you’ll see up to one fmeworker process for each core. This time the translation should - given enough system
resources like memory - be complete in a much faster time.

WARNING
Absolutely do NOT run this in "breakpoint mode". If you do, parallel processing won't work!
You are in breakpoint mode when Run with Breakpoints is set under the Run menu - whether or not you
have any breakpoints set!
Similarly, do NOT run this with feature caching turned on. Make sure Run with Feature Caching under the
Run menu is not checked.

6) Experiment with Parallel Processing Level
If you have time, re-run the workspace with a different processing level, say Aggressive. Does it run any quicker than the
Moderate processing level? If not, why might that be? Does adjusting the number of tiles make it better or worse?
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CONGRATULATIONS
By completing this exercise you have learned how to:
Create and use parallel processing in a custom transformer
Confirm with the task manager that FME is launching worker processes
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Custom Transformers and Loops
Loops are a way to carry out a process that repeats a section of transformers.

What is a Loop?
A loop is a programming structure that allows an action to be implemented repeatedly.
Often this is used to carry out iteration; where a process repeats to gradually narrow the process to the desired result. Usually, a
loop is linked to a condition; i.e., the action continues until a certain condition is met.
In FME, loops are only permitted inside a custom transformer.

First Officer Transformer says…
I often get into a loop when flying. I have to circle the airport again and again (the action) until I have
clearance to land (the condition). Users who have flown into London will understand what I mean!

Why Use a Loop?
As you know, FME processes one feature at a time. Therefore, when you create a loop, each feature is being sent around the loop
individually.
However, the essence of a loop is that each iteration is slightly different. Why else would you want to repeat the same action again
and again, if the result was going to be no different?
So, to be worthwhile, each iteration of the loop must either fetch new data (for example, read another entry from a list) or repeat
the same process using the results of the previous loop.
NB: In the following screenshots, the processing section is a single transformer labeled "ProcessData", in order to give a generic
view of how a loop is created. In reality, this process must be doing something to the data to be worthwhile carrying out at all.

First Officer Transformer says…
It's stating the obvious I know, but you only use a loop to repeat an action inside the custom transformer.
One-off actions should take place outside of a loop. For example, here is my landing sequence:

The "wheels down" part comes outside the circling loop because I don't want to raise/lower the wheels
every time I circled the airport. That would be very inefficient.

Setting up a Custom Transformer Loop
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A loop in a custom transformer requires two components: the start and end point of the loop.

Loop Start Points
The start of the loop is identified by an Input port object. Although it can be the same input port as used for features to enter by,
this does not have to be the case. For example, here there is an input port for features to arrive into, and another one for the start of
the loop:

This allows the loop point to be other than the beginning of the custom transformer.
By default, this second input port also appears on the transformer itself, like this:

If you don't require this, then you simply have to 'unpublish' it in the input port's parameters:

Loop End Points
The end of a loop is identified by a Loop object. You can insert one by selecting it from the canvas context menu in a custom
transformer:
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When a loop object is placed you are asked which Input object it is to be looped to:

And then the loop is complete:

Of course, this example is an infinite loop. The action is repeated, but there is no condition being tested to stop it. FME won't let
an infinite loop run forever - it will recognize the problem and stop it - but we should set up something to force an ending.

Loop Conditions
There are two general types of condition for which we can test. Firstly we can loop a set number of times. Secondly, we can loop
until a specific condition is met.
Here is a custom transformer that loops a set number of times:
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Notice that we have an attribute that is a counter for the number of times we have looped (LoopCounter), and an attribute that tells
us the maximum number of loops to carry out (MaxLoops).
In each loop, the counter attribute is incremented by 1. When LoopCounter < MaxLoops, then we loop back and process the data
again. When LoopCounter = MaxLoops, then we exit the transformer.
Instead of a simple count of iterations, another method is to test a specific measure of data quality. For example, here an ellipse
representing a park is adjusted (resized smaller and smaller) until it's size is less than a certain quantity:

First Officer Transformer says…
For an excellent, real-world example of looping in an FME workspace, check out this customer story.
In that example, the user uses a loop to place trees (the action) until a specific density is reached (the
condition). Notice that the loop is not tied to a specific counter - it continues until the data quality
required is met.

Loops and Transformer Types
As you should already know, transformers that operate on one feature at a time are called Feature-Based, and transformers that
operate on multiple features at a time are called Group-Based.
We can also call a loop "Feature-Based" because it only processes one feature at a time. Unfortunately, that means that using a
group-based transformer inside a (feature-based) custom transformer loop is not a simple task.
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If you attempt to create a loop inside an embedded custom transformer, when it includes a group-based FME transformer, then
you receive an error message. Group-based transformers are only permitted inside a loop in a linked custom transformer. There
are technical reasons for this that we won't go into right now.
This is the error message you get:

So, inside a linked custom transformer definition, you'll see a particular parameter (in the Navigator window) called Enable
Blocked Looping:

When set to Yes then other parameters are exposed to set the number of iterations, and to set an attribute that will hold that value.
Notice how parallel processing is turned off (the parameters are removed) for custom transformers that are being looped, and the
Insert Mode is automatically changed to "Linked Only".

Miss Vector says…
Which of these statements about loops are true?
1. Loops are only permitted inside a custom transformer
2. A loop without a condition will continue processing until manually stopped
3. Test conditions are built into the loop end point parameters
4. Nested loops (a loop within a loop) are permitted

348

Exercise: Looping

Exercise 6

Looping in a Custom Transformer

Data

None

Overall Goal

Create a custom transformer to create loop art

Demonstrates

Custom Transformers and Loops

Start
Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex6-Begin.fmw

End Workspace

C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex6-Complete.fmw
C:\FMEData2018\Workspaces\DesktopAdvanced\CustomTransformers-Ex6-CompleteAdvanced.fmw

Marketing has asked you for some fun images to post on twitter that you created in FME. Instead of creating maps you decided to
create some abstract art utilizing your new found skills in looping.
If you create something awesome share it with us on Twitter @SafeSoftware!

1) Start Workbench
Start FME Workbench and open the starting workspace CustomTransformers-Ex6-Begin.fmw.

If you run this workspace, nothing thrilling happens except you will get a single square.

2) Add a Rotator transformer
After the Cloner transformer add a Rotator transformer. We will use this to rotate our squares. In the parameters create a New User
Parameter for Rotation Angle (degrees) and enter 15 as the default value.

3) Save and Run Translation
Run the translation with Feature Caching enabled and inspect the output of the Rotator:
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It still looks like nothing is happening, besides a slight rotation. This is because we need to create a loop to get each square to do
something different.

4) Create Custom Transformer
First we will need to add an ExpressionEvaluator before we can make the custom transformer. Add an ExpressionEvaluator and
connect it to the Rotator:Rotated output port. In the parameters change the Evaluation Mode to Overwrite Existing Attributes and
set the Attributes to Overwrite to _count. Then enter the following expression:
@Value(_count)+1

This expression will count each of the squares as it passes though adding 1 to the count each time. We will use this count to stop
our loop:
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Now select the Tester, Cloner, Rotator and ExpressionEvaluator transformers and create a new custom transformer, name it
Looper. In the Looper tab, double-click on the Tester_Input port and rename it to Input.

5) Add Output and Looping Ports
Next we need to create the loop and output ports. Let's create the loop first. Create the loop by right-clicking on the canvas and
selecting Insert Transformer Loop, and it will automatically create the Loop To to the Input. Click ok, then connect this to the
ExpressionEvaluator:Output port.

Create an output port by right-clicking on the canvas and selecting Insert Transformer Output. Connect this to the
ExpressionEvaluator:Output port.

6) Expose Angle Parameter
In the Main tab, open the Looper custom transformer parameters. Set the Rotation Angle (degrees) to create a New User
Parameter. The defaults will automatically be set to the ANGLE parameter we already created.

7) Run the Translation
Run the translation with Run with Prompt enabled and enter different values for the parameters to change your art, then inspect
the output. Run it again changing some of the published parameter values.
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Advanced Exercise
You can change the color of your art by adding an FeatureColorSetter after the Looper Custom
transformer. Create a New User Parameter for Color Scheme and one for Fill Color to customize your art
at each run.
You could also try changing the shapes in the Creator.

CONGRATULATIONS
By completing this exercise you have learned how to:
Create a loop object in a custom transformer
Create and increment a loop counter in a custom transformer
Use a loop counter to loop through content in a custom transformer
Exposed published parameters from within a custom transformer
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Module Review
This chapter investigated Custom Transformers and how they can be used to improve your FME workspaces
What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
A custom transformer is a sequence of standard transformers condensed into a single transformer.
A custom transformer lets you tidy your workspace, re-use sequences of transformers, and apply some advanced
functionality like looping.
Handling schema in a custom transformer is very important, and it can be done either automatically or manually.
Custom transformers can be either embedded or linked.
Custom transformers can be used to implement parallel processing.
Loops in FME can only be implemented in a custom transformer.
FME Skills
The ability to create, edit and reuse a custom transformer.
The ability to handle schema in a custom transformer
The ability to embed or link transformers and to share them with colleagues
The ability to apply parallel processing in a custom transformer
The ability to use custom transformer loops

Further Reading
For further reading why not browse articles relating to Custom Transformers on our blog?
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Questions
Here are the answers to the questions in this chapter.

Miss Vector says...
Which of these is NOT a reason to use Custom Transformers?
1. To make my content available in Quick Add
2. To use advanced functionality like looping
3. To reuse chunks of content in a simple way
4. To tidy and declutter the main workspace canvas
Admittedly it does become available in Quick Add, but that's not a specific reason to create a custom
transformer. The reason you want it in Quick Add is so that you can reuse the content (answer #3).

Miss Vector says...
Consider this section of workspace. If I select the three transformers highlighted with arrows, and create a
custom transformer, how many input and output ports will it have by default?

1. One Input and One Output port
2. One Input and Two Output ports
3. Two Input and Two Output ports
4. Two Input and Three Output ports
It will have two input and two output ports, proving that FME will automatically create multiple ports
where required. There are two inputs because there are two connections entering the set of transformers,
and two outputs because there are two connections exiting the set of transformers (although there are
three output ports on the StatisticsCalculator, only two are connected).

Miss Vector says...

354

Q+A Answers

Why do you think that we left the CSMapReprojector transformer out of our custom transformer (in the
exercise)?
It's because the CSMapReprojector is not a vital part of the process and wouldn't be needed in all cases.
Only where the coordinate system wasn't compatible with our area measurements would we need it. For
that reason we'll leave it out of the custom transformer - but maybe add a note to the usage setting to say
that data needs to be in a specific coordinate system to use this custom transformer.

Miss Vector says...
What do you think would happen if you changed the parameter from "Handle with Published Parameters"
to its other possible value, "Fix Manually (Advanced)"? Pick as many of these answers as you think are
correct:
1. The workspace won't run by default because no attributes are available in the custom transformer
2. There will be no way to pick attributes to use from the main canvas
3. The author will need to manually fix the custom transformer by exposing attributes in its definition
4. The custom transformer won't work on a different schema unless the exposed attributes are also
published
Yes, when the parameter is set to manual, it really means manual! All four of these are true, meaning
you'll have your work cut out if you don't let FME take care of attribute references for you.

Miss Vector says...
Can you nest custom transformers? That is, can you put one custom transformer inside another?
1. Yes, with no restrictions
2. Yes, but you can only nest transformers of the same type (Linked or Embedded)
3. Yes, but you cannot nest Linked Custom Transformers
4. Yes, but only a single level of nesting
Yes you can embed any type of custom transformer inside any other type of custom transformer, to multiple
levels of nesting.

Miss Vector says...
You have a workspace with a linked custom transformer (version 1). The author of that transformer makes
a series of edits and updates it to version 4. What do you think the upgrade option do to the custom
transformer in your workspace?
1. Upgrade it to version 2
2. Upgrade it to version 3
3. Upgrade it to version 4
4. It depends on what version of FME you and the author are using
It will upgrade the custom transformer to the latest version that is compatible with the FME version you
are using. If you are using the same version of FME, then it would upgrade the custom transformer to
version 4. But if you are using different versions of FME then it could be version 2 or 3 instead (or maybe
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there would be no available updates at all!)

Miss Vector says...
Which of these statements about loops are true?
1. Loops are only permitted inside a custom transformer
2. A loop without a condition will continue processing until manually stopped
3. Test conditions are built into the loop end point parameters
4. Nested loops (a loop within a loop) are permitted
Yes, loops only work in a custom transformer. An endless loop will not continue forever (FME will stop it
after a time). Conditions need to be checked with transformers (like the Tester). And Nested Loops are
permitted. The following is a screenshot of a nested loop custom transformer:

Notice that there are now two count attributes (one for each loop). The first (inner) loop counter is reset to
zero every time the second (outer) loop counter is incremented.
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Course Wrap-Up
Although your FME training is now at an end, there is a good supply of expert information available for future assistance.
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Product Information and Resources
Safe Software Web Site
The Safe Software web site is the official information source for all things FME. It includes information on FME products, Safe
Software services, FME solutions, FME support and Safe Software itself.

Safe Support Team
Behind FME are passionate, fun, and knowledgeable experts, ready to help you succeed, with a support team philosophy built on
the principle of knowledge transfer.

You can request product support through a Support Case (web/email) or using a Live Chat.

Your Local Partner
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Safe Software has partners and resellers around the world to provide expertise and services in your region and your language.
You can find a list of official partners on the Safe Software web site.

Safe Software Blog
The Safe Software blog provides technical information about FME, articles about customers' use cases, and general thoughts on
spatial data interoperability.

FME Manuals and Documentation
Use the Help function in FME Workbench to access help and other documentation for FME Desktop. Alternatively, look on our
website under the Knowledge Center section.
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Community Information and Resources
Safe Software actively promotes users of FME to become part of the FME Community.

The FME Community
The FME Community is a one-stop shop for all community resources, plus tools for browsing documentation and downloads.

Knowledge Base
The FME Knowledge Base contains a wealth of information; including tips, tricks, examples, and FAQs. There are sections on
both FME Desktop and FME Server, with articles on topics from installation and licensing to the most advanced translation and
transformation tasks.

Forums
FME community members post FME-related messages, ask questions, and share in answering other users’ questions. Members
earn "reputation" and "badges," and there is a leaderboard of the top-participating users. Join the conversation to see how the
community helps each other with their FME projects!

Ideas Exchange
FME development is very much user-driven. The Ideas Exchange gives users the chance to post their ideas for new FME
functionality, or improvements to existing functionality, and allows everyone to vote on the proposed ideas. The more votes an
idea gets, the more likely it is to be implemented!
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The FME Channel
This FME YouTube channel is for those demos that can only be properly appreciated through a screencast or movie. Besides
this, there are a host of explanatory and helpful movies, including recordings of most training and tutorials.
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Feedback and Certificates
The format of this training course undergoes regular changes prompted by comments and feedback from previous courses.

Course Feedback
Miss Vector says...
There's one final set of questions – and this time you'll be telling me if the answers are correct or not!

Safe Software greatly values feedback from training course attendees, and our feedback form is your chance to tell us what you
really think about how well we’re meeting your training goals.
You can fill in the feedback form now, but you'll also be reminded by email shortly after your course. Safe Software's partners
who carry out training may ask that you fill in a separate form, but you can also use the official Safe Software form if you wish.

Certificates
Mr. E. Dict, (Attorney of FME Law)says...
In order to prove you have taken this training course, a certificate will be emailed automatically to anyone
who was logged on for the duration of Safe Software hosted courses.
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Thank You
Thank you for attending this FME training course.
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Congratulations!
As a reward for reading this far, here's a little challenge for you to try out.
Various folk have something to say to you, but can you figure out what it is? Maybe FME can help?

Miss Vector says...
.6 si ecnetnes siht rof rebmun edoc ehT .rebmun edoc a dnif ot gnidoced ralimis sdeen ecnetnes
hcaE .ylreporp ti tamrof ot EMF esu ot si egnellahc eht ,yawyna daer ylbaborp dluoc uoy
ecnetnes eno si siht hguohtlA .snoitalutargnoC

Dr Workbench says...
57656C6C20646F6E652E20596F75207265636F676E697A6564207468697320617320686578
20656E636F64656420746578742E204920686F706520796F75206465636F646564206974207
76974682074686520546578744465636F646572207472616E73666F726D65722E2042792074
6865207761792C2074686520636F6465206E756D6265722066726F6D206D652069732039

Sister Intuitive says...
11114604017115716504014715716404016415014504016016214516615115716516304016314
5156164145156143145040151164040163150157165154144040150141166145040142145145
1560401521651631640401411630401451411631710401641570401441451431571441450401
6415015116304015714316414115404016414517016404016214516016214516314515616414
1164151157156040165163151156147040164150145040124145170164104145143157144145
1620401641621411561631461571621551451620560401241501511630401431571441450401
56165155142145162040151163040061

Police Chief Webb-Mapp says...
Lbh ner tbbq, nera'g lbh. Gur pbqr ahzore sbe guvf fragrapr vf 3. Bs pbhefr, gung ahzore
nccrnef va pyrne grkg, ohg bayl lbh jvyy xabj gur cnffjbeq gb gur arkg pyhr vf gur svefg sbhe
pbqrf pbagnpgrangrq gbtrgure!

Miss Vector says...
C:\FMEData2018\Resources\Challenge\FinalChallenge.ffs
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